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Warning Labels

The following warning and caution labels are utilized throughout this manual to convey critical information 
required for the safe and proper operation of the hardware and software.  It is extremely important that all 
such labels are carefully read and complied with in full to prevent personal injury and damage to the 
equipment. 

There are four levels of special alert notation used in this manual.  In descending order of importance, 
they are: 

 
 

DANGER: This indicates an imminently hazardous situation, which, if not 
avoided, will result in death or serious injury. 

 

 
avoided, could result in serious injury or major damage to the equipment. 

 

WARNING: This indicates a potentially hazardous situation, which, if not 

 

 

CAUTION: This indicates a situation, which, if not avoided, could result in 
minor injury or damage to the equipment. 

 

 

  NOTE: This provides supplementary information, emphasizes a point or 
procedure, or gives a tip for easier operation 
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PreciseVision Machine Vision System 

PreciseVision Introduction 
PreciseVision is a powerful, full featured 2D machine vision software package.  This software application 
includes a complete toolkit with everything that is needed to acquire vision images, identify and locate 
randomly positioned and oriented parts, measure key features and inspect parts for specific defects.  
Each of the basic vision functions is provided as a type of "Tool" in the vision toolbox and is internally 
designed as a modern software "Object".  

PreciseVision executes on a Windows PC system and includes a built-in interface to communicate with a 
Precise Controller via Ethernet. This software package has been designed to operate with the Guidance 
Programming Language, which executes on a Precise Guidance Controller, to produce flexible vision-
guided motion applications.  The Guidance Programming Language, GPL, includes a complementary 
built-in communications interface to PreciseVision and has classes and objects for easily controlling the 
operation of PreciseVision and retrieving vision results.  A complete vision guided robot application 
consists of a list of vision tools executing in PreciseVision and a GPL program executing on a Guidance 
Controller that takes the vision results and utilizes this information to alter the actions of a robot. 

PreciseVision includes a very easy-to-use visual programming interface that allows both simple and 
complex vision programs to be constructed by dragging-and-dropping tools into a list.  Training of the 
tools is performed by visually positioning and sizing tools on top of a captured camera image.  The 
parameters for each tool can also be access via a "Properties Table".  Since each tool is a software 
object, the output of one tool can be easily linked to the input of other tools.  This is a very powerful 
capability that allows the placement and the actions of tools to be a function of the results of previously 
executed tools and permits the results of several tools to be combined. 

To capture an image, PreciseVision supports third party Ethernet and USB cameras.  Vendor and part 
number information for purchasing and installing recommended hardware and drivers are provided in this 
document. 

While the most common configuration is to have PreciseVision interfaced to a single robot, information is 
also provided on executing PreciseVision without a robot or when connected to multiple robots.  

In addition to the normal mode of executing tools on a real camera image, this package also permits a 
sequence of images to be easily saved to disk and then subsequently played back.  This allows vision 
tools to be tested off-line and provides a convenient means for customers to obtain assistance from 
Precise and its partner companies remotely. 

In this document, instructions for installing PreciseVision and the supported 3rd party hardware is 
presented.  This is followed by an overview and quick start section that introduces machine vision 
newcomers to PreciseVision's principal concepts and permits experienced individuals to quickly use the 
system. Finally, the last sections of this manual provide detailed information on the system's user 
interface, toolkit and camera calibration procedures. 
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PreciseVision 

For further information on programming a vision guided robot application in GPL, please refer to the 
Guidance Programming Language, Introduction to GPL. 
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Supported Hardware and Software Installation 

Supported Vision Hardware 
PreciseVision is a software package and does not include hardware. This software is designed to capture 
vision images that are generated by either Ethernet or USB cameras. PreciseVision permits three camera 
options: 

1. DALSA Genie™ GigE cameras that communicate via a 10/100/1000 Ethernet 
connection 

2. IDS Imaging uEye™ cameras that communicate via a USB 2.0 connection 
3. Other 3rd party USB cameras (No customer support provided)  

Each of these options offers a range of camera resolutions, imaging element sizes and a choice of 
monochrome or color image capturing. The DALSA and IDS cameras have many of the same industrial 
features and a wide range of models are fully supported by PreciseVision. There are a host of other USB 
cameras available that range from very inexpensive web cams, to astronomy cameras, to industrial grade 
cameras, all with different prices, characteristics and installation procedures. Please contact Precise to 
determine if a specific USB camera has been qualified with PreciseVision. Precise is not able to 
provide support for USB cameras that have not been tested and qualified. 

When using the standard version of PreciseVision, the system can connect to multiple DALSA cameras 
or multiple USB cameras. However, you cannot connect to both DALSA and USB cameras 
simultaneously. In the Multi-Instance version of PreciseVision, the same rule applies to each instance, i.e. 
a single instance cannot be connected to a mix of DALSA and USB cameras. However, different 
instances can be connected to either DALSA or USB cameras. 

There are a number of trade-offs that should be considered when selecting the type of camera to use with 
PreciseVision. The following table summarizes the trade-offs between the DALSA and IDS cameras. 

Characteristic DALSA GigE  IDS uEye USB  

Cost Typically more expensive  

Typically 20% less expensive than 
equivalent DALSA cameras. Non-
industrial 3rd party USB cameras can 
be significantly less expensive.  

Resolutions 640x480 up to 1600x1200  
640x480 up to 2560x1920 with even 
higher resolutions to be announced 
soon.  

Acquisition time  Very similar to IDS for same 
resolution  

Very similar to DALSA for same 
resolution using USB 2.0 (480 
Mbits/sec). USB 3.0 (4.8Gbits/sec) due 
in 2011 will reduce the requisition time. 

Hardware 
synchronization  

Supports trigger input and 
acquisition output  Same as DALSA.  
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PC CPU Loading  Reduced load relative to 
USB cameras 

Higher load relative to Ethernet 
cameras. Multiple cameras will require 
a higher performance CPU. 5 or more 
cameras may degrade acquisition time. 

Cable length  100M 5M. Powered USB hubs might be able 
to extend length  

Max. number of 
cameras per PC  

Limited to 13-18 cameras 
per Ethernet subnet, 
maximum of 6 cameras per 
PV instance.  

Limited by how many cameras can be 
connected to and serviced by a PC 
using hubs, maximum of 6 cameras 
per PV instance.  Adding cameras to a 
port will reduce the pixel clock rate.  

Installation and 
support  

Fewer steps but more prone 
to complications due to 
firewalls, Ethernet card 
compatibility, Ethernet 
switch problems, and 
somewhat more 
complicated driver 
installation.  

Typically easier for single cameras if 
wired point to point since no firewalls, 
less issues with USB hardware 
interface, simpler driver installation.  
 
Multiple cameras are a bit more difficult 
to setup since each must be assigned 
an ID and registered with the 
DirectShow interface.  

Arm-mounted 
cameras  

Simpler to install on Precise 
robots since Ethernet cable 
and power available at end-
of-arm  

Requires extra external cable for 
Precise robots 

Power 12VDC 4 watts provided in 
second cable from extra PS 5VDC taken from single USB cable  

Size / weight 29x44x67 mm, <125g  34x32x34.4 mm, 75g  

In the following sections, part numbers are provided to allow hardware to be directly purchased from the 
hardware vendors together with simplified wiring drawings that illustrate how the components should be 
connected. 

Option 1:  DALSA Ethernet Cameras

• Each instance of PreciseVision supports up to 6 DALSA Genie™ GigE Ethernet 
cameras. See the table below for the recommended/supported camera models.  

• DALSA cameras can be directly connected to the PC running PreciseVision or 
through an Ethernet switch. 

• The PC must include a standard Ethernet card, but a GigE card is recommended 
for the best performance. 

• For more information, visit the DALSA website at www.imaging.com. For 
ordering, contact Manish Shelat at DALSA Digital Imaging, phone: (510) 249-
5664, email: manish.shelat@DALSA.com. 
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Hardware Specification  

ETHERNET 
CAMERAS 

 

M640-1/3, 640x480 resolution, 60 frames/second raw frame rate, 

 

M1400, 1392x1040 resolution, 15 frames/second raw frame rate, 

te, 

PreciseVision fully supports a number of DALSA Genie GigE 
Vision Cameras.  All models listed below provide Progressive 
scan, have metal cases, C-Mount or CS mount lens adapters, are 
available in monochrome (M) or color (C), and support an external 
trigger (DIN) and a digital output (DOUT). Effective frame-to-frame 
time depends on the exposure time that ranges from 100 
microseconds to 4 seconds, controlled via software, plus PC 
overhead. For total time, add vision processing time, which is 
typically less than 100ms. PreciseVision supports up to 6 DALSA
cameras. 
 
  
1/3" sensor.  
  M1024, 1034x779 resolution, 20 frames/second raw frame rate,
1/3" sensor. 
  
1/2" sensor.  
  M1600, 1600x1200 resolution, 15 frames/second raw frame ra
1/1.8" sensor. 

MOUNTING 
ADAPTER 

Optional DALSA mounting bracket assembly, 1/4" screw mount, 

 standard tripod. 
part # CA-GENA-BRA00.  This bracket is used for mounting the 
camera on a
Each camera requires 4 watts, 11 VDC to 13 VDC.   
 
Option 1: If you wish to break out the camera’s I/O p
DALSA part # CA-GENA-PS120 and the DALSA Ge

CAMERA POWER  

ins, order 
nie I/O and 

power breakout cable assembly, part # CA-GENC-IOP00. 

Option 2: If you do not need I/O signal break out, an alternative is 
the Intercon PSISP10, which includes a connector compatible 
with the camera but no I/O signal break out, 
www.nortechsys.com/intercon/index.html

ETHER
SW

net Switch. Netgear GS605 10/100/1000, or NET Standard GigE Ether
ITCH equivalent. 

ETHERNET CARD Standard GigE PC Ethernet card. Netgear GA311 PCI Gigabit 
Adaptor, or equivalent. 

ETHERNET CABLE Standard Cat-5 Ethernet cable. Total of 3 required. 
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Option 2:  IDS uEye USB 2.0 Cameras 

• Each instance of PreciseVision supports up to 6 IDS uEye™ USB 2.0 cameras. 
See the table below for the recommended/supported camera models.  

• IDS cameras are typically connected directly to the PC running PreciseVision 
although a USB hub can be used. 

• The PC must support USB 2.0 (not 1.0) and must have DirectX 9 or higher 
installed. PreciseVision uses DirectShow (DirectX) to interface to the camera 
driver.  

• It is highly recommended that only uEye ca port "Global" shutters 
be utilized and not "Rolling" shutters. A Gl r exposes all of the pixels of 
the imaging element at one time. A Rolling shutter exposes lines at different 
times. This can result in smearing if there is any movement in the image.  

• For flexibility in selecting the appropriate lens for your application, a camera with 
a C-Mount or CS-Mount is highly desirable. 

meras that sup
obal shutte

        

 

Hardware Specification  

USB CAMERAS 

PreciseVision fully supports the IDS Imaging Development 
Systems GmbH uEye USB 2.0 Cameras listed below.  All of the
models have Global Shutters, metal cases, C-mount lens 
adapters, are available in monochrome (M) or color (C), DB9 
signal/power connector, and support an external trigger (DIN) 
a digital output (DOUT). Effective frame-to-frame time depend
the exposure time and PC overhe

se 

and 
s on 

ad.  For total time, add vision 
 

eras. 

n, 15 frames/second raw 

w 

processing time, which is typically less than 100ms. PreciseVision
supports up to 6 USB cam
 
  UI-2410-M/C, 640x480 resolution, 75 frames/second raw frame 
rate, 1/3" CCD sensor.  
  UI-2230SE-M/C, 1024x768 resolution, 30 frames/second raw 
frame rate, 1/3" CCD sensor.  
  UI-2240SE-M/C, 1280x1024 resolutio
frame rate, 1/2" CCD sensor. 
  UI-2250-M/C, 1600x1200 resolution, 12 frames/second ra
frame rate, 1/1.8" CCD sensor.  
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CAMERA POWER  
C's power supply.  

Power is supplied directly by the USB cable and is generated by
the P

USB INTERFACE  PC must be equipped with USB 2.0 interface (not 1.0). 
USB CABLE, IDS uEye industrial cam
TRIGGER 

era cable: High speed 2.0 Extension 
cable - Screw type 4-Pin USB type A (F) TO 5-Pin micro-USB 

SUPPORT, NO 
DOUT  

type B (M). 3 meter length. Cable breaks out trigger input as 
separate input. CB-IDS-9UD-A-T-3M 

USB CABLE, 
TRIGGER AND 

Right angled trigger cable for uEYE-Cameras, 3 meter uEye Micro 
Sub-D connector, 90° angled with screws. USB signal via 
shielded USB 2.0 cable to USB-A. Breakout cable for trigge

DOUT SUPPORT and digital output, cable with open ends. CB-IDS-9UD-A-ST3M-
RT 

r input 

Option 3:  Other 3rd Party USB 2.0 Cameras 

The a
hobbyis
differen
gua te vide 
ass ta

Non he
plea  c

• lly optimized for the IDS 
u

• 

onment.  
• Many inexpensive cameras utilize the standard USB connectors that are retained 

by friction. It is relatively easy for these to become accidentally disconnected as 
compared to screw in DB connectors such as those used in the IDS uEye cameras.  

ntegrated fixed lens or lens mounts that 
re available. Also, many lens do not have 

screws for locking in the focus or F-stop adjustments.  

uirements. 
Also, since communication standards have not be established for these features, 
e eVision will probably not be 
a

Installing PreciseVision on a PC 
PreciseVision tes on a Windows PC system.  For the 

re e a wide variety of 3rd party USB 2.0 cameras that are available for the home, 
t, commercial and industrial markets. Due to the large number of vendors, their 
t installation procedures and their individual idiosyncrasies, Precise cannot 

r

ran e that any camera brand that you select will work properly and we cannot pro
is nce for any camera that has not been tested and qualified by Precise.

et less, if you wish to interface an unsupported camera without Precise's assistance, 
se onsider the following when selecting a USB camera. 

• PreciseVision utilizes DirectShow to interface to the camera. Therefore, the USB 
camera must be compatible with DirectShow, which is quite common.  
PreciseVison's image acquisition tool has been specia
Eye family of cameras. Other USB cameras will take somewhat more time to 

acquire an image.  
For similar features, a camera in a plastic case will be less expensive that a 

camera in a metal case. You must determine if the additional ruggedness of a metal 
case is important for your envir

• Many inexpensive cameras either have i
do not support the full range of lens that a

• Most cameras do not have trigger inputs and digital outputs. These are important 
features for conveyor belt tracking and other real-time image capture req

ven if the camera has these hardware features, Precis
ble to access this capability. 

 is distributed as a standalone application that execu
best results, it is suggested that this software be executed on the following equipment: 

• 2.3Ghz or faster Pentium 4 PC running Windows XP 
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• Depending upon the type of cameras to be utilized:  
o Gigabit Ethernet (recommended and required for certain cameras), 

otherwise 100Mb Ethernet interface 

 At least 1 GB of space on the PC's disk 
• A 2x CD-ROM drive interfaced to the PC 

While Preci e able to 
commun ided 
motion appli

o USB 2.0 interface  
• 512 MB of RAM 
•

seVision can be executed by itself to develop Vision Processes, the PC must b
icate with a Precise Guidance Controller via Ethernet in order to run a complete vision-gu

cation.  Please see the “Guidance System Setup and Operation, Quick Start Guide” for 
instruc communicate with each other.tions for configuring the PC and the Guidance Controller to 

If you pr
performing the steps below. If you are installing PreciseVision for the first time, you can 
instructi

eviously installed PreciseVision on your computer, you should un-install the old version by 
skip the first set of 

ons. 

»   Shut down all programs that are running including virus protection programs. 
 
»   Bring up the Window's Control Panel by clicking “Start > Settings > Control Panel”. 
 
»   Double click on the “Add or Remove Programs” selection. 
 
»   In the “Add or Remove Programs” popup window, scroll down and click on “PreciseVision”.
 
»   Click the “Remove” button and click on “Yes” to confirm the action. 
 
»    Close all of the windows that you opened. 

To install PreciseVision on your computer, perform the following steps: 

»   Shut down all programs that are running including virus protection programs. 
 
»   Insert the PreciseVision CD-ROM into your computer’s CD-ROM drive. A panel should pop 
up that welcomes you to the Setup Wizard. If the installer does not automatically start, click 
“Start > Run”, type in “D:\setup.msi” (where D is the CD-ROM drive), and click “Ok”. 
 
»   Follow the instructions in the Setup Wizard to install PreciseVision.   Note, PreciseVision 
relies upon the Microsoft .NET Framework in order to operate.  This is a standard module that 
Microsoft provides free of charge.  If the Setup Wizard detects that this module is not available, 
you will be asked if you wish to install the Framework now.  You should respond "Yes".  This 
will launch a browser to take you to the download site for the required software. 

At the conclusion of this process, PreciseVision will be installed on your PC.  This software by it
sufficient to exec

self is 
ute PreciseVision with camera images that have already been captured and saved to a 

disk file.  But, to operate this software with a camera, one of the camera interface installation 

a following section.  

procedures in the following sections must be performed.  In addition, in order to continue to use 
PreciseVision beyond the trial period, you must register this product with Precise Automation.  The 
registration process is described in detailed in 
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Installing and Configuring the DALSA Genie™ Camera 
Interface 
If your system is equipped with a DALSA Genie™ GigE camera, the procedure described in this section 

a, please 
skip to the next section of the documentation. 

Prior to executing this pro

 DALSA Genie™ camera must be interfaced to the PC via a 100MB or 
1000MB (Gigabit) Ethernet card.  A 1000MB card will produce the best 

le performance for 
many applications. 

The firs tall the DALSA device driver and its configuration software. 

must be executed to interface and configure this device.  If your system does not use this camer

cedure, ensure that the following requirements are satisfied: 

• The

performance although a 100MB card will produce acceptab

t step in the process is to ins

»   Insert the PreciseVision CD-ROM into your computer’s CD-ROM drive. 
 
»   In the "DALSA/SaperaLT/" folder, double click "Setup.exe" to execute the installation 
procedure. 
 
»   Follow the instructions in the Setup Wizard to install the driver. 
 
»   In the "DALSA/Genie/" folder, double click "Genie_1.nn.nn.nnnn Release.exe" to execute 
the installation procedure. 
 
»   Follow the instructions in the Setup Wizard to install the driver. 
 
»   After installing the Genie drivers, the PC must be rebooted. 

After rebooting the PC, you should see a small camera icon.  in the task bar in the right hand corner but 
with a re

Plug the Genie camera into the network. r over the 
icon, the tool tip will indicate the number s are 
located, A

e ie Installation

d ‘X’ over it. 

After a period of time the ‘X’ will disappear. If you hove
 of Genie cameras that have been located. If no camera

 Genie Installation Trouble Shooting" table. 

 Trouble Shooting  

 please see the following "DALS

DALSA G n

Trouble  Possible Solutions  

When the PC boots up it is not 
displaying the little .  camera 
icon in the system tray. installing the Genie driver. 

The Genie driver did not properly install. If you have 
VPN software installed, try removing this and re-

The camera .

If you have multiple network cards, try opening

 icon is 
displayed but always has a red 
‘X’ over it . 

Package". 
 
Select the "Network" Adapter you are using with the 
camera. Select the "DHCP/LLA" mode in the Device 
Configuration sectio

 up the 
 Network Configuration Tool’. This is found in 
> DALSA -> Sapera Network Imaging 

n. 

‘DALSA
"Start -
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If you are still having difficulty with the operation of your DALSA camera, please see the FAQ 
this manual for additional step-by-step trouble shooting instructions.chapter of  

Verifying the Camera Firmware is Up-to-Date

At this point, the basic camera driver installation is completed.  However, it is po
that shipped with your DALSA Genie camera may not match the PC driver that you just insta

ssible that the firmware 
lled.  If the 

firmware and the driver do not match, the camera may not operate reliably. To determine if the camera 
firmware needs to be updated, perform the following steps: 

»   Ensure that the camera is properly communicating with the PC per the instructions above.  
 
»   Open the DALSA Device Manager firmware update dialog.  This is accomplished from the 
Window's Start menu by clicking: "Start > Programs > DALSA > Genie > Firmware Update". 

A list of available cameras will be displayed as shown in the following picture.  

 

t most column labThe righ eled "Update" indicates the firmware status of each camera. 

»   If the "Update" status is "Not Required", the camera firmware matches the driver and the 
following steps can be skipped. 
 
»   If "Required" is indicated, the camera firmware must be updated for proper operation.  To 
update the firmware, click on the "Automatic" button.  
 
»   Allow up to 3 min. for the camera to update.  Do NOT unplug the camera during this time.  
 
»   After the camera re-initializes the LED on the camera next to the power connector should 
return to a solid BLUE state.  This indicates that the process is completed and you can now exit 
from the DALSA Device Manager.  

Selecting Ethernet Cameras Instead of USB Cameras

10 
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PreciseVision can operate using either Ethernet cameras or USB cameras or in a demonstration mode 
without a camera.  However, at any given time, only one camera type is permitted for each instance of 
PreciseVision.  The first time PreciseVision is executed after being installed, it prompts for the type of 
camera to be used.  Thereafter, the camera type is remembered until it is explicitly changed.  The 
following procedure can be used to change the camera type or to verify that PreciseVision is properly 
configured to capture images from the correct type of camera. 

»   Launch PreciseVision by selecting "Start > Programs > Precise Automation > PV_ > 
PreciseVision". 
 
»   Open the Preferences pop-up by selecting the following within PV:  "File > Preferences" 
and open the "Camera Hardware" tab. 
 
»   Ensure that the "Genie (Dalsa Ethernet Camera)" option is selected. 
 
»   Restart PreciseVision if the selected camera type is changed.  

 

Assigning (Mapping) Dalsa Cameras

The first time the DALSA Genie camera option is selected, PreciseVision will automatically scan
available Genie cameras. When a camera is located, the camera list will be created. Each locate
camera is automatically assigned a camera number and will be identified by it

 for all 
d 

s MAC ID. The MAC ID is a 
unique number that is permanently assigned to every Ethernet compliant hardware component in the 
world. 

»   To view the available Genie cameras and their assigned camera numbers, while still viewing 
the "Camera Hardware" tab as described above, click on the "Genie Mapping" button. 
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Up to 6 Genie cameras can be "Accepted" for use by each instance of PreciseVision.  Once the Genie 
camera
have the
physical cam contents of this 
table an

When P mera will 
automatically be assigned to the first available slot (logical camera number). 

If a camera is disconnected or powered down, the slot for this camera is NOT cleared. This is important 

amera will be assigned to the first 

 list is created, a user can manually copy and paste MAC ID’s to change the camera order. To 
 changes take effect, PreciseVision must be restarted.  Each time PreciseVision is started, the 

eras will be assigned to the same logical camera numbers based upon the 
d the camera's MAC ID numbers. 

reciseVision is restarted, if a new camera is found on the network, the new ca

since there are unique calibration files for each physical camera and vision applications expect to take 
pictures using specific cameras. 

With the Genie camera, it is possible to assign the same camera to several camera slots. This allows 
different calibrations for the same camera if needed. 

For a single camera configuration, simply start PreciseVision and the c
camera slot and can be referenced as logical camera #1. 

Camera "Binning"

For DALSA cameras, the system supports "binning".  At the camera hardware level, this process 
combines every other pixel horizontally and vertically and returns half of the standard number of pixels in 
each ro

This pro me manner as averaging 
two ima image acquisition time is 
reduced.  However, the acquisition time is not reduced proportionally to the reduction in pixels.  Although 
there are only 1/4th the number of pixels, for a 640x480 camera the speed improvement is only a few 
percent and for a 1392x1040 camera the speed improvement is approximately a factor of two.  This is 
because the camera performs the vertical binning in the analog domain, which results in a 2x 
improvement, but the horizontal binning is performed in the digital domain so all pixels in a row are still 
sampled.  In addition, there is some overhead that further reduces the speed improvement.  Nonetheless, 

w and only every other row of pixels.   

cess has the advantage of increasing the contrast in an image in the sa
ges.  Also, since there are fewer pixels transmitted by the camera, the 
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for high resolution Dalsa cameras, binning can be used to reduce the image capture time when lower 
resolution is acceptable. 

»   If you wish to turn on binning for a camera, in the "Genie Camera Mapping" panel shown 
above, check the "Enable Binning" next to the camera's MAC address. 
 
»   If you wish to access a camera in both full resolution and binning mode, in the "Genie 
Camera Mapping" panel, copy the MAC address to another logical camera number and 
enable binning on one of the logical cameras for the same physical camera. 
 
»   PreciseVision must be restarted to have any changes take effect.  

Whenever a logical camera with binning enabled is accessed, binning will automatically be performed. 

When binning is turned on for a camera, the camera calibration for this logical camera must be re-
computed.  This is required since the pixel to mm scale factors will have changed. 

Releasing DALSA Cameras to Other PreciseVision Applications 

For multiple cameras on the same Ethernet network that are accessed by a different PC or for cameras 
that are accessed by a different instance of Multi-Instance PreciseVision on the same PC, there is an 
ignore list. Cameras that are listed as one of the "Ignore" entries are released from the current 
PreciseVision and available for use by other copies of PreciseVision. 

»   If you do not wish to utilize a camera within the current PreciseVision application, cut and 
paste the camera's MAC ID from the "Accept" list to the "Ignore" list. 
 
»   PreciseVision must be restarted to have any changes take effect.  

 

This com s via 
this cam

pletes the DALSA Genie™ camera setup.  PreciseVision can now acquire camera image
era(s). 
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Installing and Configuring the IDS uEye™ USB Camera 
Interface 
If your system is equipped with an IDS uEye™ USB camera, the IDS uEye device driver must be insta
and the camera must be configured. PreciseVision utilizes DirectShow and the IDS driver to co
with the camera. If your system does not use this type of camera, please skip to the next section of the 
documentation. 

lled 
mmunicate 

Prior to executing this procedure, ensure that the following requirements are satisfied: 

 the PC.  After the 
IDS driver is installed, the camera can be attached and the PC will automatically 

The first step in the process is to install the IDS USB device driver and its associated configuration and 
diagnos

• Initially, it is preferable if your IDS camera is NOT connected to

discover the camera. 

tic software. 

»   Insert the PreciseVision CD-ROM into your computer’s CD-ROM drive. 
 
»   In the "uEye" folder, double click "uEye32_xxxxx.exe" to execute the installation 
procedure. If your computer contains a 64bit version of Windows, then visit the IDS web site to 
download the 64bit version of the driver. 
 
»   Follow the instructions in the Setup Wizard to "Install driver". When asked what type of 
installation should be performed, select "USB".  You should NOT install any Ethernet or 
custom drivers. 

At this p

Assigning ID's to Multiple uEye Cameras

oint, the required system driver and the support software have been loaded and installed.  

For Ethernet cameras, each camera's Ethernet MAC ID uniquely identifies the camera and is used to 
associate each camera with the same vision operations whenever PreciseVision is restarted.  
Unfortunately, USB connections do not have a similar identification mechanism.  So, to ensure that the 
correct cameras are associated with vision operations, a unique camera ID must be stored into the 
NVRAM of each IDS camera. 

The camera ID ranges from 1 to n and is automatically added to the name of each camera.  For example, 
if the ID is set to 3, the camera will be identified as "uEye Capture Device 3".  

»   Plug the uEye cameras into the PC.  This will permit the PC to discover this new hardware 
and configure the cameras for use. 
 
»   Execute the uEye demo software to verify that the cameras are functioning property.  Select 
the demo software by RIGHT clicking: "Start > Programs > IDS > uEye > Samples > uEye 
DirectShow Demo". 
 
»   In order to gain access to key properties when executing the demo software, click "Run as", 
then select "The following user:" and "Administrator".  

14 
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In order to receive a clear indication that the camera is properly interfaced and to permit changing the 
camera ID's, the automatic registration mode of the camera must be disabled. 

»   In the main panel for the demo program, set the "active video source" to the camera of 
interest and press the "Filter Properties" button to display the panel below. 
 
»   Uncheck "Use automatic registering", press "Ok", and exit the demo program. 

 

If you on  camera to your PC, you can skip to the next section since the 
cameras default ID of 1 can be used. 

ly intend to connect a single USB

15 
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»   To assign camera ID's, execute the uEye Camera Manager by clicking on "Start > 
Programs > IDS > uEye > uEye Camera Manager". 

 

»   Select a desired camera by clicking on a line in the Camera List and click "Camera 
Information". 

 

16 
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»   Change the "Camera ID" to a unique number.  These should be assigned so there are no 
gaps in the numbering (1,2,3,..). 
 
»   When completed, click "OK" and close the Camera Manager when done. 

Before PreciseVision can discover multiple USB cameras, they must be registered using the uEye 
DirectShow Capture Device Manager. 

»   To register each of the IDS cameras, click "Start > Programs > IDS > uEye > DirectShow 
device manager". 

 

»   Clear the list by clicking on "remove device" multiple times. 
 
»   Populate the list by clicking on "add device" a number of times until the highest camera ID 
that you have defined is listed. If the camera ID's were not sequentially assigned, there can be 
N/A placeholders as shown above.  This will not create a problem. 

Selectin ad of Ethernet Camerasg USB Cameras Inste

PreciseVision can operate using either Ethernet cameras or USB cameras or in a demonstration 
without a camera.  However, at any given time, only one camera type is permitted for each instance of 
PreciseVision.  The first time PreciseVision is executed after being installed, it pro

mode 

mpts for the type of 
camera to be used.  Thereafter, the camera type is remembered until it is explicitly changed.  The 

s properly following procedure can be used to change the camera type or to verify that PreciseVision i
configured to capture images from the correct type of camera. 

»   Launch PreciseVision by selecting "Start > Programs > Precise Automation > PV_ > 
PreciseVision". 
 
»   Open the Preferences pop-up by selecting the following within PV:  "File > Preferences" 
and open the "Camera Hardware" tab. 
 
»   Ensure that the "DirectShow (USB)" option is selected. 
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»   Restart PreciseVision if the selected camera type is changed.  

 

Assigning Cameras, Selecting the Camera Resolution and Display Mode

When the PC boots or whenever a USB camera is connected or disconnected, Windows automatically 
assigns each camera an index in a list of cameras.  The ordering of the cameras is dependent upon the 
USB interface to which they are connected.  For a given configuration of cameras, the index of each 
camera will always be the same.  However, if a new camera is connected, it will not necessarily be added 
to the start or the end of the list.  

rectShow 

To review or change the current camera assignments and settings, perform the following.  

Unlike Ethernet cameras, USB cameras typically have several different formats that can be used to 
retrieve the image data at different resolutions.  The formats that PreciseVision and its Di
interface support include the following: 

RGB8 (8-Bit Grayscale) 
RGB24 (24-bit color with 8-bit R,G,B components) 
YUY2 (16-bit color) 

When PreciseVision is started, it retrieves information on all of the connected USB cameras and 
automatically assigns them to a logical camera buffer and selects a format with the highest resolution.  
PreciseVision permits these automatic assignments to be manually over-written. 

»   While still displaying the PreciseVision "Preferences" pop-up, and viewing the "Camera 
Hardware" tab (as shown above), click on the "DS Mapping" button. 
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For each discovered USB camera, this panel displays the logical number (Camera buffer) that it has been 
assigned, together with its resolution and format, and the index number that Windows has automatically 
assigned.   The "Enable" checkmark indicates that a camera will be exclusively used by the current 
instance of PreciseVision.   

»   If the Multiple-Instance version of PreciseVision is being executed, a camera can be 
released for use by another instance by unchecking "Enable" and restarting PreciseVision. 

If you wish to assign a camera a different logical camera number or change its format and resolu
the following.  

tion, do 

»   While still displaying the USB Camera Mapping panel, click on the "Select" button for the 
camera of interest. 
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If you wish to access the same camera in different formats or want to utilize more than one set calibration 
data, the same c ffer numbers.  

Subsequent Changes in Camera Assignments

amera can be assigned to multiple logical camera/bu

If a USB
Precise mbers can all be changed.  If a camera name is 
unambiguous, as is the case for IDS cameras that have been assigned unique camera ID numbers, 
PreciseVision attempts to assign the cameras to the same logical camera number/buffer as the last 
session independent of their Windows index number. If camera names are not unique, PreciseVision 
utilizes the Windows camera index numbers to determine their logical camera numbers.  At the end of this 
process, if the camera mapping has changed relative to the previous session of PreciseVision, the 
following message is displayed to alert you to a possible problem. 

 camera is disconnected or a new camera is connected to the PC, the next time that 
Vision is started, the Windows camera index nu

 

»   If the error message above is displayed, review the USB camera assignment by going to 
"File > Preferences > Camera Hardware > DS Mapping" and correcting any errors.  

This com es 
via this came

 you must start the application on the PC. 

pletes the IDS uEye USB configuration setup.  PreciseVision can now acquire camera imag
ra(s).  

Activating PreciseVision 
To begin using PreciseVision,

»   To launch PreciseVision, click on "Start > Programs > Precise Automation > PV xxx > 
PreciseVision". The first time PreciseVision begins execution, you will see the following 
popup. 
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The license that you purchased for PreciseVision permits you to use this software to build and execute 

ted.  

If for so
each tim eVision.  To re-display the activation popup from within PreciseVision, click on 
"Help >

Vision Processes on a single PC.  To complete the software activation process, you must send 
information concerning the PC to Precise Automation.  To allow time for sending the information and 
receiving a reply, PreciseVision is fully functional for 30 days without being activa

me reason, you do not wish to initiate the activation process now, this popup will be displayed 
e you start Precis
 Product Activation". 

»   To initiate the activation process, click "Yes" in the popup above.  This will display the 
following activation popup. 

 

This popup displays the "Computer ID" that you need to submit to Precise as part of the activation 
process. 

»   To obtain a license key to activate PreciseVision, please send an email to Precise 
Automation that contains the following information: 

To:       sales@preciseautomation.com 
Subject: PreciseVision License Key Request 
 
Customer Name:          <your name here, optional> 
Customer Company:     <your company name here> 
Telephone Number:       <your phone number here, optional> 
 
PreciseVision Serial Number:      PVS0-0xxx-xxxxxx 
Computer ID Number:   xxxx-xxxx-xxxx-xxxx 
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»   You can obtain the PreciseVision Serial Number from the PreciseVision License Certificate 
that you received with your order. Below is a picture of the top portion of a typical PreciseVision 
License with the serial number circled in red. 

 

»  The Computer ID number should be copied from the Product Activation popup. 
 
»   As a convenience, if you are viewing this help in the Precise Documentation Library, you 
can click on the following link to get an email template: sales@preciseautomation.com. 
 
»   Alternatively, if you do not have email access, please Fax this information to 408-516-8348 
together with your own fax number. 

Your name and your phone number are optional.  However, we recommend that you provide this 
information in case there is a problem with your license and we need to get in touch with you.  A sample 
email should look as follows. 
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In response to your request, you will receive a license key. 

»   When you receive your license key, access the Product Activation popup by restarting 
PreciseVision or  Activation". clicking in the PreciseVision menu item "Help > Product
 
»   Enter the license key in the "License Key" box and press "Activate". 

PreciseVision is now activated. 

 position. 

Configuring PreciseVision to Read Positions from a Controller

Configuring Communication Between the PC and the 
Controller 
In order for PreciseVision to exchange information with a Guidance Controller, each system must know 
the Ethernet IP address of the other unit.  During normal runtime execution, the Guidance Controller 
initiates all communications and so it must know where to send its commands.  During the Robot Vision 
Camera Calibration procedure, PreciseVision needs to know where to send its commands to read the 
current robot

To permit PreciseVision to query a Guidance Controller for the current position of the robot, the IP 
address of the controller must be defined in the system Preferences. 

»   Launch PreciseVision by clicking on "Start > Programs > Precise Automation > PV xxx > 
PreciseVision". 
 
»   Open the panel for setting the controller IP address by selecting "File > Preferences > 
Client Settings".

The panel for setting the IP address should resemble the following: 
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»   Enter the Guidance Controllers Ethernet IP address and press the "Update" button. 

  

Configuring a Controller to Send Commands to PreciseVision

Whenever the Guidance Controller issues a command to PreciseVision, the controller automatically 
establishes an Ethernet connection utilizing an IP address that is specified in the controller's Parameter
Database.  This database is stored in the controller's flash disk and is preserved even if the controller is 
turned off and restarted.  To modify this database value, perform the following operations. 

 

»   Please see the “Guidance System Setup and Operation, Quick Start Guide” and follow the 
instructions for bringing up the web based Guidance Operator Interface for the controller. 
 
»   In the web interface, open the database page for the vision IP address, "Setup > 
Parameter Database > Controller > Network > Vision IP ". 

The web interface page should look like the following: 

 

»   Enter the IP address of the PC executing PreciseVision into the value for the "Vision server 
IP address (DataID 424)". 
 
»   Press the "Set New Values" button to store this setting into memory. 
 
»   Press the "Save All to Flash" button to store this setting in the flash disk. This ensures that 
this setting will remain in effect if the controller is restarted.  The button will flash for 10-30 
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seconds as the data is being written.  DO NOT TURN OFF YOUR CONTROLLER WHILE THE 
BUTTON IS BLINKING SINCE THIS MAY CORRUPT THE FLASH DISK.

The controll ciseVision.   It is not nece start the 
controller

er is now setup to send 
. 

commands to Pre ssary to re
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Overview and

PreciseVision Overview 
This chapter introdu s Precis ers to 
machine vision, this chapter will provide background scriptions 
contained in the following chapters.  For individuals w
information in this chapter should be sufficient for you

PreciseVision ha n desig b  its 
embedded Guidance Programmin ) -guided 
motion applications. The following diagram illustrates nce 
application. 

 Quick Start 

ce eVision's principal concepts, terminology and features.  For newcom
information prior to reading the detailed de
ith experience applying machine vision, the 
 to start using the system.  

ination with a Precise Guidance Controller and
to easily produce flexible and powerful vision
 the key software components in a vision guida

s bee ned to operate in com
g Language (GPL

 

In PreciseVision, each fundamental vision runtime fun  and 
the collection of all possible ty erred  
function that captur s a picture from a camera and st
Tool"; the operation that fits a line to a set of edge points is the "Line Fitter Tool"; and the function that 
uses an advanced, patented algorithm to identify and

To perform an element of a vi
"Vision Process". Normally, an Acquisition Tool is th owed 
by one or more tools to perform part location, metrolo ltiple copies of the 
same type of tool can be included within the same Vision Process.  The individual characteristics of each 

ction is represented as a type of "Vision Tool"
to as the "Vision Toolkit".  For example, the
ores the result in a frame buffer is the "Acquisition 

pes of tools is ref
e

 locate parts is the "Finder Tool". 

mber of Vision Tools can be combined into a 
e first tool in each Vision Process.  This is foll
gy or inspection operations. Mu

sion application, any nu
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tool (i.e. its size, position, algorithm parameters) are s tool is 
executed, its output data is stored in its Property List lify their 
definition, tools can be positioned an display of a 
camera image.  

A Vision Process is the basic unit of execution that ca lled by a GPL procedure.  Using a built-
in "Vision Class", a GPL procedure running on a Precise Guidance Controller can start the execution of 
a Vision Process in PreciseVision via Ethernet and m
completes execution, the GPL pro e ted 
Vision Process by accessing t on is 
not connected to a Guidance Controller, another prog sor 
can be used to trigger a Vision Process and retrieve t  Remote 
PC Control for additional information).  

In most cases, only a single V cut ine vision 
task.  Typically, this Vision Process will take a picture  a part and 
validate some key features or dimension.  However, if a more complex machine vision operation is 
required, a GPL procedure can execute any number of Vision Processes.  For convenience, multiple 
Vision Processes can be stored in a ne 
Vision Project can be loaded i g. 

In order for PreciseVision to return Tool Results in meaningful units, e.g. millimeters, and in an 
appropriate coordinate system, any camera used for vision guidance must first be "Calibrated".  As a 
convenience, PreciseVision includes a number of "Ca d in a 
later section.  Once a camera is calibrated, all data re ts 
Class will be in mill eters an

In a typical application, a single copy of PreciseVision cted to 
a single robot or motion controller.  If you wish to prov n results to a number of robots or motion 
controllers, please see the appendix that describes M

In the following sections, the Vision Tools are briefly d  and 
editing Vision Projects, Vision Processes, and tools w

Vision Toolkit Summary 
In order to effectively analyze images, PreciseVision includes a full set of vision tools for acquiring 
images, locating and identifying parts, performing metrology operations and executing visual inspection of 
key features. In this section, the function of each tool is briefly summarized and a picture displaying how 
the tool appears on the Camera Display Window is presented. 

An important feature of PreciseVision is that the output of one tool can be easily utilized as the input for 
another tool.  For example, after the Finder Tool locates one or more parts, a tool that measures the 
distance between two edges can be easily placed relative to the located part.  This measurement tool can 
then test if a critical dimension of the part is within the desired tolerance.  Since this measurement is 
performed relative to the output of the Finder, it will operate correctly even if the part's position or 
orientation changes. Furthermore, if the Finder locates more than one part, the measurement tool will be 
automatically applied to each located part. This ability allows complex measurements and tests to be 
easily built-up from the basic tools that are provided. 

tored in Object "Property Lists".  After a 
in a "Tool Results" section. To simp
ng their graphical handles on top of the 

n be contro

d sized by draggi

onitor its progress.  When the Vision Process 
 the Tool Results of any tool within the execu
sults Class".  In applications where PreciseVisi
ram executing in the PC or on another proces
he results (see the appendix that describes

cedure can retriev
he built-in GPL "VisRe

ision Process is exe ed in order to perform the complete mach
 and then utilize Vision Tools to locate

"Vision Project"
nto PreciseVision and o

 in PreciseVision.  At any given time, only o
nly one of its Vision Processes can be executin

mera Calibration" methods that are describe
trieved by a GPL procedure via the VisResul
 system of the robot.  

 will be executed on a PC and will be conne
ide visio

im d in the world coordinate

ulti-Instance Execution.  

escribed along with the methods for creating
ith their associated Property Lists.  
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For a complete description of each tool, please read the "Vis
for the complete set of tools has been developed and will be 

ion Toolkit" chapter. (Note:  The algorithms 
released in future upgrades to PreciseVision 

during 2007. If you cannot find a tool that you require, please contact Precise Automation.) 

Graphical Display  Vision Tool Description

N/A  Acquisition Tool
Captures an image from a camera or loads 
it from a disk file, and stores the image into 
a frame buffer. 

 

Arc Fitter Tool
Searches a specified region for arc edge 
points and returns the arc or circle that best 
fits the edges. Returns both the arc center 
point and radius.  

 

Area-Of-Interest 
(AOI) Tool

Copies a rectangular area-to-interest to a 
disk file, another region of the current image 
buffer, or another image buffer.  Permits 
mathematical manipulation when copying to 
an image buffer.  

 

Barcode Reader Tool
Reads a variety of standard 1-D and 2-D 
barcodes and returns the barcode type and 
the value of the barcode. 

 

Clear Grip Tool
Verifies that there is no obstruction within 
the bounds of a defined window. Typically 
used to confirm that gripping a part will not 
result in a collision. 

 

Connectivity Tool

Searches a specified region for binary blobs 
and returns the centroid and other features 
of each blob. In addition, this tool can return 
data that defines the perimeter of any 
located blob. 

 

Edge Locator Tool

Detects edge points with sub-pixel accuracy 
along a linear path in a vision image and 
returns their positions.  Alternately, this tool 
can return an array of the intensities along 
the linear path or a histogram of their 
values. 
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Find Centerline Tool
Searches a specified region for edge points 
and returns the centerline between two 
located bounding lines. 

 

Find Point Tool

Locates the edge point that is closest to the
line that defines the start of the tool's searc
region.  The XY position of the point is 
returned with sub-pixel accuracy along (a
pixel accuracy perpendicular to) the search 

 
h 

nd 

direction. 

 

Finder Tool
Most powerful vision tool that identifies 
randomly placed parts in a camera image 
and returns their position, orientation and 
scaling to within sub-pixel accuracy. 

Fixed Frame Tool

Places a reference frame at a fixed image 
coordinate or at a constant offset relative to 

 

repeatedly execute any linked tools. 

another vision object.  Can optionally index
the frame in an X and/or Y grid pattern to 

 

 

Image Process Tool
Performs image filtering, edge extraction, 
thresholding and morphological operations 
on a specified area in the camera image. 

N/A  Inspect Frame Tool

Passes through the XPos, YPos and Angle 
d tool and optionally 

sults based upon 
nsist of 
ults of 

r tools. So, this tool also provides a 
means for performing simple mathematical 

Results of a reference
rotates and shifts the Re
an inspection. The inspection can co
the arithmetic combination of the Res
two othe

operations on the results of two tools. 

N/A  Inspect List Tool

Passes through the XPos, YPos and Angle 

determine if the object is good or bad.  This 
tool provides a convenient way to perform 

Results of a referenced tool and tests up to 
12 different Results from multiple tools to 

complex testing of a located object and 
generating an equivalent location with a 
single Pass/Fail indicator. 

N/A  Inspect Region Tool Inspects the perimeter and the interior of an 
opaque object to determine if there are any 
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flaws in the object's outline or holes in the 
interior.  This tool was designed to inspect 

afers, where slight changes in the overall 
size and shape of the wafer are permitted, 
w

but chips in the perimeter or interior holes or 
cracks are unacceptable.  

 

Light Recorder Tool

Acquires a sequence of camera images for 
a specified period of time, determines the 
brightness of each im
brightness readings in an array for 
subsequent analysis. 

age, and returns the 

 

Line Fitter Tool Searches a specified region for edge points 
and returns the line that best fits the edges. 

 

Line-Line Frame Tool

Determines the intersection of two lines 
defined by vision objects and returns a 
reference frame.  Alternately, computes and 
returns the midpoint of two reference frames 
defined by two vision objects. 

 

Pixel Window Tool

Counts edges or binary pixels or collects 
gray-scale statistics within a rotated 
rectangular or circular region. Used for 
quickly detecting the presence of features or 
collecting general intensity information about 
a region.  

Tests if the general color of a rectangular or 
circular region matches a trained color 
within a specified tolerance.   Also computes 

Pixel Color Window 
Tool

the mean HSV/HSI values for the region. 

 

 

Point-Line Frame 
Tool

Takes a point and a line from two vision 
tools and returns a reference frame. 
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C
vision toolPoint-Point Line Tool

 

omputes a line given two points from two 
s. 

Detects motion in a window region. Ensures 
the scene is stable prior to other operations 

used in place of physical senso
parts feeding where parts can t
settle.  

Sensor Window Tool or waits until motion is detected. Can be 
rs in flexible 
ake time to 

N/A  Text Label Tool
Displays string constants plus inspection 
and results data from a referenced tool.  
Text is shown relative to the position of the 
referenced tool. 

N/A  Tool Filter Tool
Takes the output from another tool that 
generates multiple sets of results, and 
returns a subset of the results based upon 
specified criteria. 

Graphical User Interface Overview 
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This section summarizes the purpose and use of eac onents of the PreciseVision 
graphical user interface (GUI).  The user interface has been designed to allow you to quickly construct a 

For detailed information on each of the components of the GUI, please read the "PreciseVision User 
Interface" cha

h of the major comp

Vision Process and to easily define the properties for each of the utilized vision tools. 

pter.  The following table contains a brief summary.  

GUI Component Description

1.
Toolbar

 Main Menu and PreciseVision, e.g. loading and saving projects, selecting the 
 

zooming the camera image up.  

Provides access to the major functions available within 

camera output to view, etc. The toolbar includes buttons for putting
the camera into "live video" mode, taking a single snap shot, and 

2. Vision Camera 
Display of the camera image. When a tool is being edited, its outline will be 

displayed on top of the camera image. To reposition or resize a 

Displays the output of the last selected camera.  This can be either 
a frozen snapshot or a live camera image.  When a Vision Process 
is being evaluated, the tool Results graphics will be overlaid on top 

tool, simply drag its handles in this window. 
Displays and permits editing of all of the Vision Processes defined 
within the currently loaded Vision Project.  Each process can be 
expanded to show the sequence of Vision Tools that are ex

3. Process Manager process.  To add a new tool, simply drag a defined tool from the 

ecuted 
within the process. Tools can be deleted or re-ordered within the 

Vision Tool Definition window and drop it on a process name. To 
preview how a Vision Process will perform, click on the "Test 
Process" green button in the toolbar.  This will execute a process 
once or continuously without requiring a GPL procedure to trigger 
this activity. 

4. Vision Toolbox

Lists all of the possible types of Vision Tools that can be created.  
To create a new copy of a tool, double click on the tool or right-click 
and select "Create tool".  Each tool must be assigned a unique 
name.  New copies of tools are automatically added to the lists in 
the Vision Tool Definition window. 

5. Vision Tool 
Definition Window

Displays all of the tool that have been created.  A created tool will 
not be utilized in a process until you drag the tool and drop it into 
the Process Manager window.  If a tool is relative to another tool or 
requires other tools as inputs, they will be listed below the tool.  
This provides a quick visual queue as to the relationships between 
tools. 

6. Vision Results 
Window

Whenever a Vision Process is executed, the output of each tool 
(i.e. its Vision Results) will be displayed in this window. 

7. Property Display
Whenever a copy of a vision tool is selected in the Vision Tool 
Definition window, all of the properties of the tool will be displayed 
in this window.  Dimmed properties are read only. 

8. Status Bar 
Displays status information such as the last Process execution 
time, live video/snapshot indicator, networking indicator, camera 
calibration type, etc.  
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Tutorial 1:  Testing Processes and Editing Vision Tools 
The first step in learning how to apply PreciseVision is to gain more of an understanding of how vision 

on provides a very convenient means for 
obot or any parts. 

files 
s were 

Prior to executing this tutorial, the following steps must first be performed: 

• The procedure for "Installing PreciseVision on a PC

tools operate and how to edit tools.  Fortunately, PreciseVisi
experimenting with the tools without needing a camera, r

In the following procedure, you will be using a Sample Vision Project and camera images from disk 
that are distributed with PreciseVision.  One thing to note is that this Sample Project and image file
generated using standard PreciseVision facilities.  So, once you are familiar with the system, you will be 
able to create your own Sample Projects and stored images to illustrate your work to co-workers or 
customers or to relay problems to Precise and our partners. 

" must be completed. 

In this first example, two Edge Locators are executed to compute a line along the side of a part. 

• No camera hardware of any sort is required. 

»   Start by launching PreciseVision.   Click on "Start > Programs > Precise Automation > PV 
xxx > PreciseVision".

If this is the first time PreciseVision is executed, a pop-up window will be displayed requesting the 
specification of the camera hardware followed by a window requesting that the software be activated.  
Both of these actions are good to perform and you should return to the installation chapter and follow the 
instructions for completing these procedures.  However, if you wish, you can cancel out of these pop-up's 
since neither of these setup steps is required to initially execute the Sample Projects. 

The following "Quick Start" pop-up window should now be displayed. 

 

If you ho ge 
to provide mo

ver the cursor over the three buttons on the left, the text in the center window panel will chan
re information about each selection. 
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»   Click on the "Samples" button.  A standard file selection pop-up window will be displayed 
that lists a number of Sample PreciseVision Project files (*.pvp). 
 
»   Click on the "ComputeLineExample.pvp" file and press "Open" to load this Project. 

 

The def d show 
the pictu

If you examine the Process Manage  Process defined, 
"Compu
"cl_com ra.  In 
this cas oes the work of computing 
a line from th
in the V

ault PreciseVision application layout should now be visible and the Camera Display shoul
re of a "T" part with two green Edge Locators as shown above. 

r, you will see that this Project has one Vision
teLine".  This Process consists of an Acquisition Tool, "picture", and a Point-Point Line Tool, 
pute_line".  The Acquisition Tool would normally be set to capture an image from a came
e, it is configured to read the image from a disk file.  cl_compute_line d

e output of two Edge Locators.  The two Edge Locators are implicitly executed and not listed 
ision Process (more about this later). 

»   To test the Vision Process, click on "ComputeLIne" in the Process Manager and then click 
on the circular green "Test Selected Process" button in the window's toolbar. 

Each tim
from the e between 
their first detected edges.  The first time you click the test button, the Camera Display should resemble 

e that you click on the "Test Selected Process" button, the Acquisition Tool loads an image file 
 disk and then the Point-Point Line Tool executes the two Edge Locators and fits a lin

the following.  You will note that the output line of the Point-Point Line Tool is indicated in yellow.  
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For this Sample Project, there are multiple image files and so the captured image and the results will 
change each time you click the test button. 

»   To continuously execute the Sample Project, pull down on the arrow next to the test button 
in the toolbar and select "Test Loop".  
 
»   To stop the execution, click the "Stop Test Loop" button in the toolbar.  
 
»   Next, to examine the defined tools, in the Vision Tool Definition Window, click on each of the 
"+" boxes to expand all of the displayed items. 

 

a specific type.  If a type of tool has not been created, the corresponding tool folder is hidd
-level item

The items in the left-most column of the Vision Tool Definition Window are folders that contain all created 
tools of en.  
The top s listed in the tool type folders are the names of the created tools.  The third and 
successive levels are lists of tools that are referenced by the tool above it.   In this example, in addition to 

ine" tool.  This second 
listing indicates that the output (i.e. "Results") of these two Edge Locators are referenced by and used in 
the computation of "cl_compute_line". 

Since the system knows that the Edge Locators are needed for the computation of the Point-Point Line 
Tool (more about how to specify this later), the Edge Locators are automatically executed by the Point-

the "picture" and the "cl_compute_line" tools, two Edge Locators, "el_edge_locator1" and 
"el_edge_locator2" have been created.  Note that the names of the Edge Locators appear twice, once in 
the top-level Edge Locator tool type list and a second time under the "cl_compute_l
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Point Line Tool if necessary and they need not be included in the Vision Process.  Including the Edge 
Locators in the Vision Process before the computation of the Point-Point Line Tool is a matter of personal 
preference and does not effect execution time.  

The Vision Tool Definition Window provides a convenient means to access all created tools whether or 
not the tools are included in any Vision Process.  This window also provides a simple graphical 
representation of how tools are dependent on and connected to other tools. 

»   In the Vision Tool Definition Window, click on either of the "el_edge_locator1" names to 
select this tool for editing. 

 

Once th l 
handles

e Edge Locator is selected for editing, it will be displayed in the Camera Display with graphica
 (as shown above) that allow it to be repositioned and resized.  

»   To practice repositioning the tool, click anywhere along the green line and drag the tool to 
translate it. 
 
»   Click on the blue square that indicates the start of the Edge Locator and drag it to stretch or 
shrink the tool. 
 
»   Click on the blue circle that indicates the end of the tool and drag it to rotate the tool's 
orientation. 
 
»   To test the Vision Process with a new tool position and size, in the Process Manager, click 
on "ComputeLIne" and then click on the circular green "Test Selected Process" button in the 
window's toolbar. 

When th
automa  to graphically positioning 
and sizing this tool, you can also enter new values into this panel. The properties are organized into 

For each of the tool types, all of the properties are described in detail in the Vision Toolkit Chapter of this 

e Edge Locator was selected for editing, you might have noticed that its properties were 
tically displayed in the Property List Display as shown below.  In addition

groups based upon their function.  Readonly values are displayed in dimmed characters. 

document.  
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»   In the Property List Display, try editing the "Angle", "Length", and "XPos" and "YPos" 
properties and note the effect in the Camera Display. 
 
»   If you wish to save your changes to the Sample Project, select "File > Save Vision Project 
As. a.." nd assign a new name to your project so the original Sample is preserved.  

This comple

Tutorial 2:  Adding Vision Tools 
In this tutorial, w  
present the proc
purposes, we will add an Edge Locator that measures the width of the stem of the "T" and validates if this 
dimension falls within an acceptable range.  In an application that required high precision, you would 

 but for training purposes, an Edge 
Locator will suffice.  

Prior to erformed: 

tes the tutorial on testing a Sample Project and editing a tool. 

e again make use of the ComputeLineExample Sample Project.  In this case, we
edure for adding a Vision Tool to an existing Vision Process.  For demonstration 

probably use two Line Fitters for locating the edges of the "T" stem,

executing this tutorial, the following steps must first be p

• The procedure for "Installing PreciseVision on a PC" must be completed. 
• No camera hardware of any sort is required. 

»   If PreciseVision is not running, click on "Start > Programs > Precise Automation > PV xxx 
> PreciseVision". 
 
»   If PreciseVision is already running, select "File > Quick Start".
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If a pop dow is 
displayed re
these setup steps is required to initially execute the Sample Projects. 

-up window is displayed requesting the specification of the camera hardware or a win
questing that the software be activated, you can cancel out of these pop-up's since neither of 

»   In the Quick Start window, click on the "Samples" button.  A standard file selection pop-up 
window will be displayed that lists a number of Sample PreciseVision Project files (*.pvp). 
 
»   Click on the "ComputeLineExample.pvp" file and press"Open" to load this Project. 

 

The default ould show 
the picture of a "T" part with two green Edge Locators as shown above. 

For robustness, of the stem is 
accurate ind e hould be 
oriented per ixed 
position and orie otated.  To 
create the new tool, the following should be executed. 

 PreciseVision application layout should now be visible and the Camera Display sh

 the visual inspection should be designed such that the measured width 
ep ndent of the orientation of the "T".  To achieve this, the new Edge Locator s
pendicular to the computed Point-Point Line.  If the Edge Locator was just placed at a f

ntation, the width measurement would return too large a value if the "T" is r

»   Double click on the "Edge Locator" in the Vision Toolbox. 
 
»   I h ess n t e Name pop-up, enter "el_measure_width" as the name of this new tool and pr
"Ok".  T efinition Window. he new tool will be created and will appear in the Vision Tool D
 
»   Click on the new tool in the Vision Tool Definition Window and drag it to the Process 
Manager and drop it on "ComputeLine".  This will evaluate the new tool after the Results of 
cl_compute_line are computed. 
 
» s for    In the Property List Display, pull down the entrie "RelativeToolName" and select 
"cl_compute_line".  This makes the position and orientation of the new tool relative to the 
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computed position and orientation of the Point-Point Line Tool. 
 
»   In the Camera Display Window, resize and position the new tool so that it is approximately 
perpendicular to the yellow line for cl_compute_line and stretched across the stem of the "T". 

The Camera Display should resemble the following picture that shows the el_measure_width tool drawn 
across the stem of the "T" and approximately perpendicular to the yellow line for cl_compute_line. 

 

»   To ensure that el_measure_width is exactly perpendicular to cl_compute_line, in the 
Property display, edit "RelAngle" to be an even multiple of 90.  For example, if it has a value of 
-628.2, change this to -630. 
 
»   To automatically test the width of the stem, change "InspectType" to 
"Distance_From_First_To_Last".  This defines the inspected results as the computed 
distance between the first and last edge found by el_measure_width. 
 
»   To define the width dimensions that we will accept as valid, set the "InspectMax" value to 
"31.8" and the "InspectMin" value to "31.2".  
 
»   To display a pass or fail label on the tool in the Camera Display, change "InspectLabel" to 
"Pass_and_Fail". 
 
»   To test the new tool, in the Process Manager, click on "ComputeLine" to select it and then 
click on the circular green "Test Selected Process" button in the window's toolbar. 

Each tim ls.  
The new e drawn perpendicular to the yellow compute should be labeled to 
indicate if the width dimension is acceptable.  The following illustrates a typical image in the Camera 
Display.

e you click the test button, you should now see the new tool in addition to the three former too
 tool should b d line and 
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execute the modified Process, you should review the data displayed in the Results Window tAs you o see 
the numerical value of the computed width.  All of the Results information is also available by selecting 
individual tools and viewing rties List Display.  the data in the Prope

»   If you wish to save your changes to the Sample Project, select "File > Save Vision Project 
As..." and assign a new name to your project so the original Sample is preserved. 

This com ss. 

Tuto
The Fin tifying parts or sections of parts and locating 
their po al situations, other tools can be combined to 
perform torial, three tools were combined to locate 
a known cted to translate and rotate within a limited range.  
The Fin  both identify and locate parts that are 
random g technique. 

In this tu reating and teaching a Finder using a Sample Project.  
This tuto a new Vision Process within an existing Vision Project. 

Prior to executing this tutorial, the following steps must first be performed: 

stalling PreciseVision on a PC

pletes the tutorial on adding a tool to an existing Vision Proce

rial 3:  Applying A Finder Tool 
der is the most general purpose tool available for iden

tation and scale.  For constrained or specisition, orien
 some of these functi an example, in the first tuons.  As 

, in that case, the part was only expe part.  But
der Tool utilizes an advanced patented algorithm to

aininly positioned based upon a simple one-shot tr

torial, we step through the procedure for c
g rial also includes an example of creatin

• The procedure for "In " must be completed. 
• No camera hardware of any sort is required. 

»   If PreciseVision is not running, click on "Start > Programs > Precise Automation > PV xxx 
> PreciseVision". 
 
»   If PreciseVision is already running, select "File > Quick Start".
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If a pop ayed requesting the specification of the camera hardware or a window is 
displayed re e activated, you can cancel out of these pop-up's since neither of 
these setup steps red to initially execute the Sample Projects. 

-up window is displ
questing that the software b

is requi

»   In th window, click on the "Samples" button.  A standard file selection pop-up e Quick Start 
window played that lists a number of Sample PreciseVision Project files (*.pvp). will be dis
 
»   Click ocateRandomlyOrientedPart.pvp" file and press "Open" to load this  on the "L
Project. 

The default P w 
the pictu

reciseVision application layout should now be visible and the Camera Display should sho
re of a circular plastic part with a "V" shaped attachment as shown below. 

 

This Sample Project already includes a Finder as its principal tool.  In this tutorial, we will go through the 
pplied Process steps of re-creating this Vision Process including the Finder.  Before beginning, the su

should be tested to see how the Finder performs on this part. 

»   To see the Finder in operation, click on "Main" in the Process Manager and then click on 
the circular green "Test Selected Process" button in the window's toolbar. 
 
» ct, pull down on the arrow next to the test button    To continuously execute the Sample Proje
in the toolbar and select "Test Loop".  
 
»   To stop the execution, click the "Stop Test Loop" button in the toolbar. 

We will now begin creating a new Vision Process.  In order to perform the image capture, we will reuse 
the existing Acquisition Tool since it has already been initialized to read the desired image disk files. 
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»   Click on the "Add a new Process" button in the Process Manager toolbar. 
 
»   In the Process Name pop-up window, fill in "my_process" as the name and press "Ok" to 
create the Process.   
 
»   In the Vision To  the "picture" tool and ol Definition Window, in the Acquisition folder, click on
drag and drop it on top of the "my_process" in the Process Manager. 

Before performing the next step of creating and tra
information and hints that will aid in applying this to

ining a new Finder, the following is background 
ol. 

When you create a new Finder or re-teach ("re-train") an existing Finder, red and yellow rectangles will be 
drawn in the Camera Display as shown below. 

 

The red rectangle defines the "Finder Template" for the part to be located.  When PreciseVision 
subsequently searches for the part, it is looking for matches for the Template in the image.  When the 
system reports the position and orientation of a matched part, it is actually stating the position of the 
center of the Template when the match was found and the amount by which the Template was rotated.  
When defining the Template, keep in mind the following guidelines. 

• The Template should fully enclose the target object and should contain no other 
objects or parts of objects. 

• The Template should include some of the background on all sides of the target 
object, typically at least 16 camera pixels (too many is better than too few).  This 
allows the system to distinguish the boundary of the object from the background, 
which is especially important for parts with few internal features.  For a 640x480 
camera, 16 pixels is 1/30th of the full height of the camera image.  

• If the background varies considerably (i.e. it is dirty or has blotches), the part 
should be trained on a uniform neutral background. 

• The target object should be oriented in the camera image in what you wa

 

nt to 
define as ‘Zero’ degrees.  That is, when the Finder later locates a part is in the 
trained orientation, it will return an orientation angle of 0 degrees. 

The yellow outline defines the "Training rectangle".  This rectangle is used to teach the system how to 
distinguish the Template from other objects or background clutter.  When defining this rectangle, keep in
mind the following guidelines. 
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• This rectangle must be larger than the Template and must fully enclose the 
Template. 

• This rectangle should include one and only one complete copy of the target 
object.  It's okay if this region includes other partial copies of the target object so 
long as each partial copy is less than 50% of the target object.  

• This rectangle should include any other objects or clutter that are expected to be 
encountered during runtime to aid the system in learning to distinguish between 
the target object and its surroundings. 

s large as possible without violating the rules above.  
 system to test more positions and orientations for the 

t to the Vision Process. 

• This rectangle should be a
A larger region permits the
Template during the training phase and assists in optimizing the runtime search 
strategy. 

It's now time to create the Finder and add i

»   Double click on the "Finder" in the Vision Toolbox. 
 
»   In the Name pop-up, enter "my_finder" as the name of this new tool and press "Ok".  The 
new tool will be created and will appear in the Vision Tool Definition Window. 
 
»   Follow the step-by-step instructions within the "Finder training" Application Wizard that is 
displayed to setup the Finder keeping in mind the   hints above.
 
»   Click on "my_fin  der" in the Vision Tool Definition Window and drag it to the Process
Manager and drop it on "my_process".  This will evaluate the Finder after the camera 
acquisition is executed. 
 
»   To test the new t en ool, in the Process Manager, click on "my_process" to select it and th
click on the circular green  button in the window's too"Test Selected Process" lbar. 

Congra rts!  You 
can continue to click on the 

tulations, you just created your first Vision Process that identifies and locates randomly pa
test button or execute your process in a continuous loop. 

»   If you wish to retrain the Template at anytime, click on "my_finder" in the Vision Tool 
Definition Window to select it.  Then click on the arrow to the right of "Finder Operation Mode" 
icon on the window aining toolbar and select "Train Mode".  You can also restart the Finder Tr
Wizard in this same pull-down if you wish. 
 
»   If you wish to sav ject e your changes to the Sample Project, select "File > Save Vision Pro
As..." and assign a new file name to your project so the original Sample is preserved. 
 
»   At this time, we h le Vision ighly recommend that you execute each of the distributed Samp
Projects, review the and edit the Tool Properties to get an understanding of ir Vision Processes 
more of the vision tools. 

This completes the tutorial on creating a Vision Process and applying the Finder Tool. 
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Tutorial 4:  Deve
This tutorial illustrates how t   It 
presents both the PreciseVis ce 
Controller.  This tutorial requ ced to 
the PC executing PreciseVis

Prior to executing this tutoria ps must first be performed: 

loping a Robot Vision Application 
o develop a simple, but complete, robot vision guidance application.
ion Project and the GPL software that must be executed on a Guidan
ires that your robot and Guidance controller be operational and interfa
ion. 

l, the following ste

• The procedure for "Installing PreciseVision on a PC" must be completed. 
ust be rigidly mounted over a region that can be rea• A camera m ched by the 

robot. 
mera g one 
roce

• The ca
of the p

 interface must be installed and interfaced to PreciseVision usin
dures in the "Hardware Installation" section of this manual. 
ust be fully operati• The robot m onal and interfaced to the PC via Ethernet. 

• The procedures outlined in "Configuring Communication Between the PC and the 
Controller" t

rmed.  
• The "Robot 

hat permit the two systems to exchange data must have been 

Vision Area Camera Calibration
perfo

" must have been executed to define 

• The Guidan

the camera'
camera's fra

s pixel-to-millimeter conversion and the transformation from the 
me of reference to the robot's frame of reference. 
ce Development Suite must be installed on the PC and you should 
est ability to develop and execute GPL programs. have a mod

»   If PreciseVision i  xxx s not running, click on "Start > Programs > Precise Automation > PV
> PreciseVision". 
 
»   If PreciseVision is already running, select "File > Quick Start". 
 
»   In the Quick Start window, click on the "New Project" button. 

You sh e "Cr embles 
the follo

ould now see th
wing. 

eate New Project From Application Template" pop-up window that res
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The "Create New Project Fro ject for 
a number of common tasks. rip" constructs a Project 
that use cate an object and then executes two ClearGrip Tools to verify that the parts 
can be struction.  In particular, this wizard deletes the current Vision Project 
(after c  the Pro ly creates the 
Vision T roc gh the steps to 
position ch of the tools for your parts.  Over time, we will be adding additional templates 
to addr mon tasks and we will be adding the ability for you to add your own templates 
to simplify the use of the system by your co-workers or customers.  Of course, you can always create 
your ow , Pr torials.  
The Ap is ju serve as a 
starting those alrea

For this exe e lePart" template. This takes a single picture 
and then employs a single F

m Application Template" is a wizard that builds a complete Vision Pro
  For example, the "FinderLocatingPartWithClearG

s a Finder Tool to lo
out hitting an obgrasped with

onfirmation if ject should be saved), creates a new Project, and automatical
esses for the selected task.  The wizard then walks you throuools and Vision P

, size and train ea
ess even more com

n Vision Projects
plication Wizard 
 point for 

ocesses and Tools using the basic methods described in the other tu
st a convenience for people learning about the system or it can 
dy familiar with the system. 

rcise, we will b selecting the "FinderLocatingSing
inder Tool to locate your part. 

»   Click on the "FinderLocatingSinglePart.pvt" file, click on "Create" and then follow all of 
the instructions of th  your Vision Project.  At the conclusion of the wizard, the e wizard to create
Project, Process and Tools should all be created and the Finder should be trained on your 
object. 
 
»   Save your Project by selecting "File > Save V t As..." and assigning a file for ision Projec
your Project. 
 
»   To test your Project, place your object in the camera's field-of-view, click on "Main" in the 
Process Manager an the d then click on the circular green "Test Selected Process" button in 
window's toolbar. 
 
»   To validate that the Vision Project and the camera calibration are working properly, using 
the same robot poin ove the ter you used during the camera calibration process, manually m
robot to the X/Y pos  ition indicated in the Results Window "RobX" and "RobY" values and
verify that the tool is at the center of your part's Finder Template. 

Precise tup a ion in 
a speci ork with  there 
is no further development to

The ne  a  "part1" 
Finder he rogram 
is prese c  Vision section 
and is repeated below. 

Vision is now se
al mode to w

nd ready to receive commands.  It is not necessary to place PreciseVis
the robot, it is always listening for commands from a GPL system.  So,
 be done in PreciseVision. 

 GPL project that will execute the Vision Process "Main", retrieve the
 robot to the specified position.  A simplified version of the required p
e Programming Language, Introduction to GPL" manual in the

xt step is to develop
Results and move t
nted in the "Guidan

»   Within GDE, the Guidance Development Environment, in the Project Manager, create a new 
GPL P named "Robot_vision". roject 
 
»   In the new "Robot_vision" Project, double click on the "Main.gpl" file to begin editing. 
 
»   In the editor wind f ow, below the "Public Sub Main" statement, insert the following lines o
text.  If you are read e help file), ing this exercise in the Precise Documentation Library (the onlin
this can be accomplished by copying and pasting if you wish to save yourself some typing. 

 
        Dim vis As New Vision
        Dim vResult As New VisResult
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        Robot.Attached = 1  
        Move.Loc(safe, vsProfile)  
         
        vis.Process("Main") ' Run vision process "Main"  
        If vis.ResultCount("part1") = 0 Then  
            Console.Writeline("Vision object not found")  
            Goto done 
        End If 
  vResu t("part1", 1) ' Get resu      lt = vis.Resul lts  
         
        ' Create a reference frame object and set it  
        urned' equal to the ret  vision location  
        New RDim vsRefFrame As efFrame 
        vsRefFrame.Loc.PosWrtRef = vResult.Loc  
         
        ' Pickup point is relative to new frame  
        vsRelPoint.RefFrame = vsRefFrame  
         
        PoinMove.Approach(vsRel t, vsProfile)  
        oint, vsMove.Loc(vsRelP Profile)  
        (vsRelPoinMove.Approach t, vsProfile)  
         
        ' Move back to safe location  
        Move.Loc(safe, vsProfile)  
         
    d neo :  

»   In the the "Robot_vision" Pro .gpo" file to access the ject, double click on the "GModule
global Motion Objects panel. 

»   C ea tion n g r te and teach a Loca amed "safe" that positions the robot so it is not obstructin
the c m rt.  Als e a era's view of the pa o, create a Motion Profile named "vsProfile" that will b
used to slo robot to twly move the he part. 
 
»   Create a Location named "vsRelPoint".   This will define the robot's pickup position relative 
to the Location returned from Prec  define this iseVision.  Normally, it would be best to manually
Loca n ion tio  relative to the actual value returned from the vision system.  But for demonstrat
purposes, set its properties to the a safe world coordinate value  following where the Z value is 
above the part. 

X = 0 
Y = 0 
Z = Z_safe  
Yaw = 0 
Pitch = 180 
Roll = 0 

» Press the "Save Document" ic e your changes. on on the main tool bar to sav
 
» To a  the  lo d your application, in the Project Manager, drag the "Robot_vision" Project from
PC to th jects"e top "Loaded Pro  panel and drop it. 

You have now c en omplete 
vision guided 

ompleted the developm
plication.  

t of the GPL Project and we are ready to execute the c
robot ap
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DANGER: Before pr
robot has been prop
installed and tested, r the 
PrecisePlace robots, this information is provided in the “PrecisePlace 
2300/2400 Robot, Hardware Introduction and Reference Manual”. 

 

oceeding with this procedure, please ensure that the 
erly mounted, all required safety interlocks have been 
and power has been connected.  Fo

»   In the GDE Robot Control Window, set the "Robot Speed" to approximately 5%.  This will 
force your Project to move the robot at 1/20th of its normal speed. 
 
»   This next action will move the robot automatically to a position computed by 
PreciseVision, so be prepared to hit the E-Stop button or disable power if any problem 
occurs! 
 
»   With your part placed in the camera's field-of-view, execute the GPL Project.  When you run 
a GPL program for the first time, it is advisable to start the project in debug mode. This can be 
done by selecting "Debug > Start with break" or pressing "Shift-F5". Single step through the 
program one line at a time by pressing "F10".  

Congratulations, you just created your first full vision guided robot application! 

For more information on the GPL vision interface, please read the Vision Guidance chapter of the 
"Guidance Programming Language, Introduction to GPL" manual.  This contains an overview of the built-
in GPL vision classes, methods and properties.  For more detailed information, please see the "Guidance 
Programming Language, GPL Dictionary Pages".
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PreciseVision User Int
The PreciseVision Graphical User Inte f the 
opened project, a top menu bar, a mai ckable 
windows can be displayed or hidden, r efficient 
for your use.  

When PreciseVision is started for the f s elements 
of the GUI is presented. 

ical User Interface 

erface 
rface (GUI) consists of a title bar that displays the name o
n toolbar, and a variety of dockable windows. Each of the do
esized and repositioned into the arrangement that is most 

 

irst time, the following default arrangement of the variou

 

To reposition a window, you simply click in its title bar and drag it to its new location.  If you drag a 
window on to another window, they can split the space or share the space using tab controls.  If you click 
on the close icon (x) in the top right of a window's title bar, you can use the "View" top-level menu to 

 the top right of a window's title bar, you will either 
w so it can share its space with another window. 

Windows can be resized by grabbing a border and stretching or shrinking it to the desired dimension. 

redisplay the window.  If you click on the "push pin" in
"pin" a window and fix its location or "un-pin" a windo
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In the following sections, the functions supported by each of the major elements of the PreciseVision GUI 
(i.e. main menu bar, tool bars, and windows) will be described.  In addition, the Preferences Panel for 
specifying system configuration information is also described.  The graphical components are presented 
in order of importance rather than alphabetically.  To jump to a specific description, click on a label in the 
picture above or on a window. 

ar provide access to general functions such as displaying the 
  

Main Menu and Toolbar 
The Main Menu and the Main Toolb
dockable windows, saving and loading Vision Projects and launching the camera calibration operations.
This menu and toolbar appear as follows. 

 

The following tables describe the operation of each of the selections within the Main Menu and are 
organized by the name of the top-level menu.  These tables are followed by a description of each of the 
Toolbar buttons. 

File Description

Quick Start  be loaded, sample canned Projects to be loaded, or a new Project to 
mmon 

viduals 
who wish to learn about machine vision or PreciseVision.  

Displays the pop-up Quick Start window that is shown each time 
PreciseVision is started.  This window allows an existing Project to 

be constructed by a step-by-step wizard that supports many co
procedures.  The latter two options are very instructive for indi

New Vision Project 

 a sub-menu with selection either an empty un-
sion p 

wizard that su
ctio

diting 

Displays
named Vi

s that create 
 Project or a new Project constructed by a step-by-ste
pports many common procedures.  An additional sub-
n permits the last executed wizard to be re-executed to 

of the previously generated Vision Process. 
menu sele
allow e

Open Vision Project 

Opens a new
replacing the ndow 
is displayed t
project files h

 Vision Project from the disk and loads it into memory 
 current Vision Project. The standard file pop-up wi
o allow browsing to the desired folder.  PreciseVision 
ave a ".PVP" file extension. 

Import Vision 
Project 

 
th ains 

any processe
already loade
any camera c

ct is igno

Loads in the
contents wi

Vision Project contained in a file and merges its 
 the currently loaded project. If the new project cont
s or tools whose names conflict with items that are 
d, "_r" is appended to the name of the new item. Also, 
alibration information that is contained in the new 
red. proje

Expo  V
Project 

ies the cu s 
part of the co
vision tools, s

Normally, PV
permit them t rojects.  If you manually copy 

roject area k to 
the file will be broken.  The Export utility can automatically copy the 

rt ision calibration file
 

Cop rrently loaded Vision Project into another directory.  A
py operation, the extra files associated with certain 
uch as Finder templates files, and the camera 
s can also be automatically copied.   

 stores camera calibration files into a central folder to 
o be shared by multiple P

a p , the calibration file will often not be copied or the lin

49 



PreciseVision 

applicable cal
the link.  If th

ation file

The Export fu
each with uni  
same Vision Project.  In this case, you should Export the Project 
without calibration files and with zero'ed links.  For each PV system, 
you start by loading its unique calibration files.  You then load the 

ect to associate the generic Project with the individual 
s.  

ibration files with the other Project files and can zero 
e link is zeroed, when the Project is reloaded, the 
s stored in the Project folder will be utilized. 

nction is also useful if you have multiple PV systems, 
que camera calibrations, but you wish to execute the

calibr
 

exported Proj
calibration file

Save Vision Project  
Save Vision Project 
As ...  

displays a pop-up file window to allow the operator to browse to the 
desired disk folder and assign a disk file n

Either saves the loaded Vision Project to its associated disk file or 

ame. 

Close Project  

Closes the loaded Vision Project after prompting if any changes 
should be saved to the Project's disk file.  The close operation 
deletes all defined tools and Vision Processes resulting in an empty 
un-titled Project.  

Preferences 

Displays the PreciseVision Preferences panel.  This panel contains a 
number of application setup parameters that customize the operation 
and appearance of PreciseVision, e.g. enable/disable the display of 
the Main Toolbar or tool graphics.  

Acquire New Image  Takes a single snap shot from the currently selected camera and 
loads the image into the Camera Display window.  

Reinitialize Camera 
Connections  

Reinitializes Dalsa cameras that have stopped operating after being 
disconnected and reconnected or due to network connectivity 
disruptions. PreciseVision normally tries several times to reconnect 
to cameras that are no longer operating, but will eventually stop 
retrying. This function forces the system to perform additional retries. 

Image Load / Save  
Diagnostic and debugging aid that loads a camera image from a disk 
file into the Camera Display window or saves the currently displayed 
image to a disk file.  

Lock / Unlock 
Application  to no longer operate corre

removes most toolbar ite

Locking an application prohibits users from modifying the loaded 
project. This is useful for avoiding situations where a user might 
inadvertently change a parameter or tool and cause a vision project 

ctly. Locking dims out all menu items, 
ms, and inhibits closing PreciseVision. 

Unlocking requires a password if a password has been defined in the 
Preferences panel.  

Exit Terminates execution of PreciseVision  

 

View Description

Layouts set back to the normal default.  Also provides "Load Runtime 
Layout", "Load Edit Layout" and "Load Calibration Layout" for putting 
standard layouts into effect.  These standard layouts can also be 
accessed from the main toolbar. 

Provides "Load Default", "Load Layout" and "Save Layout" selections 
for permitting custom desktop layouts to be preserved, reloaded or 

Select Camera Display window.  This also specifies the camera that is utilized in the 
Camera Calibration methods and other functions.  

Selects the camera whose image is to be presented in the Camera 
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Debug 

Brings up a submenu that permits displaying log files that contain the 
bi-directional communication messages between PreciseVision and 
Guidance Controllers or Remote PC Servers.  Generating these log 

p. files can be enable via the Preferences Pop-U
Proc ses  Manager  
Vision T
Defi o

ool 
niti n  

Vision Toolbox  
Property Display  
Results Display  

Permits any dockable window that has been closed to be re-
displayed.  

Guidance Web 
Panels  

Opens up to three web panels specified in the 'Preferences -> Web 
Interface' tab. This provides convenient access to the Precise 
Guidance Controller web interface. 

Project Version  currently loaded vision project.  
Sets and displays the version number and text description for the 

Refresh window.  This is convenient because the graphics can 
sometimes be lost when PreciseVision is minimized or if you click on 

Redraws any graphics generated by vision tools in the Camera 
Display 

certain panels.  

 

Tool Description

Calibrate Visio

Initiates the execution of the camera calibration wizard.  This 
re determines the pixel-to-m version for the 
 camera and also the conv e camera's frame of 

ference to t

n  procedu
selected

illimeter con
ersion from th

re hat of the robot.  

Camera Calibration 
Configur

o  that associates a camera calibration file 
ifi n 

Project.  ation  with a spec
in this pop-up

Displays a p p-up window
c camera in the current Vision Project.  The informatio
 is saved and reloaded with the Vision 

Show Camera 
Inform t

Displays a po
 ca ion the camera

p-up window that shows which camera is selected and 
alibration data that is in effect.  

Camera Video 
Prop tie

Displays a po ness range and 
offset for the 

n
er s  during the se

other functio

p-up window that permits the bright
currently selected camera to be set.  This is helpful 
tup procedures for the Camera Calibration methods and 
s. 

Show Vision Tool 
Cross Re
Inform t

Displays a po s 
and vision too

d vision
ision too

relationship b

ference 
ion  

define
any va

p-up window that either: (1) lists the vision processe
ls that reference each defined tool or (2) lists the 
 tools that are not referenced by any vision process or 
l.  This function is useful for understanding the 
etween vision tools in complex applications.  

 

Help Description
Contents 
PreciseVision GUI  
Vision Tools 
Overview  
GPL Programming  

Opens the Precise Documentation Library in a separate window and 
jumps to the specified section that is relevant to PreciseVision. 

Product Activation Displays the pop-up window used for activating this product. 
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Camera Driver Info  Presents the version and identification information for installed 
camera drivers. 

About PreciseVision and ID information along with build information for key components of 
this application package. 

Generates a popup window that displays the PreciseVision version 

 

Icon Tool Tip Title Description

 Project  If the current Project has been changed and needs to 
be saved to the disk, a pop-up is first presented that 
permits the operator to save the modifications. 

Create new Vision 

A new empty un-named Vision Project is created by 
deleting all of the tools and existing Vision Processes.  

 
Save current Vision 
Project to disk  

the current project has never been saved to the disk, a 
file pop-up window is displayed to allow the operator to 
browse to the desired disk folder and assign a disk file 
name. 

Saves the loaded Vision Project back into its disk file. If 

 Open a Vision Project  

Opens a new Vision Project from the disk and loads it 
into memory, replacing the currently loaded Project. 
The standard file pop-up window is displayed to allow 
browsing to the desired folder.  PreciseVision project 
files have a ".PVP" file extension. 

Display live video 
camera image  

Places the current mera into "Live Video" 

 is 

e 

ly selected ca
mode.  Pictures will be taken continuously and 
displayed in the Camera Display window.  This mode
very convenient for setting up the focus, f-stop, gain, 
and offset of a camera.  If the camera is already in liv
video mode, pressing this button will terminate this 
mode.  

 

Take a single snap shot 
Takes a single snap shot (i.e. picture) using the 
currently selected camera and displays the results in 
the Camera Display window. 

 

 
Toggle Color Di
Mode  

spl  ay For color cameras only, toggles the Camera Display
window display between color and grayscale mode.  
Set to color display mode by default.  

 
Zoom the Camer
Display w

a 
indow  it 

nge 

Zooms the Camera Display window view in or out.  
Pressing the button zooms in.  A pulldown menu tied to 
this button zooms out or resets the window to its un-
zoomed state.  If "Zoom Auto" is selected, the active 
vision window is automatically scaled so as to best f
within the display window.  The zoom factors ra
from 0.1 to 5 in steps of 0.1. 

Refresh Camera Di
window graphics  Vision 

splay 
Redraws any graphics generated by vision tools in the 
Camera Display window.  This is convenient because 
the graphics can sometimes be lost when Precise
is minimized or if you click on certain panels.  

 

 Switch display layout  
Switches between three predefined display layouts: 
Edit, Run and Calibration. This icon makes changing 
the display layout very easy.  

Lock / Unlock 
 Application  

Locking an application prohibits users from modifying 
the loaded project. This is useful for avoiding situations 
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where a user might inadvertently change a parameter 
or tool and cause a vision project to no longer op
correctly. Locking dims out all menu items, removes 
most toolbar items, and inhibit

erate 

s closing PreciseVision. 
Unlocking requires a password if a password has been 
defined in the Preferences panel.  

Vision Camera Display 
The Camera Display window shows the captured image from a selected camera with graphics to illustrate
applicable vision tools.   The camera image can be a "live video" display, which means that the captu
image is co

 
red 

ntinuously updated, or a single snap shot.  The vision tool graphics illustrate the placement of 
tools and their computed results.  When a tool is selected for editing, the graphics also include handles 

f 
 and the Y-axis points from the bottom of the display 

to the top.  The origin (0,0) of the camera coordinate system is in the lower-left corner of the camera 
image.  If the camera is not calibrated, X/Y positions in the camera image are returned in units of raw 
pixels relative to the lower-left corner of the camera image.  If the camera is calibration, X/Y positions are 
typically in units of millimeters relative to the origin. 

that permit the tool to be easily re-positioned, re-oriented and re-sized using a mouse. 

The following picture is a typical camera image with overlaid tool graphics.  For all cameras, the X-axis o
the camera coordinate system points from left to right

 

hose with many or few pixels), the camera display can b
 this operation is provided on the Main T

To accommodate large or small images (t e 
zoomed out or zoomed in.  The control for oolbar along with icons 
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for manually placing a camera into live video mode and taking a snapshot.  The Main Menu contains 
other commands for changing the selected camera and adjusting their gain and offset. 

The following i e how to utilize the graphical ha e and size a typical vision tool 
and opt ntrolling how the r ow. 

mages describ ndles to plac
ions for co esults of a tool are illustrated in the Camera Display Wind

Graphical Display  Description

 

tool and marks the best fit line. 
 
To position the tool, click anywhere in the search region 
and drag the rectangle.  To resize the tool, click one of
four blue squares an

This is a snap shot of a Line Fitter Tool placed over one 
 

 

 of the edge.  The red line illustrates the results of the 

 the 
d drag.  To rotate the search region, 

edge of a part. The green and blue perimeter lines indicate
the tool's search area.  The blue edge marks the side of
the search region that should be positioned on the dark 
side

click the blue circle and drag. 

 

as a single position.  In this picture, the 

If the output of a tool is to be utilized as an input (X, Y) 
point for another tool, it is informative to display the result 

ShowResults 
property for the Line Fitter has been set to "POINT".  This 
places a yellow "X" at the origin of the output of the Line 
Fitter.  Note, setting ShowResults only affects the 
graphical display and does not alter the results computed 
by the tool. 

 

In this example, if the output of the Line Fitter is to be 
interpreted as a line, the ShowResults property for the 
Line Fitter can be set to "LINE". 

 

In this final example, the output of the Line Fitter is to be 
interpreted as a reference frame, so the ShowResults 
property for the Line Fitter has been set to "FRAME". 
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Process Manager Wind
The Proce  displays  in the 
currently lo d t.  If a Vis r the Process 
are displayed in the order in which they anaging 
Vision Pro se ny 
Process that is displayed in this window cise 
Guidance C tr

A typical Proces  is s

ow 
ss M
ade

anager Window
 Vision Projec

 the list of all of the Vision Processes that are contained
ion Process is expanded, all of the Vision Tools fo
 are evaluated.  This window is the primary means for m
n, renaming, deletion, modification and test execution. A
 is eligible for execution by a

ces s including their creatio
 GPL procedure running on a Pre

on oller. 

s Manager Window hown below. 

 

In this example, a single Vision Process "LocateMultipleParts" is contained in the currently loaded Vision 
Process begins with the standard Acquisition Tool that 

em evaluates a Finder Tool named "part".  The final 
operation is an Edge Locator "el_test_part". 

matically execute the Finder if the Finder had not been 
evaluated.  The decision of whether to include the Finder in the Vision Process is entirely a matter of 

 identical 
e execution time. 

To add a new Vision Process to a Project, click the toolbar icon to "Add a new process". Once the new 
Process is assign que name, it will appea
specify the sequence of tools n 
Tool De indow and d  end of 
the Process and can be re-or rrows in the toolbar.  The order of 
appearance of the tools is im . 

After a Vision Process has be thin the 
Process Manager window an

Once a Vision Process has b sing 
an icon on the toolbar.  The m ted 
continuously.  The continuou on of 

Project.  This Vision Process has three tools.  The 
takes a picture.  After the picture is captured, the syst

It should be noted that if the Edge Locator is defined relative to the Results of the Finder Tool, the 
Process could have been written without the explicit execution of the Finder.  When the system 
encounters the Edge Locator, it would auto

personal preference.  Whether or not the Finder is included, the Results of the Process would be
as well as th

ed a uni r as a top-level (i.e. left-most) item in the window.  To 
 to be executed in the process, simply drag Vision Tools from the Visio
rop them on the Process.  New tools are automatically added to the
dered by using the up and down a

finition W

portant since the tools are evaluated top to bottom in the displayed list

en created, it can be renamed by right-clicking on its name wi
d selecting "Rename Process." 

een created, it can be triggered from GPL or can be manually tested u
anual test can be executed a single time or the process can be execu

s test mode is intended for demonstration purposes since the executi
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the Process will not be synch ractical 
use. 

The following tables provide rmation on each of the window toolbar options. 

ronized with the GPL robot program and therefore not of very much p

additional info

Icon Tool Tip Title Description

Add new pro
gned a 

unique name via a pop-up window.  The Process 
 GPL 

cess 

Creates a new Vision Process and adds it to the 
Process Manager Window after it has been assi

names are very important since they are used by
procedures to initiate the execution of a Process. 

 

Test selecte
e 
ith the 

d process 

Test executes the selected Process once or 
continuously.  This is useful for debugging a Process 
and examining its computed results.  However, in a 
robot guidance application, Processes are always 
initiated from a GPL procedure to ensure that th
picture taking and evaluation are coordinated w
robot motions. 

 

Stop test loop 
If a process is running in a continuous test mode, this 
button will stop the Process. This is only used while 
manually test executing a Process. 

 

ected item 

Removes a Process from a Project or a tool from a 
Process.  In both cases, any referenced tools are not 
deleted from the Project, only the reference to the tool 
is removed.  To delete a tool, you must use the Vision 
Tool Definition Window. 

Remove sel 

 Move tool up 

Move tool d
 

sses 
ure and 

ed. 

own 

Moves a vision tool up or down one line in a Vision 
Process list.  The order in which the tools are listed in a 
Process is important because this is the order in which 
the tools are evaluated. If a Vision Process is selected,
these button will change the order of the Proce
within this window.  This is a convenience feat
does not alter how Vision Processes are execut

 

Vision Toolbox W
The Vision Toolbox Window construct 
a Vision Process.  The top of

indow 
displays a list of all of the vision tool types that can be employed to 
 this list currently looks as shown below. 
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To add a new tool to an appl ect "Create 
Tool".  A pop-up will be disp l.  Once a name 
has been assigned, the new dow.  Once there, the tool 
can be edited or dragged into the Process Manager to add the execution of the tool to a specific Vision 
Process. 

Vision Tool Definition Window 
The Vision Tool Definition W
Vision Project, even those th es the 
primary means for adding too
convenience, this window gra  tools.  

A typica finitio

ication, double click on a tool type in this list or right-click and sel
layed for assigning a unique name to the new copy of the too
tool will appear in the Vision Tool Definition Win

indow displays all of the tools that have been created in the currently loaded 
at are not referenced in any Vision Process.  This window provid
ls to a Vision Process and for selecting tools to be edited.  As a 
phically indicates when tools are dependent upon the results of other

n Window will appear as shown below. l Vision Tool De

 

ll of the defined tools are grouped according to their tool type and
tools defined are visible.  In the example above, there is one Acquisit
 Locators named "edge_2" and "el_test_part" and on

To simplify accessing tools, a  only tool 
types that have one or more ion Tool 
named "picture_1", two Edge e Finder Tool named 
"part".  The second Edge Locator has been defined with respect to the results of the Finder, so the Finder 

art" appears below "el_test_part" to indicate this relationship. 

There are a number of ways that a new tool can be added to the Vision Project and the Vision Tool 
Definition Window: 

• Double click on a tool type in the Vision Toolbox Window. 
• Right-click a tool or tool type in the Vision Tool Definition Window and select 

"New Vision Tool". 
• Drag a tool type from the Vision Tool Definition Window and drop it into the 

Camera Display Window. 
• Right-click in the Camera Display Window and select "New Vision Tool". 

To copy an existing tool while maintaining its dependencies to other tools, highlight the tool in this window 
and click the "Copy" icon in the toolbar or drag the existing tool and drop it into the Camera Display 
Window. 

"p
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To edit a tool, simply click on the name of the tool.  This will automatically display the properties of the 
tool in the Property Display Window and will highlight the editing graphics and the handles for the tool 
within the Camera Display Window. 

To test the operation of a ck the "Play" 
button in the toolbar.  Th t is dependent.  If the 
tool on which it is dependent returns multiple results, e.g. a Finder, only the first set of results is 
processed by the tool being executed.  This is done to permit you to easily reposition the executed tool. 

on on each of the window toolbar options. 

 tool without executing a Vision Process, click on the tool and cli
is only executes the selected tool and any tools on which i

The following tables provide additional informati

Icon Tool Tip Title Description

 Create copy Copies the selected tool along with its relationships to 
other tools. 

 Remove selected tool Deletes the selected tool after confirmation but doe
not effect any tools that it references. 

s 

 Execute selected tool 
Executes the selected tool and all of the tools on whic
it is dependent without executing a Vision Process.  
See above for further information. 

h 

 Finder operation mode 

between "Find" and "Train" 
mode. Can also launch the Training Wizard to assist in 
teaching a Finder Tool and can display a trained Finder 

For Finder Tools, switches 

template at various resolutions as a diagnostic aid. 

 
Perform training 
operation 

For tools that require training, executes the training 
process. In the case of the Finder Tool, this records the 
Finder Template and performs the analysis to 
determine distinctive features and the maximum level
of the search pyramid. 

s 

Prop ispla
In Preci on Tool is int re rs for 
each to  as its "P The w a tool 
operates (e.g. its tool type, tool name, position, s well as the values 
that indicate the results of executing the tool (e.g ated, 
etc.). F list of p om 
one type of tool to the next. 

Some Vision cial butto  that a erty 
grid.  T ce spec
automatically snapping a tool into position). 

The Pro  provide onve erty 
values of a to perty Li elow. 

erty List D y 
seVision, each Visi
ol are referred to

ernally 
roperties".  

presented as a software "Object". The paramete
 properties include both the values that specify ho
ize, operating characteristics, etc.) as 
. number of objects found, number of edges loc
roperties is always the same, but the list will vary fror a given type of Vision Tool, the 

Tools provide spe
hese buttons provide ac

ns
ss to tool 

re displayed between the tool name and the prop
ific operations during the editing process (e.g. 

perty List Display
ol.  As an example, the Pro

s a very c nient means for both viewing and editing the prop
st Display for a typical Fixed Frame Tool is shown b
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ts the tool to be displayed.  The displayed tool wil
reated or a tool is selected in the Vision Tool Def

The pull-down list at the top of the window selec l also be 
automatically changed whenever a new tool is c inition 
Window. 

Once a tool has been selected, any of its writabl d 
entering a new value.  When a property is select  at the 
bottom pertie do

To assist in accessing these parameters, the pro escription of 
each of the groups is presented in the following s for each 
of the tool types please see the chapter on the "

e values can be modified by clicking on a cell an
ed, a short description of the property is displayed
nly are indicated by dimmed text. 

perties are group according to their use.  A d
table.  For detailed information on the prop

of the window.  Pro s that are rea

ertie
Vision ToolKit". 

Property Group Description
1. Identity Properties Specifies the name of the tool and its basic tool type. 

2. Placement / Size 
Properties 

Defines the  the 
coordinate s ol is 
defined rela

 c
 p e 

andle . 

position, orientation and size of the tool in
ystem of the camera.  In addition, if the to
tive to another tool, the relative position and 
an also be specified.  Normally, it is easiest to 
osition and size each tool by dragging on th
s displayed in the Camera Display Window

orientation
graphically
tool's h

3. Operation Properties 

Defines para
, a t
f it s
e le

meters that control the execution of the tool.  For 
ool might have an Operation Property that 
hould screen out black-to-white edges o

example
defines i
gray scal

r the 
vels above which pixels are processed. Only the 
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commonly u
group. 

sed Operation Properties are placed in this 

3A. Advanced Operation 
Properties 

Contains Op ified 
and general  bit more experience to utilize.  For 
these prope
performance

eration Properties that are not normally mod
ly require a
rties, their default settings will yield good tool 
 for typical applications. 

4. Inspection Settings 
Properties 

s a si
automaticall  
limits.  A Pa  a Pass / 
Fail label ca

Permit ngle scalar result of the vision tool to be 
y tested (inspected) to verify that it is within
ss / Fail property is set accordingly and
n be optionally displayed on the tool in the 
play Window. Camera Dis

5. Results Settings 

r 
example, if m mputed by the 

e p
d a  is displayed in 
lts

Properties 

Controls the results that are computed by the vision tool.  Fo
ultiple sets of results can be co

tool, thes
compute

roperties can limit the number of sets of data 
nd can select the set of data that

the Resu  Properties. 

6. Results Properties 

a si f results for the vision tool.  In general, 
the results r  

n refe
nal re
e ans

Displays ngle set o
eturned varies from tool to tool. Many tools return
rence frame.  However, some tools return 
sults items such as statistical information on how 
wer fits the actual data. 

a visio
additio
well th

Vision Results Display 
The Vision Results Window displays the "Result eviously 
execute   For po nd orien ision 
coordinate system and the robot coordinate syst data.  The 
information contained in this display is automatically u ach time a Vision Process completes 
executio

A typica esults of a Vision Process that contains both a Finder and a Edge 
Locator To
or Conn hted 

s" properties for all of the tools evaluated in the pr
tation data, the results are displayed in both the v
em utilizing the applicable camera calibration 

pdated e

d Vision Process. sition a

n. 

l display that illustrates the r
ol is shown in the following picture. For tools that return multiple sets of results (e.g. the Finder 

ectivity), if you click on a line in the Results display, the corresponding object will be highlig
with a blue coordinate frame in the Camera Display. 

 

The follo bles provid onal information on t vided in 
each column of the results table. 

wing ta e additi he window toolbar options and the data pro
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Icon Tool Tip Title Description

Save 

Stores the re
(*.CSV) that n 
for further pr  
displayed to 
to be specifie

sults data in a comma delimited file 
can be read into a spreadsheet applicatio
ocessing.  A standard popup file window is
allow the file name and disk directory path 
d. 

 

Copy to clipboard 
Copies the c
clipboard in a
information c

ontents of the results table to the system 
 comma delimited (*.CSV) format.  This 
an then be pasted into another application.

 

 Timer 

Displays the -level tool in 
the previous
to sults. T
displayed as e for 
all tools in the process, in milliseconds. 

execution time for each top
ly executed vision process in place of the 
he incremental time for each tool is 

 well as the cumulative execution tim
ol re

 

Data Column Description

Name Specifies the name of the vision tool that generated the 
results. 

Idx for the set of re
For tools that return multiple sets of results, this is the index 

sults that is displayed on a line.  The index 
value goes from 1-n. 

Vis X 
Vis Y 

Vis Angle 

For to eturn a position and this is the X & 
Y position in millimeters and the angle in degrees.  These 
val  co
vie

ols that r  orientation, 

ues are in the ordinate system of the camera's field-of-
w. 

Rob X 
Rob Y 

Rob Angle 

For tools that return
Y position in millim
values are in the ro  
va an
guidance applicatio

 a position and orientation, this is the X & 
eters and the angle in degrees.  These 
bot's world coordinate system and are the
sferred to a GPL program in a vision 
n. 

lues that are tr

Passed Pass / Fail results o
value as the Inspe

f the tool Inspection.  This is the same 
ctPassed property. 

Insp Val Ac al
This is the same va

tual property v ue that was tested by the tool Inspection.  
lue as the InspectActual property. 

Special Results 

Each vision tool ma
to o
the area of located l 
Results column pro y up to 20 tool 
spe er  
sa  c
the fo
documentation for 
W ivi  
fet su
number in the Spec n. 

y have additional results that are unique 
r example, the Connectivity Tool returns 
 blobs (ResultBlobArea).  The Specia
vides a place to displa

the tool type. F

cific results p  vision tool.  These special results are the
an be retrieved by a GPL program using me values that

 VisResults.In  method and are indicated in the 
each tool by [GPL: VisResult.Info(x)].  
ty Tool is executed, the blob area can be
lt.Info(3)

hen a Connect
ched as VisRe  and will be displayed as the 3rd 

ial Results colum

Errors and Warnings tool was executed.  This is the same value as the 
Specifies if an error or warning condition occurred when the 

ResultErrorCode property. 
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Appl
The bottom o reciseV pplication win contains the Status Bar.  This area continuously 
displays status information on the execution of the application.  The les the 
following

ication Status Bar 
f the P ision a dow 

Status Bar typically resemb
. 

 

The info ntained in each of the columns of the ble. rmation co  Status Bar is described in the following ta

Col # Data Description

1  Server status 
Indicates Ether PreciseVision and a 
Guidance Controller.  Each time a message is received, 

net traffic between 

the icon will flicker. 

2  Image status 
Indicates if the selected camera is in "live video" mode 
(bright light bulb) or a single still image has been 
captured. 

3  Camera calibration file Displays the name
currently selected 

 of the camera calibration file for the 
camera. 

4 ra ca n 
 

Displays the type of camera ca is in effect for 
the curre tly selected camera,  Only, Robot 
Vision, etc. 

  Came
type

libratio libration that 
 e.g. Cameran

5  Process execution 
time 

Indicates the total time required to execute the last Vision 
Process in seconds. 

7  Camera coordinates 
and intensity readin

Shows the X/Y position of the mouse cursor in calibrated
camera coordinates and the gray-level intensity value

g 

 
 of 

the associated camera image pixel.  This is useful for 
setting threshold and edge level values. 

8
currently loaded Vision Project has been 

modified in any way and must be saved to the disk in 
ord serve the changes. 

  Project modified flag 
Indicates if the 

er to pre

Preferences Panel 
The Preferences Panel contains a number of application s ration 
and appearance of PreciseVision.  Once saved, these pre  put 
into effect each time the application is restarted. 

The Preference Panels appears as 

etup parameters that customize the ope
ferences are automatically reloaded and

shown below. 
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When any data in the Preferences has been modified, the "Update" button must be pressed before the 
change 

In the follow figur forma ented on each t el is briefly 
described. 

will take effect and be preserved. 

ing table, the con ation in tion pres ab of this pan

Tab Description

Acquire 
Defines the default disk file  an 
Acquisition Tool is executed  
convenience for logging ima

path for storing camera images when
.  This is a debugging and diagnostics
ges. 

Auto Start 

Spe Visio  th  
Pre  is re d.  O
Processe y 
procedure executing on a G
 
This tab also contains the 'S
spe out w utom
is sta sy e 
'Run Mode' layout. 
 
Options are also provided to  PreciseVision minimized and / 
or in a locked mode that pre o 
the loaded processes.  To s
Access tab. 
 

s p ha
execution for a spe um
PreciseVision is automatica  
PC requires time to initialize

cifies a n Project at will be automatically loaded each time
nce a Project is loaded, its Vision 

available for execution by a GPL 
uidance Controller. 

tartup Layout' specification.  The 
atically loaded each time PreciseVision 

stems this would normally be set to th

 start up

ciseVision
s are immediatel

starte

cified lay
rted. For produ

ill be a
ction 

vents operators from making changes t
et the lock password, see the User 

t will delay PreciseVision from starting 
ber of seconds. This is beneficial if 

lly started when the PC boots up, but the
d its network cards and camera 

A parameter i rovided t
cified n
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interfaces. 

Camera Hardware 

Specifies the type of camera
images, e.g. Ethernet or US
number.  Some of the data s
panels are specific to the typ
these parameters are define
installation process. For mo see 
the Camera Installation

 hardware to be used to capture 
B, and defines each camera's logical 
pecified on this panel and its sub-
e of camera being employed.  Normally, 
d during the software and camera 

re information on this panel, please 
 sect

information on configuring each type of supported camera. 
ions of this manual for detailed 

Client Setting

Defines the Ethernet IP add
accessed during the camera
ope the co r IP
the comm s that GPL sen

s 

ress for the Guidance Controller that is 
 calibration process.  For normal 

 address is automatically deduced from 
ds to PreciseVision. 

rations, 
and

ntrolle

Data Logging 

Enables the logging of Visio
diagnostic purposes. Each t re 
time stamped and stored in  
format (*.csv).  This file can 
spreadsheet application for 
 
Also provides a  to
comm ations  Pr  
and Remote PC Servers.  N
debugging purp  it

n Tool Results to a disk log file for 
ime a tool is executed, its Results a
a specified file in a comma delimited text
be easily imported to Excel or another 
analysis. 

 enable logging of bi-directional 
eciseVision and Guidance Controllers
ormally, this should only be enabled for 
 consumes resources.

 checkbox
 between

oses since

unic

Environment minimized to an icon in the System Tray as opposed to an item on 
the Windows Start Bar. 
 
An "Auto Zoom" feature is also provided that automatically scales 
the active camera image to best fit within the camera display 
window. 

Controls whether the Main T
displayed.  Also permits adju
demonstration parameters. 
 
In addition, a checkbox is provided to permit PreciseVision to be 

oolbar and the Status Bar are 
stment of some diagnostic and 

Layouts 

Defines three user-interface layouts of the dockable panels. These 
outs provide an easy way to quickly switch between several 

ay formats that are appropriate for different operating needs: 
pr n sys ting sessions and ocesses. 
 
If the "Layout Filename" is  
u defined default lay
installation directory. If the 
override these defaults. 
 
Click the "Current" button in  the 
window (width and height) 

lay
displ

oductio tems, edi  calibration pr

left blank, PreciseVision will automatically
out stored in the "Layout" folder of the 

field contains a valid layout file, it will 
se a pre

 each selection to record the size of
automatically. 

Live Video 

Controls the rate at which t
Video mode. This permits t
balanced when using Preci
 
The update rate ranges fro
default setting of 10.  For c  
rate of 1 to 15 fps is typical 000Mb 
Ethernet, the refresh rate c . 
 

he camera image is updated in Live 
he Ethernet network traffic to be 
seVision. 

m 1 to 30 frames per second (fps) with a 
ameras interfaced at 100Mb Ethernet, a
.  For cameras interfaced at 1
an be as high as 30 fps
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T NOT available et 
to the maximum defined by t 
operate properly if the live f

his mode is  for USB cameras. The frame rate is s
 the camera. Some USB cameras do no
rame rate is set to certain values. 

Tool Operation 

Enables and disables the R
required tools.  This is typic ed 
that analyzes the output of lts, 
s  Finde d the I spection 
operations.  Enabling this p
results even if their inspect
generating complete, consi t 
to test.  This property is nor ost vision 
processes prefer to ignore  inspection test  
This property is disabled by default. 

esultOnNotFound property for all 
ally set if an Inspect List Tool is defin
a tool that generates multiple resu
nspect Listuch as a r, an  includes multiple in
roperty forces all tools to generate 
ion tests fail.  This is important for 
stent sets of results for the Inspect Lis
mally disabled since m
any object that fails an

User Access Defines the password used to unlock access to PreciseVision. 

Vision Graphics 

Enables and disables the display of Vision Tools and their Results in 
the Camera Display Window.  Drawing these graphics has relatively 
little impact on the performance of the system, so the graphics are 
normally displayed. 

Web Interface 

Enables up to 3 web panels to be configured into the PV user 
interface as dockable controls.  These panels can be utilized to 
integrate web pages of the Guidance Controller into the PV 
environment. 
 
Either the complete path for each web must be specified, e.g. 
"http://192.168.0.1/ROMDISK/web/Opr/master/masterfs.html" or just 
the path with the Client Guidance Controller without the Client's IP 
address, e.g. 'ROMDISK/web/Opr/master/masterfs.html'.   In the 
latter case, the IP address of the Client Guidance Controller will be 
automatically assumed when displaying the panel. 
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Vision Toolkit Description 

Vision Toolkit Introduction 
r provides detailed information on each of the tools in the PreciseVision vision 

  These tools perform all of the runtime operations that are needed to acquire and 
process an image captured from a camera. 

Each instance of a tool is a vision object with a graphical front-end, a property list for 
configuring the tool for your desired operation, and a read-only list of results properties 

ed b r vision objec ate more complex mac nd 
logical operations.  The graphical front-ends allow the vision tools to be easily positioned 

captured image and greatly simplifies their training. 

olKit Summar

ing table briefly summarizes the primary function of each of the vision tools.  
"Type" broad ries each to o whether i  an 

s es, "Inspects" a region, "Comp
s" image or ata or serves as a "Motion Se

tions on the followin

This chapte
toolkit.

that can be us y othe ts to cre hine vision a

over a 

To y

The follow
The ly catego ol as t t "Acquires" an image, "Finds"
object, "Measure
"Filter

" featur
 object d

utes" additional information, 
nsor".  Please see the detailed 
ich these tools can be utilized. descrip g pages for more ways in wh

Vision Tool Type Description

Acquisition Tool Acquires 
Captures an image from a camera or loads it 
from a disk file
frame buffer.  

, and stores the image into a 

Arc Fitter Tool Measures 
Searches a spe
returns the arc
both the arc ce

cified region for arc edges and 
 that best fits the edges.  Returns 
nter point and radius.  

Area-Of-Interest (AOI) 
Tool Copies 

 recta
her reg , or 

another image 
manipulation w

Copies a
file, anot

ngular area-to-interest to a disk 
ion of the current image buffer

buffer.  Permits mathematical 
hen copying to an image buffer.  

Barcode Reader Tool Inspects 
Reads a variet
barcodes and r
value of the ba

y of standard 1-D and 2-D 
eturns the barcode type and the 
rcode. 

Clear Grip Tool Inspects 

Verifies that the
bounds of a de
confirm that gri
collision. 

re is no obstruction within the 
fined window.  Typically used to 
pping a part will not result in a 

Connectivity Tool Finds 

s a reg
the centroid an
addition, this to
perimeter of an

Searche ion for binary blobs and returns 
d other features of each blob. In 
ol can return data that defines the 
y located blob. 

Edge Locator Tool Measures Detects edge p ub-pixel accuracy oints with s
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along a linear p
their positions.

of the inte a 
histogram of th

ath in a vision image and returns 
 Alternately, this tool can return an 
nsities along the linear path or 

eir values. 
array 

Find Centerline Tool Measures 
Searches a spe on for edge points and 
returns the cen

g lines

cified regi
terline between two located 
. boundin

Find Point Tool Measures 

Locates the ed
that defines the
The XY positio
pixel accuracy 
perpendicular t

ge point that is closest to the line 
 start of the tool's search region.  

n of the point is returned with sub-
along (and pixel accuracy 
o) the search direction. 

Finder Tool Finds 

Most powerful s randomly 
placed parts in ra image and returns their 
position, orient
pixel accuracy.

vision tool that identifie
 a came
ation and scaling to within sub-
  

Fixed Frame Tool Computes 

Places a refere
coordinate or a
another vision  index the 
frame in an X and/or Y grid pattern to repeatedly 
execute any lin

nce frame at a fixed image 
t a constant offset relative to 
object.  Can optionally

ked tools.  

Image Process Tool Enhances 
image  

Performs imag
thresholding an

d area  image. 

e filtering, edge extraction, 
d morphological operations on a 

in the cameraspecifie

Inspect Frame Tool Computes 

 through
Results of a re
rotates and shi
inspection.  Th
arithmetic com
other tools.  So
for performing 
on the results o

Passes  the XPos, YPos and Angle 
ferenced tool and optionally 
fts the Results based upon an 
e inspection can consist of the 
bination of the Results of two 
, this tool also provides a means 
simple mathematical operations 
f two tools. 

Inspect List Tool Computes 

Passes through
Results of a re
different Resul
if the object is g
convenient way
located object 
location with a 

 the XPos, YPos and Angle 
ferenced tool and tests up to 12 
ts from multiple tools to determine 
ood or bad.  This tool provides a 
 to perform complex testing of a 

and generating an equivalent 
single Pass/Fail indicator. 

Inspect Region Tool Computes 

Inspects the pe
opaque object to determine if there are any flaws 
in the object's o
This tool was d  
slight changes 

 permitted, but chips in the 
rior holes or cracks are 

.  

rimeter and the interior of an 

utline or holes in the interior.  
esigned to inspect wafers, where
in the overall size and shape of 

te
the wafer are
perimeter or in
unacceptable

Light Recorder Tool Detect
pattern  

q
o

s of e
s light 

Acquires a se
specified peri
brightnes
brightness reading

uence of camera images for a 
d of time, determines the 
ach image, and returns the 

s. 

Line Fitter Tool Measures Searches a spe
returns the line

cified region for edge points and 
 that best fits the edges. 

Line-Line Frame Tool Computes Determines the intersection of two lines defined 
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by vision objec s a reference frame.  
Alternately, computes and returns the midpoint of 
two reference f
objects.  

ts and return

rames defined by two vision 

Pixel Window Tool Inspects 

Counts edges 
scale statistics
circular region.
presence of fea
intensity inform

or binary pixels or collects gray-
 within a rotated rectangular or 
 Used for quickly detecting the 
tures or collecting general 
ation about a region.  

Pixel Color Window 
Tool Inspects 

Tests if the gen
circular region  
specified tolera ce.  Also computes the mean 
HSV/HSI value

eral RGB color of a rectangular or 
matches a trained color within a
n
s for the region. 

Point-Line Frame Tool Computes Takes a point a
and returns a r

nd a line from two vision objects 
eference frame. 

Point-Point Line Tool Computes Computes a lin
objects. 

e given two points from vision 

Sensor Window Tool Detects 
motion  

Detects motion e 
scene is stable
until motion is d
physical senso
parts can take 

 in a window region. Ensures th
 prior to other operations or waits 
etected. Can be used in place of 

rs in flexible parts feeding where 
time to settle.  

Text Label Tool Labels 

Displays string
results data fro
shown relative to the position of the referenced 
tool. 

 constants plus inspection and 
m a referenced tool.  Text is 

Tool Filter Tool Filters 

Takes the outp
generates mult
subset of the re
criteria.  

ut from another tool that 
iple sets of results, and returns a 
sults based upon specified 

 
Standard Tool Properties

To simplify their application, as much as practical, the v mon 
group of property names and associated operations.  Th
standard tool properties that are common to many of th

In these tables and the detailed tool descriptions, prope
their name and data type dimmed.  In addition, propertie
property or method within the Guidance Programming L
member name underlined and in italics bounded by squ
and the class name, e.g. "[GPL: Vision.ResultCount]

ision tools make use of a com
e following tables describe the 

e tools. 

rties that are "read-only" have 
s that have a counterpart 
anguage include the GPL 
are brackets preceded by "GPL:" 

".  

The Identity Properties specify the name of the tool and its basic tool type. 

1. Standard Identity Properties

Property 
Name

Data 
Type Range  Description

Name String n/a 
This is th
assigned
general 

e unique name that must be 
 to each instance (copy) of a 

tool type.  The name must follow 

68 



Vision Toolkit Description 

the GPL aming conventions.  
That is, 
(upper a
when re
names a
(i.e. Abc c refer to the same tool).  
Names m r an 
undersc
to 127 a
undersc

 variable n
a name can be mixed case 
nd lower case characters) but 
ferenced by other tools, the 
re not considered case sensitive 
 and aB

ust start with either a letter o
ore "_" and can be followed by up 
dditional letters, numbers and 
ores.  In GPL, this is the name by 

which a tool is referenced.

Type String n/a This rea y property displays the basic 
type for 

d-onl
the tool, e.g. VsLineFitter. 

The Placement / Size Properties define the position, o
the coordinate system of th

elative po  an
graphically position and size h
Camera Display Window.  In the range specifications, "
of Interest" and refers to the size of the portion of the ca
analyzed.  

rientation and size of the tool in 
 tool is defined relative to another 
ecified.  Normally, it is easiest to 
e tool's handles displayed in the 

AOI" is an abbreviation for "Area 
mera image that is being 

e camera.  In addition, if the
d orientation can also be sp
 each tool by dragging on t

tool, the r sition

2. Standard Placement/Size Properties

Property 
Name

Data 
Type Range  Description

Angle Single -360 to 360 
XPos Single 0 - AOI (mm) 

YPos Single 0 - AOI (mm) 

These v
degrees
units, m
in the co
These v
when th ned 

nd re-o
sion to
ion to

alues specify the orientation (in 
) and the position (in calibrated 
m) of the center of the vision tool 
ordinates of the vision image.  
alues are automatically updated 
e tool is graphically re-positio

a riented during training and if the 
ol is placed relative to another 
ol during runtime. 

vi
vis

Height 0 -Single  AOI (mm) 

Width Single 0 - AOI (mm) 

ese v dth 
 the vi

These v
when th
or can b
precise 

Th alues define the height and wi
sion tool in calibrated units (mm).  
alues are automatically updated 
e tool is adjusted with the mouse 
e manually entered for more 
adjustments. 

of

RelAngle Single -360 to 360 
RelXPos Single 0 - AOI (mm) 

RelYPos Single 0 - AOI (mm) 

These v
degrees

its, m
lative 

Relative
not relat
values a

alues specify the orientation (in 
) and the position (in calibrated 
m) of the center of the vision tool 
to the vision object specified by 
ToolName

un
re

.  If the vision tool is 
ive to another vision object, these 
re zero. 

The Operation Properties define parameters that cont ol.  For 
example, a tool might have an Operation Property that d

 ed  gray sc e 
commonly used Operation Properties are placed in this

rol the execution of the to
efines if it should screen out 

ch pixels are processed.  Only th
 group.  

black-to-white ges or the ale levels above whi
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3. Standard Operation Properties

Property 
Name

Data 
Type Range  Description

Camera Integer 1 - 6 
Defines 
its assoc
tool ope

the number of the camera (and 
iated frame buffer) on which the 

rates. 

Relative-
ToolName List n/a 

If a tool 
another 
referenc
any visio
coordina
not relat
property  

is to be positioned relative to 
tool, this is the name of the 
ed tool.  Tools can be relative to 
n tool that returns a vision 
te position.  By default tools are 
ive to another tool and this 
 is blank.

The A
modifie

dvanced O n Properties in Operatio
d and gen quire a bit more experience to

default settings will yield good tool performance for typic

peratio
erally re

 conta n Properties that are not normally 
 utilize.  For these properties, their 
al applications.  

3A. Standard Advanced Operation Properties

Property 
Name

Data 
Type Range  Description

The Inspection Settings Properties permits a single s
automatically tested (inspected) to verify that it is within
set accordingly and a Pass / Fail label can be optionally
Camera Display Window.  

calar result of the vision tool to be 
 limits.  A Pass / Fail property is 
 displayed on the tool in the 

4. Standard Inspection Settings Properties

Property 
Name

Data 
Type Range  Description

InspectType
Spec
to be 
vary f
"None

List   

ifies the single scalar result that is 
inspected.  The items in the list 
rom one tool to the next.  Select 
" to disable inspecting a result. 

InspectLabel List

NONE / 
PASS_AND_FAIL / 

PASS / FAIL / 
VALUE_REAL / 

VALUE_INTEGER  

Indica
nume
tool in
based
inspe
indica
displayed, only a Pass label, only a 
Fail la
a rea
Pass 
and th
selec
only a
the in

tes if a Pass / Fail label or a 
ric value is to be displayed on the 
 the Camera Display Window 
 upon the results of the 

ction.  The items in the list 
te if no label should be 

bel, either a Pass or Fail label, or 
l or integer numeric value. The 
indicator is displayed in green 
e Fail is written in red.  This 

tion is used for display purposes 
nd has no effect on the results of 
spection. 

InspectMax Single   Maximum and minimum values 
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InspectMin
perm specified in 
Inspe
Value
marke

Single   

itted for the item 
ctType to "Pass" the inspection.  
s outside of this range are 
d as "Failed". 

InspectActual Single  

This i
indica
speci
tested the inspection. [GPL: 

s a read-only property that 
tes the value of the result 

fied by InspectType that was 
 during 

VisResult.InspectActual]

InspectPassed Pass / Fail

Indica s 
satisf
to 'Pa
the in
refere
the R
also h
althou ted. 
[GPL

List

tes if the inspection criteria wa
ied (Pass) or was not (Fail).  Set 
ss' if no inspection is selected.  If 
spection fails, any tool that 
nces this tool, for example via 
elativeToolName property, will 
ave a failed InspectPassed 
gh that tool will still be evalua

: VisResult.InspectPassed]

The 
too

Results Set perties control the results th ision 
l.  For exampl ple sets of results can be computed by the tool, these 

n limit the number of sets of ata compute
layed sults Propert .  

tings Pro
e, if multi

at are computed by the v

d and can select the set of data properties ca  d
that is disp in the Re ies

5. Standard Resul ngs Propertiests Setti

Property Name Data 
Type Range  Description

MaxResults Integer -1 or 1 to n 

For to
results, this p
maxim
that a
negat
possib

ols that provide multiple sets of 
roperty can limit the 

um number of sets of results 
re computed and returned.  A 
ive 1 (-1) indicates that all 
le results should be collected. 

OffsetAngle Single degrees 
OffsetX Single mm 

OffsetY Single mm 

These Offset values permit the results 
of a vision tool to be shifted and rotated 
from their standard location.  This 

ts of 
t 

orientation change is in degrees and 
the shift is in calibrated units (mm).  

allows you to re-position the resul
a tool to a position and orientation tha
is more meaningful to you.  The 

See the Fixed Frame Tool for an 
alternate method for implementing this 
offset. 
If TRUE, indicates that the "Return 

d 
s 
 
n 

ResultOnNotFound Boolean TRUE / 
FALSE

results if not found" Preferences 
property is asserted.  Normally, this 
property is FALSE and only tools that 
are successful will generate results an
continue processing an object.  This i
the correct behavior if you only wish to
process objects that pass all inspectio
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tests.  However, if a tool is referenced 
in an Inspect List, it is important that 
both successful and failed results be 
returned so that all of the inspections in 
the list are aligned and are with respect 

if an 
is 

 

to the same located object.  So, 
Inspect List is being utilized, th
Preference property should be set to
TRUE.  

ResultSelect Integer 1 - n 
of results, this property selects the set 
of results that is displayed in the 

For tools that return more than one set 

Results Properties.   This does not 
affect the actual results of the tool. 

ShowResults List
NONE / 
POINT / 
LINE / 

FRAME  

Alters how the results of a tool is 
graphically displayed.  Each vision tool 
has a default method for display, e
line or a frame.   This property allow
the graphical display to be changed. 
For example, a Fixed Frame Tool is 
normally displayed as a reference 
frame.  However, if it is being used a

.g. a 
s 
 

s 
a datum line or a point, its display can 
be changed to a line or a point for 
visual clarity.  This property does not 
affect the actual results of the tool. 

The Results Properties display a single set of results for the vision tool.  In general, the 

 
results returned varies from tool to tool.  Many tools return a vision reference frame.  
However, some tools return additional results items such as statistical information on how
well the answer fits the actual data. If the tool computes more than one set of results and 
MaxResults is set to greater than 1, the displayed set of results will correspond to the 
setting of the ResultSelect property.  

6. Results Properties

Property Name Data 
Type Range  Description

ResultCount Integer 0 - n has returned. [GPL: Vision.ResultCount]
Number of sets of results the vision tool 

ResultE

dard error code that indicates if the 
 executed without an error.  This is 

different from the InspectPassed, 
which indicates if the result was 
computed properly but its value was 

mit.  If 
on-zero, any tool 

ple via 
, will 

 error code and 
will not be evaluated. [GPL: 

Stan
tool

rrorCode Integer   inside or outside of a specified li
ResultErrorCode is n
that references this tool, for exam
the RelativeToolName property
also fail with this same

VisResult.ErrorCode]
ResultAngle Single -360 to 360 Orientation (in degrees) and position (in 
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ResultXPos Single mm

ResultYPos Single mm

calibrated units, mm) of the center of 
the results computed by the vision tool 
in the coordinates of the vision image 
taking into consideration the value of 
the Offset's in the Results Settings 
Properties.  For robot guidance 
applications, these values are 
transformed by the vision-to-robot 
calibration conversion routines and then 
presented as [GPL: VisResult.Loc.X, 
VisResult.Loc.Y and 
VisResult.Loc.Roll]. 
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Acquisition Tool 
Vision tool that captures an image from a camera or loads it from a disk file, and 
stores the image into a frame buffer.   

Prerequisites 

None 

Properties 

Property Name Data 
Type Range  Description

1. Identity
Name String n/a 
Typ

Standard Identity properties
e String n/a

3. Operation
Camera Integer 1 - 6 Standard Operation property
GainBlue Single
GainGreen Single

Gain
camera)  

These properties scale the intensity 
of the three color 
e read from the 

0-12 (set to -1 if not a color values for each 
layers as they ar
camera.  This permits the color 
intensities to be balanced. 

Red Single

3A. Advanced Operation

AcquireBuffer-
Image Boolean True / False  

If True, a copy of the image is stored 
into a secondary buffer when the 
image is acquired. This must be set 
True if the original image is to be 
restored by a subsequent Acquisition 
tool that has its AcquireMode set to 
"RESTORE_ORIGINAL". For 
resolutions greater than 640x480, 
setting this value to False, if not 
needed, can save a few milliseconds 
of execution time. Set False by 
default.  

Acquire-Extension List BMP / PNG  

If this tool is set to automatically save 
a camera image to a disk file, this 
property specifies whether the image 
should be saved as a non-
compressed bitmap (BMP) or as a 
compressed image in a lossless 
format (PNG).  The PNG file format is 
smaller, but requires more CPU time 
to create.  
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AcquireFill-
GrayLevel Integer 0 - 255  

If the AcquireMode is defined as 
"CLEAR_BUFFER", all of the pixels in 
the image buffer are set to the 
intensity value specified by this 
property. 

AcquireMax-
CurrentCount Integer 0 - 99999  

Acq
SaveImages Inte -1 - 99999  

When the AcquireMode is set to 
ACQUIRE_AND_SAVE or 
SAVE_ONLY, the 
AcquireMaxSaveImages property 

argest index that is 
appended to the AcquirePrefix to 
generate the name of the file in which 
the image is stored.   
 
If AcquireMaxSaveImages is -1, the 
next highest unused index values is 
assigned up to the maximum value of 
99999.  So, existing image files will 
not be over-written.  
 
If AcquireMaxSaveImages is set >0, 
AcquireMaxCurrentCount will 
indicate the next index. When the limit 
specified by 
AcquireMaxSaveImages is reached, 
AcquireMaxCurrentCount is 
automatically reset to 0. This permits 
the last A
files to be saved without consuming 
more and more disk space (but 
existing image files will be over-
written).  In this mode of operation, 
AcquireM
manually
altered by
reset the 
value.  Th
AcquireMaxCurrentCount is not 
stored with the vision project and is 
reset to 0
is loaded

defines the l

uireMax- ger

cquireMaxSaveImages 

axCurrentCount can be 
 changed or automatically 
 a robot control program to 
next index to a specific 
e value of 

 each time the vision project 
. 

AcquireMode List

NORMAL_ACQUIRE / 
RE_AND_SAVE / 

CLEAR_BUFFER / 
PLAY_FROM_DISK /  

LIVE_VIDEO / 
SAVE_ONLY / 

RESTORE_OR   

"NORMA
single im
camera a  a frame 
buffer. 
 
"ACQUIR forms 
the same o s 
"NORMA
saves the
 
"CLEAR_
pixels in a alue 
specified
This is useful before an AOI copy is 

ACQUI

IGINAL

L_ACQUIRE" - acquires a 
age from the specified 
nd places it into

E_AND_SAVE" - per
peration a

L_ACQUIRE" and then 
 image to a disk file. 

BUFFER" - Sets all of the 
 buffer to the intensity v

 by AcquireFillGrayLevel.  
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performe
 
"PLAY_F
image fro  
specified
AcquireP
are multip
with the s
Vision Pr
contents 
be copied
 
"LIVE_VI ates 
the vision
image fro
system s
setting th
VideoGa
 
"SAVE_O
of the cur  
file.  This ram to 
execute a
selected 

s.  

STOR
the conte
buffer to its original value at the time 
that the im
Requires
set to Tru
captured.

d. 

ROM_DISK" - restores an 
m a disk file.  The disk file is
 by the AcquirePath and 
refix (see below).  If there 
le numbered image files 
ame prefix, each time the 
ocess is executed, the 
of the next sequential file will 
 to the image buffer. 

DEO" - continuously upd
 display with the latest 
m the camera. This is a 
etup mode that facilitates 
e camera f-stop, focus, 
in, and VideoOffset. 

NLY" - stores the contents 
rent frame buffer to a disk
 enables a GPL prog
 vision process that saves 

frame buffers for later 

E_ORIGINAL" - restores 
nts of the current frame 

acces
 
"RE

age was first captured. 
 that AcquireBufferImage is 
e when the image is first 
  

AcquirePath String n/a 

String tha  
file when 
"ACQUIR
"PLAY_F nk (""), 
the path d
will be us
contain a  
will be ap
the Preci
stored, e.
Automati

t defines the path to the disk
AcquireMode is set to 
E_AND_SAVE" or 
ROM_DISK'".  If bla
efined in the Preferences 

ed.  If the path does not 
 ':' (i.e. C:\...), AcquirePath
pended to the path where 
seVision application is 
g. "C:\Program Files\Precise 
on\PreciseVision #.#\" 

AcquirePrefix String

String tha
in
on
QU
_F
na

Preferenc
is combin
numerica file 
extension to generate the disk file 
name for saving or loading vision 

n/a 

(exclud
extensi
to "'AC
"PLAY
the file 

t defines the disk file name 
g the required .BMP 
) when AcquireMode is set 
IRE_AND_SAVE" or 

ROM_DISK".   If blank (""), 
me defined in the 
es will be used.  This string 
ed with AcquirePath, a 
l index, and the ".BMP" 
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images. 

ActiveLayer List Monochrome / RedLayer / 
GreenLayer / BlueLayer  

Specifies
loaded in r 
processin
tools. 

ays
chr

available
buffer ha
defines it
 
For color r 
can be lo  one of four types 
of data:  m
blue.  The
produces 
grayscale  and 
blue mod ta for 
a single c
"RedLaye
frame bu
indicate t  
only the r . 
Tools tha
will only be operating on the red color 
layer of th
exception " 
Tool.  Wh
automatic
RGB colo
unaffecte
ActiveLa

 the type of data to be 
to the image frame buffer fo
g by subsequent vision 

cale cameras, only 
ome" image buffers are 

 and each pixel in the frame 
s a value from 0 to 255 that 
s grayscale intensity. 

cameras, the frame buffe
aded with

 
For gr
"Mono

onochrome, red, green or 
 monochrome mode 
the same results as a 
 camera. The red, green
es load the intensity da
olor.  For example, if 
r" is selected, the image 

ffer will contain values that 
he intensity (response) of
ed receptors of the camera
t are applied to this image 

e camera.  The one 
 is the "Pixel Color Window
en this tool is executed, it 
ally accesses all three of the 
r layers of an image and is 
d by the setting of the 
yer property. 

AoiAcquire Boolean True / False 
AoiHeight Single 0 - FOV (mm) 
AoiWidth Single 0 - FOV (mm) 
AoiXpos Single 0 - FOV (mm) 

AoiYpos Sin 0 - FOV (

For came  uEye 
USB mod
only a po iew, 
these par
rectangul tion of the image to be 
acquired.  
acquired,
will be re
tools can
positione
switch be
is typicall . 
 
To acquir
True and
position o
dimensio  
in calibra
tools instead 

gle mm) 

ras (such as most IDS
els) that support acquiring 
rtion of the full field of v
ameters define the 
ar sec
   If a reduced size AOI is
 the camera acquisition time 
duced.  Different Acquire 
 have different sized and 
d AOI's.  However, when you 
tween different AOI's, there 
y a significant time delay

e an AOI, set AoiAcquire 
 define the height, width and 
f the AOI.  The AOI 
ns and position are specified
ted units (mm) like most 

of pixels.  

FlatFieldEnabled Boo True / F If True, e
automaticlean alse ach captured image is 

ally compensated for 
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uneven b ng 
a sample
saved.  T
automatic  
such that w 
image, a 
backgrou
make it e uish objects 
when there are background lighting 

s, especially if binary vision 
ols are utilized. See below for a 

tion of the Special Feature 
 for capturing the sample 

e.  

ackground lighting by addi
 image that was previously 
he saved image is 
ally inverted and normalized

 when it is added to a ne
very light uniform (flat) 
nd is produced.  This can 
asier to disting

variation
to
descrip
Buttons
imag

ImageFile String

nly string that displ
  file.  

is valu hen the 
AcquireMode is set to 
"PLAY_FROM_DISK". 

n/a 

Read-o
currently
Th

ays the 
selected vision image
e is only displayed w

LoadFirstImage Boo True / F

This is a convenience feature for 
setting the display of a sequence of 
images back to the first image and is 
only valid during the 
"PLAY_FROM_DISK" mode.  That is, 
when this property is set to TRUE, the 
disk file that satisfies AcquirePath 
and Acqu
lowest ind o 
the image

lean alse 

irePrefix and has the 
ex values will be loaded int
 buffer. 

3B. Trigger

TriggerActive List Low_to_High / 
High_to_Low

If TriggerEnable is True, this property 
defines if the picture is to be when the 
digital input signal transitions from low 
to high or high to low.  

   

TriggerEnable Boo True / Fals

If this pro
capture is delayed until a digital input 
signal of the correct state is received 
by the ca

lean e  

perty is True, the image 

mera.  

TriggerTimeout Integer 1 - 30  

If Trigger e, this property 
specifies s that the 
system will wait for the trigger to occur 
before an
Vision Pr

Enable is Tru
the time in second

 error is generated (-4019 
ocess Failed). 

4A. Dalsa Genie Camera

ExposureTime Sin   

Time, in m
will integrate light on its imaging 
sensor. T , the more 
light is co
image.  H
lengthen 
image acquisition.  This parameter 
may not be supported on all hardware 

gle

illiseconds, that the camera 

he longer the time
llected and the brighter the 
owever, this will also 
the time required for the 
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configurations. 
VideoGain Integer 0.5 - 2.0 

Vide

t 

row range 
panded 

value 
oOffset Integer -127 - 127 

camera.  This allows a nar
of brightness values to be ex
to span the entire 256 grayscale 
range. 

The VideoGain and VideoOffse
scale and shift the grayscale value of 
each pixel as it is read in from the 

4B. DirectShow
DsB
Com

ackLight 
pensation Integer    

DsBrightness Integer   
DsColorEnable Integer    
DsContrast Integer   
DsExposure Integer   
DsGain Integer   
DsGamma Integer   
DsHue Integer   
DsPixelClock Integer   
DsSaturation Integer    
DsSharpness Integer   

DsW

 
f 
from 

xt.  When 

, its supported 
properties, the range of allowed 

 

 
 

 to the 
ock 

properties since these affect the time 
it takes to acquire an image.  

c 

These properties change the 
operation of a DirectShow (USB) 
camera.  The properties that a
camera supports and the range o
values for each property will vary 
one camera model to the ne
a camera is attached by 
PreciseVision

values and the default values are
automatically sampled. 
 
The range for each supported 
property is displayed by the "Adjust
Video Properties" Special Features
Pop-up. 
 
Special attention should be paid
DSExposure and DSPixelCl

hiteBalance Integer     
Please see the documentation 
provided with the camera for specifi
information on the setup of its 
supported properties.  

Remark

This tool performs the basic image capture operation from a color or monochrome 

 can be 
controlled to optimize the brightness range for the field of view.  To facilitate setting up a 

mage can also be continuously 
acquired and displayed in the Camera Display Window. 

Normally, when this tool is executed, a camera image is immediately captured. However, 
if Trigge ture is 
not imm  
directly f the 
image c ignificantly 
reduce latency and jitter. As a debugging convenience, if a Vision Process is manually 

s 

camera and stores the image in a frame buffer.  Consequently, this tool is normally the 
first tool in each Vision Process.  

Multiple cameras can be accessed by this tool and their gains and offsets

camera's gain, offset, focus, and f-stop, the camera i

rEnable is True, executing this tool primes an image capture, but the pic
ediately taken. The image capture is delayed until a digital signal, which is
connected to the camera, is asserted. For applications where the timing o
apture relative to an external event is critical, trigger mode can s
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executed using the PreciseVision GUI and the process contains an Acquisition that has 
triggering enabled, a pop-up is display to confirm if the camera should wait for an external 
trigger o d if the 
Vision P

Camera ease consult your camera's 
hardware documentation for specific information on whether it supports external 

gering and how this is implemented. For example, with Dalsa cameras, hardware 
signal #1 is a sinking input that must be pulled low to the camera's ground to trigger a 

l, 

tool is executed (e.g. a low pass filter), the data stored in the frame buffer is altered so 
that all subsequent tools operate on the modified image data. In these cases, it is 

es convenient to restore the original contents of the frame buffer. This can be 
ne by executing an Acquisition Tool with the AcquireMode set to 

"RESTORE_ORIGINAL". This operation restores the original image data from an in-
h faster than storing an image to a file and then 

reloading. In order for this mode to operate properly, the original Acquisition tool must 
have its AcquireBufferImage property set to True. When this property is true, a copy of 
the camera image is generated in memory when the acquisition is performed.  

If the background lighting is not uniform, FlatFieldEnabled can be set to automatically 
add a previously saved inverted normalized image of the background lighting.  This will 
produce a "flat" background that will help to highlight the features of parts within the field 
of view.  Enabling this function adds about 1 msec of processing time to a 752x480 
grayscale image. (See the Special Feature Buttons below.)  

As both a demonstration feature and as an aid in remotely diagnosing problems, this tool 
can be used to easily store captured images to a disk file and to reload images stored to 
the disk.  To store images, the AcquireMode must be set to "ACQUIRE_AND_SAVE" or 
"SAVE_ONLY".  To load files, the mode must be set to "PLAY_FROM_DISK".  For any of 
these modes, the disk file name is constructed by combining the AcquirePath with the 
AcquirePrefix and an optional numerical index followed by the .BMP file extension.  
Each time that an Acquisition Tool is executed with "ACQUIRE_AND_SAVE" or 
"SAVE_ONLY" set, the system automatically increments the numerical index to create a 
new disk file.  Likewise, each time that the Acquisition is executed with 
"PLAY_FROM_DISK", the system automatically searches the file folder for the file with 
the next larger numerical index.  This automatic indexing allows a series of images to be 
conveniently generated or replayed. 

Special Feature Buttons (located above the property editor) 

Adjust Video Properties 

Pressing this button displays a pop-up window that permits the property 
values for the monochrome image (VideoGain, VideoOffset, 
ExposureTime) and the color image (GainRed, GainGreen, GainBlue) 
to be manually adjusted while dynamically viewing the effect of the new 
settings.  In addition, histograms of the various values can be 
simultaneously displayed.  

r if the picture should be taken immediately.  This pop-up is not displaye
rocess is remotely initiated from a Guidance Controller.  

 triggering is not supported on all cameras. Pl

trig

frame capture.  

Most vision tools analyze the data that is stored in a frame buffer by an Acquisition too
generate results, and leave the frame buffer unmodified. However, if an "Image Process" 

sometim
do

memory buffer, and is therefore muc
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Select Acquire Pa

g this ys a ow that permits you to 
browse the PC's file structur Acquire
where ima  files are t  retrieve

d / Show Flat Field  

If the FlatFieldEnabled pro ll captur
automatically compensated d

e invert  was p xample, in the 
llowing picture, there is a distinct blooming of the light intensity in the 

center of the image. 

th  

Pressin button displa pop-up wind
e to select the Path that specifies 

d. 

ed images are 
 lighting by adding a 

ge disk o be stored and

Train Flat Fiel

perty is True, a
 for uneven backgroun

revious saved.  For esampl
fo

ed image that
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While viewing this background, if you press the Tra
copy of the image is inverted, normalized and save
in a disk file.  

If FlatFieldEnabled is False and an object is viewed with this lighting, it 
will appear as shown below.  While the object is relatively distinct, there 
are variations in the background light intensity that can confuse some 
vision tools, especially binary tools such as blob finders.  

in Flat Field button, a 
d both in memory and 

 

nd FlatFieldEnabled 
own below.  As can 
e image could even 
ulty.  

However, if a sample backg saved a
is True, the same captured i ear as sh
be seen, the object is m d th
be processed using bi ic

round image is 
mage will app

uch more distinctive an
nary tools without great diff

 

Examples 

lder that contains 

Acquisition Tool is executed, it will load the next successive 

See Als

If the AcquireMode is set to "PLAY_FROM_DISK", and the AcquirePath is set to 
"ExampleProjects", and the AcquirePrefix is set to "part2", and the fo
the PreciseVision application contains a folder "ExampleProjects" that has the following 
files: 

part2_0001.bmp, part2_0002.bmp, part2_0003.bmp 

Then, each time that the 
file in the list above and will restart when it encounters the end of the list. 

o 
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Vision Toolkit | Sensor Window Tool | AOI Tool 
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Arc Fitter Tool 

Vision tool that searches a specified region for arc edge points and 
returns the circle or arc that best fits the edges. 

Prerequisites 

None 

Properties 

Property Name Data 
Type Range  Description

1. Identity
Name String n/a 
Type String n/a

sStandard Identity propertie

2. Placement/Size
Angle S 60 ingle -360 to 3
XPos S (mmingle 0 - AOI ) 
YPos S (mmingle 0 - AOI ) 
RelAngle S  36ingle -360 to 0 
RelXPos S (mmingle 0 - AOI ) 
RelYPos S  AOI (mm

 

ingle 0 - ) 

Standard Placement / Size
properties.  The X and Y 
values define the center of 
the tool and the center of 
the search region. 

Radius S  

fies the nominal radius 
of the arc or circle to be 
located.  This defines the 
mid-range value for the 

ingle mm

Speci

radius search. 
3. Operation
Camera Integer 1 - 6 
Relative-ToolName List n/a 

Standard Operation 
properties

AngularSize Integer 0-360 

 

e of 360 

circle is to be located.  
Values less than 360 specify 

Specifies the angular size in
degrees of the arc to be 
located.   A valu
indicates that a complete 
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that a partial circle (arc) is to 
be located. 

DarkOutside Boolean True / Fals

nded by 
xels, this parameter 

t be set to True. 

e 

Defines whether the pixels 
outside of the arc or circle 
are darker than the interior 
pixels.  For example, to 
locate a circle with light 
interior pixels surrou
darker pi
mus

EdgeThreshold Integer 0 - 254 

cifies the threshold 
 which weak (low 

trast) gradient edges are 
ignored.  The lower this 

e Edge 

Spe
below
con

property is set, the more 
sensitive the system is in 
locating edges.  Please see 
the description of th
Locator for more information
on edge gradients.  The 
default value is 30. 

 

FindWhat List
FITARC_FIND_CENTER / 
FITARC_FIND_R

FITARC_FIND_

d 
be fixed and only the center 
of the arc varied to find the 

ADIUS / 
BOTH 

Defines if the radius shoul

best match or if the center is 
to be fixed and the radius 
varied or if both should be 
varied. 

SearchRadiusRange

This property defines the 
limits of the center point and 

e 

SearchRadiusRange et 

Single mm 

radius search regions.  The 
search region is centered 
about the XPos, YPos and 
Radius values.  So, if th
Radius property is set to a 
value of N and the 

 is s
to M, the radius can vary 
from N-M/2 to N+M/2 and 
the center point can vary by 
M in X and Y. 

UseWhichEdge List
FITARC_MIDDLE_
FITARC_INNER_
FITARC_OUTER_EDGES / 
FI DIENTS 

that is closest to the nominal 
radius, the arc closest to the 
minimum or maximum 
search radius or the arc that 

t 
(maximum gradients). 

EDGES / 
EDGES / 

If multiple arcs exist within 
the search region, this 
parameter specifies which 
arc should be returned.  The 
selected arc can be the one 

TARC_MAX_GRA

has the greatest contras

3A. Advanced Operation
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DrawEdgePoints List
..._NO_EDGE_P
..._ALL_EDGE_POINTS / 
..._USED_EDGE_POINTS 

ts to 

e 

ter the 
EdgeMode is applied and 
all outliers are eliminated.  
This is very helpful for 

 This value is 
NO_EDGE_POINTS by 

OINTS / 

If set, draws yellow do
indicate ALL edge points 
that are selected after th
EdgeMode is applied or 
only those edges that are 
USED to fit arcs af

understanding the effect of 
changing various property 
settings.

default.  

MaxEdgePoints Integer 3 - n 

ber of edge 
 

acy at the 
se of execution 

minimum value 
parameter is 3 and 
lue is automatically 
 to the number of 

 value 

Maximum num
point searches to perform.  
Higher numbers produce 
greater accur
expen
speed.  The 
of this 
this va
limited
pixels across the width of 
the tool.  The default
is 30. 

Max

Maximum number of 
iterations for filtering.  The 
filtering algorithm repeatedly 

ints, 

d to 

maximum number of 
iterations have occurred.  A 

alue 

Iterations Integer 0 - n 

removes outlier po
refitting the arc each time, 
until no more points nee
be removed or the 

value of zero disables 
filtering.  The default v
is 5. 

MinFilte is

m filter 
distance in pixels.  No edge 

ed arc 
than this are discarded 
during the iterative process.  

is 
 

rc 
l with 
n 

 is 

Absolute minimu

points closer to the fitt

rD tance Single 0 - n.nn 
A minimum distance 
needed because the
standard deviation of 
distances to the fitted a
can be less than a pixe
a good image of a clea
edge.  The default value
1.5. 

Sigm
Filter width in units of 

.  This 
 

aFilter Single 0 - n.nn standard deviations
value is multiplied by the
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standard deviation of the
edge points’ distances to
fitted arc to compute the 

 
 the 

distance threshold beyond 
which edge points are 
removed during the iterative 
fitting process.  The default 
value is 2.5. 

4. Inspection Settings

InspectType List
NONE / ..._RMS / 

..._RADIUS / 
..._NUM_EDGES_FOUND / 

...NUM_EDGES_USED 

InspectLabe
GER 

l List
NONE / PASS_AND_FAIL / 

PASS / FAIL / VALUE_REAL / 
VALUE_INTE

Insp   ectMax Single
InspectMin Single   
InspectActual Single  
InspectPass

n Standard Inspectio

ed List Pass / Fail

Settings properties

5. Results Settings
OffsetAngle Single degrees 
OffsetX Single mm 
OffsetY mm Single
ResultOnNo TRUE / FALSEtFound Boolean

ShowRe FR
P

Standard Results Settings 

sults List NONE / 
LINE / 

AME / 
OINT 

properties

6. Results
ResultErrorCode Integer   
ResultAngle Single -360 to 360
ResultX gPos Sin le mm
ResultYPos Single mm

s propertiesStandard Result

ResultNum-
EdgesFound Integer   

f edge points Number o
found. [GPL: 
VisResult.Info(1)]

ResultNum-
EdgesU Integ   

nts 
r the filtering 
: sed er

Number of edge poi
remaining afte
process. [GPL
VisResult.Info(2)]

ResultRadiusFound Single   
d arc in Radius of the locate

mm.  [GPL: 
VisResult.Info(4)]

ResultRMS Single   f the arc Root mean square o
fit. [GPL: VisResult.Info(0)]

Remarks 
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The Arc Fitter searches the region defined by its 
points and fits an arc to the edge points using a l ting 
the edge positions to a sub-pixel accuracy and b
computation, this tool is able to generate very ac

This tool is very useful for accurately locating hol
fiduc und, these fit arcs ca d
important features, for generating reference fram ject 
or features in an object or for measuring the diam

In order to make this tool m rim e e 
dark and light sides have roughly the same orien een) 
sides of the search area.  So, when positioning th r 
(nominal) arc of the search region at approximate at you 
expect to find the arc with the blue side on the an  aid 
in th s a ize on'
editor. This button will analyze the coarse positio rest 
arc/circle. The radius search range is automatica

The operation of this tool is basically performed i e 
extracted in the search region.  Secondly, an arc
operations, the tool spends most of its time extra e 
accuracy of the Arc Fitter can b d-  ad roperty 
dete y t ans to detect 
least 3 in order to detect the minimum number of ne 
edge search is performed for each pixel along the
increases roughly in proportion to the value of Ma ts.  On the other hand, the 
accuracy of the tools increases approximately as ts.  
Tha in c
quad a  do

Once the edges are found, the Arc Fitter will opti g process 
to incre stness of the results. ing
dista rc (outlie iscar his t of 
the arc and whose inclusion would incorrectly off ecifies 
the maximum number of fits to perform.  After ea edges that are beyond 
SigmaFilter standard deviations are rejected, unl
MinFilterDistance pixels of the fit arc.  The itera tions 
are o furth r e  

At the conclusion of this tool, the center position turned 
along with statistical data on the number of edge  root mean square 
of the arc fit, which indicates the quality of the fin tested 
via the "Inspect Settings" to yield a pass/fail indic

Special Feat ated  pr it

Adjust Edge Threshold

Pressing this button displays a pop-up window that permits the value of 
the Edge Threshold property to be manually adjusted while dynamically 

green and blue outlined arc for edge 
east squares technique.  By compu
y employing multiple such edges in its 
curate sub-pixel results. 

es or curved edges of objects or 
 to compute center points between 
es that can accurately locate an ob
eters of holes. 

ials.  Once fo n be use

ore disc inating, th  Arc Fitter only utilizes edges whos
tation as the dark (blue) and light (gr
is tool, you should place the cente
ly the position and orientation th
ticipated dark side of the object. To
 feature button above the property 
n of the tool and snap it to the nea
lly adjusted as well. 

is operation, there i n 'Auto S / Positi

n two steps.  First, all of the edges ar
 is fit to the edges.  Of the two 
cting the edges.  So, the speed and th
justing MaxEdgePoints.   This p
edges.  This parameter must be set to at 
 edges to define an arc.  At most, o
 width of the Fitter.  Execution time 
xEdgePoin

e trade
he tool sc

off by
rmines how densel

 the square root of MaxEdgePoin
tor of 4, the tool execution time will t is, if you increase M

ruple but the accur
axEdgePo
cy will only

ts by a fa
uble. 

onally perform an iterative fittin
 each pass, edge points that are too 
 filters out edges that are not a par

set the result.  MaxIterations sp
ch arc fit, 

ase the robu
nt from the a

  Dur
ded.  Trs) are d

ess the edge is within 
tive process stops if (1) MaxItera
d, or (3) only two edge points remain.

and radius of the best fit arc is re
s finally used and the

performed, (2) n er edges a e discard

al fit.  This statistical data can be 
ation for the operation. 

or) ure Buttons (loc above the operty ed

viewing the effect of the new setting in the Camera Display.  The display 
indicates the edges that satisfy the threshold criterion in white. 
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Auto Size / Position 

Provides an easy way to position the tool. This button will compute the 
currently found arc/circle and automa ally snap the tool to the exact 
coordinates of the found arc/circle. In addition the radius search range is 
adjusted proportionally to the arc/circle size. 

Examples 

In the following example, an Arc Fitter is utilized to accurately determine the position of a 
hole within an object. The best fit radius of the hole is computed and the resultant is 
compared to the acceptable range of values to generate a pass/fail inspection result. 

tic

 

See Also 

Vision Toolkit | Edge Locator | Line Fitter
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Area-Of-Interest (AOI) Tool 

rent image buffer.  When the 
nterest (AOI) is copied, various processing operations can be 

ally performed. 

Vision tool that copies a rectangular area of the current image into a file 
or another region of the image or a diffe
area-of-i
option

Prerequisites 

None 

Properties 

Property Name Data 
Type Range  Description

1. Identity
n/a Name String
n/aType String

Standard Identity properties

2. Placement/Size
Height m)0 - AOI (m  Single
Width Single 0 - AOI (mm) 
XPos Single 0 - AOI (mm) 

Standard Placement / Size 
properties.  The X and Y values 
define the center of the region

0 - AOI (mYPos Single m) 
0 - AOI (mRelXPos Single m) 

Single 0 - AOI (mm) RelYPos

 to 
be copied.  The Height and Width 
define the dimensions of the 
region.  The AOI is a rectangular 
region and cannot be rotated. 

3. Operation
1 - 6 Camera Integer

Relative-
ToolName List n/a 

Standard Operation properties

If the AOI is not to be copied to a 
file, another vision tool must be 
specified to define the destination
frame buffer for the copy operatio
and the cente

 
n 

r X, Y position of the 
AOI in the destination.  Only the 

and 

destination tool is not executed 
and the Height, Width and Angle 
are ignored.  The destination tool 

Destination-
ToolName List  n/a  

destination tool's XPos, YPos, 
Camera are utilized.  The 
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only serves to provide information 
required for the copy operation. 

BMP / Extension List PNG 
FilePath String n/a 

String

If the AOI is to be copied to a file, 
these properties specify the folder 
path to the file, the name of the 

d file, and the file extension an
type. 

n/a Prefix

NONE / 
_DISK / 
UFF

H_ADD / 
H_AND / 

MATH_MIN / 
MATH_XOR /
MATH_OR / 

MATH_SUBTRAC
MATH_SUBTRACT_CLIP 

Specifies whether the AOI is to be 
copied to a disk file or copied to 
an image buffer.  If the AOI is to 

ge buffer, 
various operations can be 
performed during the copy 

to an 
fer and adds the value 

region in the destination image 
buffer. 

SAVE_TO
COPY_TO_B ER / be copied to an ima

MAT
MAT
MATH_MAX / Operation LIST  

 

operation.  For example, 
MATH_ADD copies an AOI 
image buf

T / 
of each pixel of the AOI to the 
current contents of the target 

5. Results Settings

ShowResults List NONE / FRAME / 
LINE / POINT 

Standard Results Settings 
properties

6. Results
ResultErrorCode Integer   
Res 0 (non-rotating)ultAngle Single
ResultXPos Single mm
Res

pertiesStandard Results pro  
 
X and Y position for the centroid of 
the processed area-of-interest. 

ultYPos Single mm

Remark

ion 
ge buffer.  This is useful for combining several small 

ng or storage. 

Acquisition Tool

s 

This tool copies an area-of-interest (AOI) from the current image to a file, another reg
of the current image, or another ima
AOI's into a single image buffer for additional processi

This tool is similar to the AOI feature of the  in that only a portion of the 
ever, the AOI feature of the Acquisition Tool is performed by 

the camera and reduces the amount of data that the camera sends to PreciseVision (and 
reduces has 
already 

If you ne l operates more 
quickly and generates a smaller file than utilizing the image save feature of the 

quisition Tool. 

full image is copied.  How

 the acquisition time as well).   The AOI Tool operates on an image that 
been acquired. 

ed to only save a portion of an image to a disk file, the AOI Too

Ac
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While most vision tools analyze the data in the camera image and leave the data 
unmodified, this tool can alter the raw data in the image buffer.  All subsequent vision 
tools will operate on the modified image data and not the raw information captured by th
camera. 

If you wish to revert back to the original raw captured image data, special properties must
be set in the 

e 

 
aken. 

Special Feature Buttons (located above the property editor) 

Select Path 

Pressing this button displays a pop-up window that permits you to 
browse the PC's file structure to select the FilePath that specifies where 
the area-of-interest is to be stored if the Operation is set to 
SAVE_TO_DISK. 

Examples 

The various mathematical operations permit a number of interesting processes to be 
performed   In the following image, a picture is taken of what should be two identical 
parts. 

Acquisition Tool at the time that the picture is first t

 

If we use the AOI Tool to subtract the area on the left from the region on the right, any 
non-black pixels left in the destination region indicate differences (defects) between the 
two parts. 
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Likewise, if the position or orientation of one of the two parts is out of alignment, after 
subtracting the AOI in the left with the region on the right, any alignment differences will 
appear as non-black regions. 

 

See Also 

Vision Toolkit | Acquisition Tool
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Barcode Reader Tool 

ol that reads a variety of standar odes
returns the barcode type and the value of the barcode. 
Vision to d 1-D and 2-D barc  and 

Prerequisites 

None 

Properties 

Property Name Data 
Type Range  Description

1. Identity
Name String n/a 

String n/a
Standard Identity properties

Type
2. Placement/Size
Angle Single 0 (non-rotating) 

Sin 0 - AOI (mm) Height gle
Width Single 0 - AOI (mm) 
XPos Single 0 - AOI (mm) 
YPos Single 0 - AOI (mm) 
RelAngle Single 0 
RelXPos Single 0 - AOI (mm) 

Sin  - AOI

dard Pla ies.Stan cement / Size propert   
The X and Y
the region to t 
and Width de dimensions of the 
region.  The 
rotated barco
SkewTolera

 values define the center of 
 be analyzed.  The Heigh
fine the 
AOI cannot be rotated, but 
des can be identified (see 

nce). 

gle 0  (mm) RelYPos
3. Operation
Camera Integer 1 - 6 
Relative-ToolName Li n/a 

Standard Op rtieseration prope
st

ProcessLevel Integer  0 - 5  

Controls the 
are processe r 
value will pro
ut will resul
ate.  The de

speed with which regions 
d verses accuracy.  A lowe
cess images more quickly 
t in a lower successful read-
fault value is 2. 

b
r

SkewLineJump Integer  1 - 9  In order to recognize barcodes that are 
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SkewTolerance Integer 0 - 5 

not aligned a l or vertical 
axes of the c  
and SkewLin ust be adjusted.  

he approxim
eviations of

or vertical ori s 
of the SkewT
 
   0 - up to 5 
   1 -  "   "  13
   2 -  "   "  21
   3 -  "   "  29
 4 -  "   "  37

  "  45
 
The SkewLi
many lines a  
of the scanni
specifically for locating skewed 

codes.  1 means that every line in the 
sted.  Lower values for this 
will increase the processing 

t may be useful for poor quality 

de is aligned along the X or Y 
kewTolerance should be set 

d the SkewLineJump should be 
 minimize the tool's processing 

long the horizonta
amera, the SkewTolerance
eJump m
ate permitted angular 

 a barcode from a horizontal 
entation for various setting
olerance are as follows: 

T
d

degrees 
   " 
    " 
   " 
   " 
   " 

neJump determines how 
re skipped during the portion
ng process that is 

  
   5 -  " 

bar
region is te
parameter 
time bu
images. 
 
If the barco
axes, the S
to 0 an
set to 9 to
time. 

3A. Advanced Operation

AllowDuplicates Boolean  TRUE / 

ode is badly damaged, the same 
be reported twice within the 

mage.  If this parameter is FALSE, 
te results are only reported a 

e.  If TRUE, the same value can 
be returned multiple times in the same 
image. 

FALSE  

If a barc
barcode may
same i
duplica
single tim

p Bool E  Bottom_To_To ean  TRUE / FALS
Left_To_Right Boole TRUE / FALSE  an  
Right_To_Left Boolea TRUE / FALSE  n  

Top_To_Bottom Bool RUE / FAL

These parameters specify the directions 
in which the software will scan looking for 

odes.  If the barcodes always appear 
in the same orientation, turning off the 

eded scannin
ution tim

wTolera ility to identify 
arcodes tha
r horizontall

barc

unne
exec

g directions will reduce 
e.  Also, see 

nceSke  for the ab
t are not oriented vertically 
y. 

ean  T SE  
b
o

5. Results Settings
MaxResults Integer -1 or 1 to n 
ResultOnNotFound Boole TRUE / FALSEan

ShowResults List NONE / F
LINE / P

rd Re es
RAME /
OINT 

Standa sults Settings properti
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ShowResultType Boo RUE / Flean T ALSE 

ShowResultValue Boolean TRUE / F

wResu
ar  displayed 
e barcode in the camera 

dow.  In addition, if ShowResultType 
E, the display will include the type 

code that was found. 

If Sho ltValue is TRUE, the 
code value will be

ALSE 
is TRU
of the bar

identified b
on top of th
win

6. Results
  ResultErrorCode Integer

ResultAngle Single 0 (non-rotating)
ResultXPos Single mm

s Single mm

eStandard R sults properties 
X and Y p
the located b

ResultYPo

osition represent the centroid of 
arcode. 

Stri    e type of t
Result.InfoString]

Th
[GPL: Vis

he barcode, e.g. UPCA.  ResultCode ng

ResultCodeDirection Integ    

s the
te the ba

Indicate
loca

 scanning direction used to 
rcode  [GPL: 

VisResult.Info(1)] 

ght 
to top 

 
 1 - Left to ri

   2 - Bottom 
   4 - Right to
  8 - Bottom 

er   

 left 
to top  

ResultCodeValue String    he value ofT  the barcode.  [GPL: 
VisResult.InfoString]

Remarks 

This tool reads a variety of popular types of 1-D and 2-D barcode
cated w gle AOI and the barcodes can
g for m es of barcod reases exe

of the barcode as well as its type are returned by this tool and ca
in the camera window on top of the identified barcode. 

This tool can locate barcodes that are oriented in any direction (a
are approximately horizontal or vertical are processed most quickl
operate on grayscale or color images, with grayscale images bein
rapidly and more reliably due to the single image plane and highe

In order to reliably detect barcodes and to determine their correct  
should be kept in mind: 

• As a general rule-of-thumb, the thinnest bar should be at
Likewise, the smallest gap between bars should be at lea

• If a barcode is not horizontal or vertical but is tilted (skew
and gap width should be increased to at least 5 pixels sin  
like stair steps and alternately are thick and thin.  

barcod tion is wel te space luded in 
und th e so that  can det d end of 

the bars or squares.  

The Barcode Reader Tool can detect a number of different codes and can correctly 
operate even when the barcode is at any orientation or the image is somewhat degraded 

s.  More than one 
 be of different types 
cution time).  The value 
n optionally be displayed 

lthough barcodes that 

barcode can be lo
(although searchin

ithin a sin
ultiple typ es inc

y).  This tool will 
g processed more 
r quality edges. 

 values, the following

 least 3 pixels wide.  
st 3 pixels wide. 
ed), the minimum bar 
ce diagonal lines look

• Even if the 
the AOI aro

e's posi
e barcod

l known, whi
 the software

 should be inc
ect the start an
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or the barcode is slightly defective.  However, the execution spee
optimized by reducing the generality of the property settings, suc
the AOI to be searched, disabling unneeded barcode types, redu
etc. 

Special Feature Buttons (located above the property editor) 

Select Codes 

Pressing this button displays a pop-up window that can r
of barcodes that are detected during the scanning proces
unneeded types will reduce the execution time of the too
variations of the following types of 1-D and 2-D barcodes  

d of this tool can be 
h as reducing the size of 
cing the skew tolerance, 

estrict the types 
s.  Disabling 

l.  Currently, 
 can be

detected:  Code 3  93, Code 5 (interle -9, Code  128, Code 2 aved and non
interleaved), Codabar, EAN-8, EAN-13, UPC-A, UPC-E, PDF-417, Data 
Matrix, Databar, and Patch Codes. 

Advanced Settings 

button displays a pop-up wind rese
perti  barcode tool whose default va

normally acceptable.  For convenience, this pop-up also 
duplicates for some of the common properties that are co
standard Property Display.  The following describes the o
unique Advanced Settings.  

Pressing this 
advanced pro

ow that p nts more 
lues are 

contains 
ntained on the 
peration of the 

es of the

Property Name Data 
Type Range  Description

Convert UPC-E to 
EAN-13 Boolean TRUE / 

FALSE 

If TRUE, UPC-E
automatically co
13. This is FALS

 barcodes are 
nverted into EAN-
E by default.  

GammaCorrection 1 - n  

If this value is n
Correction equa

maCorrect
lied to adjus

illumination of th
this value is 100
don't apply a co

ot 100, a Gamma 
l to 
ionGam

app
/100 will be 

t the overall 
e AOI. By default, 
, which means 
rrection. 

Integer

1 - 9 

This property de
many lines are 
initial scan for a

ry line in  

parameter will increase the 
processing time but may be useful 
for poor quality images.  This value 
is 1 by default.  

termines how 
skipped during the 
 barcode.  1 means 

that eve
tested.  Lower values

 the region is
 for this Line Jump Integer

Median Filter Boolean TRUE / 
FALSE 

If TRUE a median filter is applied to 
the AOI before scanning for the 
barcode.  This can eliminate small 
flaws in high resolution images.  It 
should not be applied to low 
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resolution imag
blur the transitio rs 
and gaps.  This
default.  

es since this will 
ns between ba

 is FALSE by 

1 - 999  

Specifies the la
characters in th

 checksum c
999 by default.  

rgest number of 
e barcode including 
haracters.  Set to Max Length Integer any

Min Length Integer 1 - 999  
Defines the min
number of chara
barcode value. 

imum acceptable 
cters in a valid 

 Set to 4 by default 

th 0 - n 

Defines the min
width of spaces
Spaces that are

 are ignored
ic

system will automatically determine 
the minimum acceptable width. 

imum acceptable 
 between bars.  
 smaller than this 
.  By default, this 

h implies that the 
Min Space Wid Integer size

value is 0, wh

Noise Reduction Integer 0 - n 

before being scanned to eliminate 
marks that are unlikely to be part of 
the barcode.  Larger values will 
reduce larger marks.  This can be 
helpful in poor quality images.  A 
typical value is 10.  By defau

If greater than 0, the AOI is filtered 

lt, this 
is set to 0.  

Numeric Barcode Boolean TRUE / 
FALSE 

If TRUE, only numeric barcodes 
are identified. By default, this value 
is FALSE.  

Quite Zone Integer 0 - n  

When a line in the image is 
scanned, regions that are not 
preceded by this number of white 
pixels are ignored.  Set to 0 by 
default.  

Show Check 
Digits Boolean TRUE / 

FALSE 

If TRUE, the barcode check digit 
will be included in the barcode 
value. This property only applies to 
barcode types with built-in check 
digits, such as Code 128.  Set 
FALSE by default.  

Use 
Oversampling Boolean TRUE / 

FALSE 

If TRUE, 3 sequential lines at a 
time are scanned and their average 
pixel value is used to determine the 
barcode.  This is useful for images 
that contain both white and black 
speckles.  Set FALSE by default.  

Examples 

The following two examples demonstrate the Barcode Reader Tool identifying the same 
character pattern presented as both a 1-D Code 39 and a 2-D Data Matrix pattern.  In 
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each picture, the darker blue boxes display the barcode type and value as determined by 
this tool.  

 

 

See Also 

Vision Toolkit
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Clear Grip Tool 

Vision tool that verifies that there is no obstruction within the bounds of a 
defined window. This tool is typically used to confirm that gripping a part 
will not result in a collision. 

Prerequisites 

Properti

None 

es 

Property Name Data 
Type Range  Description

1. Identity
Name String n/a 
Type String n/a

Standard Identity properties

2. Placement/Size
Angle Single -360 to 360 
Height Single 0 - AOI (mm) 
Width Single 0 - AOI (mm) 
XPos Single 0 - AOI (mm) 
YPos Single 0 - AOI (mm) 
RelAngle Single -360 to 360 
RelXPos Single 0 - AOI (mm) 
RelY

Standard Placement / Size properties.  The 
X and Y values define the center of the 

dth verification window.  The Height and Wi
define the dimensions of the window. 

Pos Single 0 - AOI (mm) 
3. Operation
Camera Integer 1 - 6 
Relative-ToolName List n/a 

Standard Operation properties

EdgeThreshold Integer 0 - 254 

Specifies the threshold below which weak 
(low contrast) gradients edges are ignored.  
The smaller the number, the more sensitive 
the system is in locating edges.  Please see 
the description of the Edge Locator for 
more information on edge gradients.  The 
default value is 30. 

4. Inspection Settings
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InspectType List NONE / 
EDGE_COUNT 

InspectLabel List

NONE / 
PASS_AND_FAIL / 

PASS / FAIL / 
VALUE_REAL / 

VALUE_INTEGER 
InspectMax Single   
InspectMin Single   
InspectActual Single  
Insp List Pass / Fail

Standard Inspection Settings properties

ectPassed
5. Results Settings

ShowResults List NONE / FRAME / 
LINE / POINT Standard Results Settings properties

6. Results
Resul Code Integer   tError
ResultAngle Single -360 to 360
ResultXPos Single mm
ResultYPos Single mm

Standard Results properties

ResultEdgeCount   Number of edge pixels fouInteger nd. [GPL: 
VisResult.Info(0)]  

ResultTotalArea r  Total number of pixels in the tested 
recta lt.Info(1)]Intege  ngular region. [GPL: VisResu  

Remarks 

This tool specifi tangular r nd tests it to ensure that it is free of 
obstacles.  This tool is typically us at the fin
reach in and pick up a part without hitting another part. 

gion is clear by extracting edges gion and the number of edge 
ixels.  If an exc umber o ist, this indicates that a part or 
bstruction is in the region. 

The Clear Grip  normally e to ano
that is used to lo  part.  In on for t ce regions to 

fined for a part, one for each of the gripper's fingers.  When the Clear Grip tool is 
essed, all of the pixels within the r ose gray-scale gradient value exceeds 

the Edge Thres  counted as e ixels.  By se
 if the ber of edges falls outside of the Inspec

limits, this tool will signal a failure. 

Special Feature Buttons (located above the property editor) 

Adjust Edge Threshold

Pressing this button displays a pop-up window t  of 
Threshold property to be manually adjusted while dynamically 

fect of th  Cam
indicates s tha old cr

es a rec egion of an image a
ed to verify th gers of a robot's gripper can 

 This visual tool verifies that the 
 counting re  within the re

p
o

essive n f edge pixels ex

region is
cate the

 defined relativ
fact, it is comm

ther vision tool, e.g. a Finder, 
wo or more clearan

be de
proc egion wh

dge phold are tting the InspectType to 
tMax and InspectMin EdgeCount,  num

hat permits the value
the Edge 
viewing the ef

 the edge
e new setting in the
t satisfy the thresh

era Display.  The display 
iterion in white.  
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Examples 

In the following example, the Cle ed to t
positioned parts can be safel t is
Grips tools are tested, one on each side of the part.  If th
portion of another part, the zone is marked as passed.  However, in the sample picture, 
one zone in the center of the image is partially occluded
marked as failed.  This would prevent the robot from att
center and potentially damaging the adjacent part or the

ar Grip tool is us
y grasped.  As each par

est if randomly oriented and 
 located by a Finder, two Clear 
e grip zone does not contain a 

 by another part and that zone is 
empting to pick up the part in the 
 gripper. 

 

See Also 

Vision Toolkit | Finder Tool
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Connectivity ( ) Tool 

at searches a specified region for binary blobs (and/or 
eturns the centroid and other features of each blob (and/or 

). In addition, this tool can retu defines the perimeter of a 
ed blob. 

Blob

Vision tool th
holes) and r
hole rn data that 
locat

Prerequisites 

None 

Properties 

Property Name Data 
Type Range  Description

1. Identity
Name String n/a 
Type String n/a

Standard Identity properties

2. Placement/Size
Angle Single 0 (non-rotating) 
Height Single 0 - AOI (mm) 
Width S mingle 0 - AOI (m ) 
XPos Sing I (mmle 0 - AO ) 
YPos S mingle 0 - AOI (m ) 
RelAngle Single 0 
RelXPos Single 0 - AOI (mm) 
RelYPos Single 0 - AOI (mm) 

Standard Placement / Size 
properties.  The X and Y 
values define the center of 
the tool and the center of the 
search region.  The Height 
and Width specify the size of 
the search region. 

3. Operation
Camera Integer 1 - 6 
Relative-ToolName List n/a 

Standard Operation 
properties

BlobFindMode List
BLOBS_ONLY / 

OLES_ONL

bjectColor are to located 
or if blobs and/or holes are 

ite 
ObjectColor that is 
contained within a blob.  By 
default, only blobs are 

BLOBS_AND_HOLES / 
H Y  

to be located.  A hole is a 
region of the oppos

Specifies if only blobs that 
have the correct 
O
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located.  
MaxArea Integer 0 - n 

MinArea Integer 0 - n 

Specifies the maximum and 
minimum number of pixels 
that a valid blob must 
contain.  Any blob that 

 will 
consists of a greater or 
lesser number of pixels
be ignored. 

Obje

a is 
fines 

oups 
of black or white pixels 
should be considered as 
blobs. 

ctColor List DARK_OBJECT / 
LIGHT_OBJECT 

After the image are
converted to binary, de
whether connected gr

Thre

ld 
ale 

 
l 

 
ed, 

ally 

full 
e 
g 

eature button 
described below or the 
AutoThresh property. 

Specifies the thresho
below which gray-sc
pixels will be set to black
and above which pixels wil
be set to white. 

shold Integer 0 - 254 
When this tool is creat
the system will automatic
set this property to a 
reasonable value for the 
vision window.  This valu
can also be updated usin
the special f

3A. Advanced Operation

Auto

 
.  

pressing the special feature 
button that is described 
below.  

Thresh Integer 0  or <>0  

If set non-zero, the 
Threshold property is
automatically computed
This is equivalent to 

IgnoreClipped Boolean TRUE / FALSE  

If TRUE, any blobs that are 
not completely inside of the 
Width and Height search 
area are ignored.  If FALSE, 
even if a portion of a blob is 
clipped by the search area 
boundaries, it is still returned 
as a result.  

MaxHoleArea Integer 0 - n 

MinHoleArea Integer 0 - n 

Maximum and minimum 
number of pixels required 
before a hole in a blob is 
retained and not filled in.  If 
the minimum value is set to 
the total area of the image in 
pixels, holes will always be 
deleted. 
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MaxRadiusLength Single mm 

MinR

eters 

ngth 
nd the 

ResultMinRadiusLength of 
se 

limits.  Any blobs whose 
radiuses fall outside of this 

If either of these param
is non-zero, the 
ResultMaxRadiusLe
a

adiusLength Single mm a blob must fall within the

range will be ignored.  

SampleRate Integer 0 - n 

et to return 
, 
w 

many pixels to skip along the 
perimeter between each 
returned "result" position.  A 
value of '0' will not skip any 

r 

When the tool is s
PERIMETER information
this properly specifies ho

pixels and every perimete
point is returned. 

4. Inspection Settings

Insp  
MINOR_AXIS_ANGLE / 

MINOR_LENGTH / 
PERIM_LENGTH 

NONE / 
NUM_BLOB_FOUND / 

MAX_RADIUS / 
MIN_RADIUS / 

MAX_RADIUS_ANGLE / 
MIN_RADIUS_ANGLE / 
MAJOR_AXIS_ANGLE /ectType List

BLOB_AREA / 
MAJOR_LENGTH / 

Insp

NONE / 

VALUE_INTEGER 

ectLabel List
PASS_AND_FAIL / 

PASS / FAIL / 
VALUE_REAL / 

InspectMax Single   
InspectMin Single   
Insp  ectActual Single
Inspec

Standard Inspection Settings 

tPassed List Pass / Fail

properties

5. Results Settings
MaxResults Integer -1 or 1 to n 
OffsetAngle Single degrees 
OffsetX Single mm 
OffsetY Single mm 

Standard Results Settings 
properties.  
 
MaxResults defines the 
number of blobs or perimeter 
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Resu List MAX_RADIUS / 
MAJOR_AXIS / 
MINOR_AXIS / 

ltMode

BLOB_CENTER / 
MIN_RADIUS / 

PERIMETER 
ResultOnNotFound Boolean TRUE / FALSE

ShowResult

ach time this 
d. By default, 

this property is set to -1, find 
all possible blobs or 
perimeter points. 

 a description 

points to find e
tool is execute

s List NONE / FRAME / LINE / 
POINT 

 
See below for
of ResultMode. 

ResultSort List

SORT_MAX_AREA / 
SORT_MIN_AREA / 

SORT_CENTER_MOST /
SORT_LEFT_MOST / 

SORT_RIGHT_MOST / 

Specifies the order in which 
located blobs and holes are 
returned in the results.  

SORT_NONE / 

SORT_TOP_MOST / 
SORT_BOTTOM_MOST  

6. Results
ResultCount Integer  0 - n 
ResultErrorCode Integer   
ResultAngle Single -360 to 360
ResultXPos Single mm

ResultYPos Single mm

ts propertiesStandard Resul
 
ResultCount indicates the 
number of blobs located in 
non-PERIMETER mode.  In 
PERIMETER mode, this is 
sum of all perimeter points 
found for all blobs. 

ResultBlobArea Integer pixels

Total area of the blob in 
pixels excluding any holes 
within the blob. [GPL: 
VisResult.Info(3)]

ResultNumPerBlobs Integer 0 - n 

For PERIMETER mode, this 
is the total number of blobs 
located and ResultCount 
indicates the sum of all 
perimeter points available.  
For non-PERIMETER mode, 
this value is undefined and 
ResultCount indicates the 
total number of blobs 
located. [GPL: 
VisResult.Info(2)]

ResultObjectIdx Integer   

 

 

represents a single 
perimeter point.  If multiple 
blobs are located, this 
property can be monitored to 
determine when the 
perimeter points pertain to 
the next blob. [GPL: 

Each blob in a region is
assigned an index.  In 
PERIMETER mode, each
returned VisResult 
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VisResult.Info(0)]
ResultMajorAxisAngle Single -360 to 360

ResultMajorAxisLength Single mm

Angle [GPL: 
VisResult.Info(8)] and 
Length [GPL: 
VisResult.Info(9)] of the 
major axis of the best fit 
ellipse for the blob.  This 
axis provides a means for 
characterizing the orientation 

rbitrary shape 
unambiguously within +-90 
degrees. By definition, this 
ellipse has the same 2nd 
moments of inertia as the 
blob. 

of an a

ResultMinorAxisAngle Single -360 to 360

Re ngth ingle

Angle [GPL: 
VisResult.Info(10)] and 
Length [GPL: 
VisResult.Info(11)] of the 
minor axis of the best fit 
ellipse for the blob.  This 
axis provides a means for 
charact entation 
of an arbitrary shape 
unambiguously within +-90 
degrees. By definition, this 

blob. 

sultMinorAxisLe S mm erizing the ori

ellipse has the same 2nd 
moments of inertia as the 

ResultMaxRadiusAngle -360 to 360Single

ResultMaxRadiusLengt ingle

Angle [GPL: 

h S mm

VisResult.Info(6)] and 
Length [GPL: 
VisResult.Info(7)] of the 
maximum radius for the 
blob.  This radius is 
measured from the blob 
centroid to the point on the 
perimeter that is furthest 
from the centroid.  This 
provides a means for 
characterizing the orientation 
of an arbitrary shape.  

ness of 
nction of 

. 

However, the unique
this radial line is a fu
the shape

ResultMinRadiusAngle Single -360 to 360 Angle [GPL: 
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VisResult.Info(4)] and 
Length [GPL: 
VisResult.Info(5)] of t
minimum radi
blob.  This radius is 
measured from the blob 
centroid to the point on th
perimeter that is closest to 
the centroid.  This provides a 
means for characterizing the
orientation of an arbitrary 
shape.  However, the 
uniqueness of this radial line 
is a function of the shape. 

ResultMinRadiusLength Single mm

he 
us for the 

e 

 

ResultPerimeterLength Single mm
The length of the perimeter 
of the blob.  [GPL: 
VisResult.Info(12)]

Remarks 

The Connectivity tool converts the region defined by its green ou
 and gr ne els with the c

t satisfy the spe  limits as w
(i.e. blobs within blobs) are not returned.  For all valid blobs, the 
and other key features are computed and returned as the results

This tool is similar to the Finder Tool in that multiple objects can 
 is a less discriminating and less powerful tool than the Finder, but 
seful.  In particular, Connectivity should be used for locating 

objects that do not have a fixed boundary and in applications tha
visually simple images.  Parts that vary in size and shape are ea
tool.  In addition, this tool has the ability to return the perimeter o
individual results points. This perimeter retrieval feature allows a
trace an object, which is useful in the textile or automated cutting

ision system m ifferentia  differ
locate objects that touch other object are no
from the background, or operate when thresholding may not be a
Finder Tool should be utilized in place of Connectivity. 

With regard to the performance of the Connectivity tool, even tho
binary images, the X & Y position of the centroid of blobs is norm  within a 
fraction of a pixel.  This is due to the fact that the centroid is com
consideration the positions of all of the perimeter pixels.  In gene
the more accurate the centroid position.  Consequently, the cent
good measure of where the blob is located. 

he blob roid, ea atu
indicated in the following drawing

tlined rectangle to a 
orrect binary image

blobs.  Any blobs that do n
oups adjacent ("con

o
cted") pix
cified size

ObjectColor into 
ell as any interior blobs 
position of their centroid 
 of this tool. 

be identified and 
located.  However, this
it is nonetheless very u

t have high contrast with 
sily located using this 
f any blob as a series of 
n application to easily 
 industries. 

 by subtle features, 
t clearly differentiated 
ppropriate or robust, the 

ugh this tool operates on 
ally accurate to

If the v ust d te between objects that
s, locate objects that 

puted by taking into 
ral, the larger the blob, 
roid position is a very 

res computed as In addition to t  cent ch blob has several other fe
. 
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on of the blob.  
atures will be more 

These additional features can be used to determine the orientati
Depending upon the exact shape of the object, some of these fe
useful than others.  For example, if the blob is a rectangle, all four corn
same maximum radius from the centroid, so the ResultMaxRadi
one of four values, all of which are correct.   In many cases, the o
axis of the best-fit ellipse (ResultMajorAxisAngle) can provide a
estimation.  But, it should be kept in mind that this parameter alw
ambiguity due to the symmetry of an ellipse. 

tMode property selects which of the properties is utiliz
orientation of each blob or if the orientation is to be fixed (BLOB_

If the ResultMode property is set to PERIMETER, this tool return
one for each desired point on the perimeter of each located blob
contains the X & Y position of a point on the perimeter with the o
perpendicular to the perimeter of the blob.  In this mode, the SampleRate
some pixels on the perimeter are to be skipped.  For example, if 
to 3 and two blobs are located, the coordinates of every 3rd pixe
first blob will be returned in the VisResult and ResultObjectIdx w
last perimeter position of the first blob is transmitted, every 3rd p
the second blob will be returned with the ResultObjectIdx set to

Special Feature Buttons (located above the property editor) 

Automatic Threshold

The Connectivity tool operates on a thresholded binary i
requires a specific gray level to be entered in the Thresh
define which pixels are to be converted to black (below t
and white (above the Threshold). To help set this value
"Automatic Threshold" button available above the proper
this button is pressed, the Threshold property is automa
system's best estimate for the tool's search region. 

If the Threshold is properly set, a thin red boundary sho
along the perimeter of each located object.   If required, 
the Threshold value to ensure the displayed red bounda
aligned with the object boundary. 

ers will be at the 
usAngle can return any 
rientation of the major 
 very good orientation 
ays has a 180 degree 

ed to compute the 
CENTER). 

s a series of results, 
.  Each VisResult 
rientation angle set to be 

The Resul

 specifies if 
the SampleRate is set 
l on the perimeter of the 
ill be set to 1.  After the 

ixel of the perimeter of 
 a value of 2. 

mage. This 
old property to 

he Threshold) 
, there is an 
ty editor.  When 
tically set to the 

uld will be drawn 
manually adjust 
ry is properly 

Adjust Threshold
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Pressing this button displays at permits the value of 
the Threshold property to be
iewing the e of the play.  The 

ayed ima ows a r w
white pixels are the ones th d. 

Exa

g example, a single part is l nec
 radius is u etermine the orientation of the part ( de set to 

ADIUS).  The red outline illustrates the perimeter of the object as computed by 
he interse  the X and Y axes denotes the computed centroid of the 
 X-axis is  w h the radial line to the perimeter point that is furthest away 

troid.  Fo part, the maxi  point yields a unique orientation 
ect. 

a pop-up window th
 manually adjusted while dynamically 

 new setting in the Camera Dis
ll pixels converted to black o

at are above the threshol

v
displ

ffect 
ge sh hite, where the 

tivity (blob) tool. The 

mples 

In the followin
maximum

ocate ng a Cond usi
sed to d ResultMo

MAX_R
the tool.  T
blob.   The

ction of
 aligned it

from the cen r this mum radius
angle for the obj

 

In the following example, the ResultMode is set to PERIMETER
rns the locations of the points along the perimeter of the  
pleRate ha a yellow "X" is drawn ev

ter representing each of the returned values. 

 and the Connectivity 
object.  In this example,
ery 20 pixels along the 

tool retu
the Sam
perime

s been set to 20, so 

 

In this following example, a Fixed Frame tool has been added to the vision process.  The 
xed Frame has its RelativeToolName set to the name of the Connectivity tool.  The 
nnectivity tool is once again set into PERIMETER mode.  Since the orientation of each 

can 
e 

Fi
Co
of the perimeter results is perpendicular to the perimeter of the blob, the Fixed Frame 
be used to create a series of points that are a fixed distance inside of the boundary of th
blob.  In the picture below, the display of the blob perimeter points has been turned off 
and the position of each Fixed Frame is being displayed as a yellow "X". 
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o See Als

Vision Toolkit | Finder
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Edge Locator Tool 

histogram 

Vision tool that detects edge points with sub-pixel accuracy along a linear 
path in a vision image and returns their positions.  Alternately, this tool 
can return an array of the intensities along the linear path or a 
of their values. 

Prerequisites 

None 

Properties 

Property Name Data 
Type Range  Description

1. Identity
Nam Strie ng n/a 
Typ Stri

es
e ng n/a

Standard Identity properti

2. Placement/Size
Ang Single le -360 to 360 
XPo Sings le 0 - AOI (mm) 
YPo Sings le 0 - AOI (mm) 
Rel SingAngle le -360 to 360 
Rel SingXPos le 0 - AOI (mm) 
Rel Sing 0

.

YPos le  - AOI (mm) 

Standard Placement / Size properties   
The X and Y values define the center of 
the tool.  

Len Sing e linear path that is 
tested for edges.  gth le 0 - AOI (mm) Defines the length of th

3. Operation
Cam Inteera ger 1 - 6 
Rel Listative-ToolName n/a 

Standard Operation properties

EdgeThreshold Integer 0 - 254 

 value 
 

rate 
he 
e 

Specifies the gray scale threshold
used to detect edges or (in the case of
gradient values) the threshold for the 
of change of the gray scale values.  T
smaller the number, the more sensitiv
the system is in locating edges.  The 
default value is 30.  

3A. Advanced Operation
Des EDGE_BINARY / EDGE_BINARY: identifies edge iredAlg List
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EDGE S / 
E
E

PRECISION_SUBPIX 
E_GRAYTHRESH: identifies an edge 

position whenever the gray scale value 
crosses a specified threshold value. 
 
EDGE_SUBPIX: computes the positions 
of edges to a sub-pixel accuracy based 
upon the rate of change (gradient) of the 
gray scale values.  This is the default 

EDGE_HIGH_PRECISION_SUBPIX: 
similar to the sub-pixel mode except that a 
more precise interpolation technique is 
employed that provides more accurate 
sub-pixel edge locations at the cost of a 
small increase in execution time.  In rare 
cases where very fine features (e.g. 2 or 3 
pixel bumps) are contained in the edge 
and need to accurately accounted for, 
EDGE_SUBPIX may produce more 

ses a 
 results. 

_GRAYTHRE
DGE_SUBPIX / 
DGE_HIGH_-

transitions in a binary image.  
 
EDG

setting.  
 

accurate results since that method u
smaller pixel region to compute its

Des Lis
EDGE_ALLGRADS / 
EDGE_P RADS / 
EDGE_NEGGRADS 

This parameter specifies whether all 
edges are to be detected 
(EDGE_ALLGRADS) or only edges that 
occur when the gray scale value goes 
from dark-to-light (EDGE_POSGRADS) or 
only edges when the gray scale value 

etecting only 
negative or positive edges helps 
disambiguate the edge being detected or 
can eliminate double edges that occur 
when thin dark or light features are 
encountered.  Processing starts at the 

ds at the 

iredGrads t OSG
goes from light-to-dark 
(EDGE_NEGGRADS).  D

square resizing handle and en
round rotation handle. 

MaxEdg  to ePoints Integer 1 - n Maximum number of edge points
return. 

4. Inspection Settings

InspectT

GRAY_AVERAGE / 
  

Standard Inspection Settings properties.

NONE / 
NUMBER_OF_POINTS / 

DISTANCE_TO_-
FIRST_POINT /   

self 

e or 
he 

DISTANCE_TO_-
LAST_POINT / 

DISTANCE_TO_-
MID_POINT / 

DISTANCE_FROM_-
FIRST_TO_LAST / 

ype List

GRAY_MIN / GRAY_MAX

All of the inspected results should be 
explanatory except perhaps the 
"GRAY_...", which test the averag
min/max grayscale values along t
length of the entire tool.  
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InspectLabel List
NONE / PASS_AND_FAIL / 

PASS / FAIL / VALUE_REAL 
/ VALUE_INTEGER 

InspectMax Single   
InspectMin Single   
InspectActual Single  
I sed List Pass / Fail

 

nspectPas
5. Results Settings
MaxResults Integer -1 or 1 to n 
OffsetAngle Single degrees 
OffsetX Single mm 
OffsetY Single mm 
ResultOnNotFound Boolean TRUE / FALSE
ResultSelect Integer 1 - n 

S NONE / FRAME / LINE / 
POINT 

Standard Results Settings properties

howResults List

ResultMode List

RESULT_EDGE_POINTS / 
RESULT_FIRST_POINT / 
RESULT_LAST_POINT / 
RESULT_MID_POINT / 

RESULT_PASS_-
THRU_SOURCE / 

RESULT_HISTOGRAM / 
RESULT_GRAYLEVEL  

Defines whether all edge points or 
selected edge points are to be returned in 
the results.   
 
The "RESULT_PASS_THRU_SOURCE" 
is a special mode where this tool returns 
the "Results" of its parent tool pointed to 
by RelativeToolName.   This permits a 
process to add one or more Edge 
Locators after it has computed the 
position of a part and use the Locators to 
perform additional visual verification tests, 
but still have the process return the 
"Results" location of the parent tool.  
Please see the "PassFailEdgeCount" 
demonstration program that was shipped 
with PreciseVision for an example of the 
use of this feature.  
 
The "RESULT_GRAYLEVEL" and 
"RESULT_HISTOGRAM" are special 
modes that return an array containing 
either the intensity (grayscale) value for 
each pixel along the length of the tool or 
the computed histogram of the distribution 
of intensity values.  If either of these 
modes are selected, edge points are not 
detected. 

6. Results
ResultCount Integer 0 - n 
ResultErrorCode Integer   
ResultAngle Single -360 to 360

Standard Results properties
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ResultXPos Single mm
ResultYPos Single mm

 

Remarks 

This tool finds object boundaries, i.e. edges, along a linear path in an image.  The edge 
positions can be used to measure the dimensions of objects or detect if key features are 

tected in a number of different modes (e.g. 
aw pixel values or a histogram of the 
th can be returned.  In other vision systems, 
per" or "ruler".  

Locating Edge Points 

present or absent.  The edges can be de
threshold, sub-pixel, etc).  Alternately, the r
grayscale values of the pixels along the pa
this type of tool is sometimes called a "cali

When locatin
line.  Proce

g edge points, this tool operates by analyzing pixels along the specified 
ssing starts at the square resizing handle and ends at the round rotation 

.  In cases where you wish to compute the position of a single straight or smoothly 
 edge, the Line Fitter and Arc Fitter tools will yield more accurate results because 

 an edge position utilizing many more pixel values.  

y 

dge 
 

handle
curved
they compute

The primary mode of operation for this tool is specified by the Desired Alg property.  If 
this parameter is set to "EDGE_GRAYTHRESH", an edge is detected whenever the gra
scale value crosses the threshold specified by EdgeThreshold.  The graph below shows 
a typical example of how the gray scale values might appear along the length of an E
Locator.  In this case, if the threshold is set to 100, two edges will be detected (Crossing
#1 and #2) where the gray scale values cross the specified threshold value.  

 

If the Desired Alg property is set to "EDGE_SUBPIX", edge positions are computed to a 
pixel accuracy by first computin rate of ch  scale 

ong the length of the Edge Lo   For e
exceed the Edge Threshold value, the peak of th
accuracy and returned as the location of the edge.

sub-
values al

g the 
cator.

ange ("gradients") of the gray
ach region where the gradients 

e gradient is computed with sub-pixel 
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If Desired Alg is set to "EDGE_HIGH_PRECISION
pixel position is computed than the ""EDGE_SUBPIX" method by employing an even 

(and ly) sub-p nation
 nei rhoo e

Finally, if Desired Alg is set to "EDGE_BINARY", 0-to-1 or 1-to-0 transitions are detected 
in a binary image.  

After all of the edges have been determined, this tool can return all of the located edges 
or a selected edge based upon the setting of the ResultMode property.   Also, the 
standard "Inspection Settings" can be used to yield Pass / Fail results based upon the 
number of edges detected, various distance relationships or the average grayscale value 
along the entire length of the tool.  

Computing Intensity Histogram

_SUBPIX", a higher-resolution sub-

more accurate 
longer gradient

 cost
ghbo

ixel determi
d along the path of th

 method.  This method analyzes a 
 Edge Locator. 

If the ResultMode is set to "RESULT_HISTOGRAM", rather than computing edge points, 
this tool counts the number of pixels along the specified line that has each of the possible 
256 grayscale values and returns the pixel counts.  This count of the grayscale 
distribution of pixels is called an intensity "Histogram".   It is useful for determining the 
prevalent grayscale values and the intensity differences between the peak values.  

If you are executing GPL version 2.0 or later, an array of 256 counts ( 0[black] - 
255[white] ) can be fetched using the VisResults Info property.  This array of results is 
also displayed in the Vision Results panel of the PV user interface in the "Special 
Results" section and can be recorded if "logging" is enabled.  

Whenever this mode is selected, the ResultXPos and ResultYPos properties represent 
the center of the specified line and can be used to further propagate the vision tree. 

Returning Grayscale Values 
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If the ResultMode is set to "RESULT_GRAYLEVE
this tool returns the grayscale (intensity) value for 
specified line.  Each grayscale value can range fro

If you are executing GPL version 2.0 or later, an a
fetched using the VisResults Info property.  This 
Vision Results panel of the PV user interface in the
recorded if "logging" is enabled.  

Whenever this mode is selected, the ResultXPos 
the center of the specified line and can be used to

Special Feature Buttons (located above the property editor

Adjust Threshold

Pressing this button displays a pop-up win
the Edge Threshold property to be manu
viewing the effect of the new setting in the
DesiredAlg mode is "EDGE_BINARY", th
above the threshold as white.  Otherwise, 
display indicates the edges that satisfy the

Show Histogram

SUL OGRAM" mode is selec n will pop-up a 
window that displays the histogram for the sp
image.  A sample graph is shown below.  
tool placement described in the Example b
number of white pixels with grayscale valu
distribution of dark pixels with grayscale va

L", rather than computing edge points, 
each pixel along the length of the 
m 0 (black) to 255 (white).  

rray of up to 1500 pixel values can be 
array of results is also displayed in the 
 "Special Results" section and can be 

and ResultYPos properties represent 
 further propagate the vision tree. 

) 

dow that permits the value of 
ally adjusted while dynamically 
 Camera Display.  If the 
e display illustrates the pixels 
for the grayscale modes, the 
 threshold criterion in white.  

ted, this butto
ecified line in the current 

This graph corresponds to the 
elow.  You will note the large 
es around 238 and a 
lues between 34 and 68. 

If "RE T_HIST

 

Show Gray Level

If "RESULT_GRAYLEVEL" mode is selected, this button will pop-up a 
window t ys the g levels 
specified e curren A sam
This graph corresponds to the tool placement described in the Example 

hat displa
 line in th

rayscale 
t image.  

for each pixel along the 
ple graph is shown below.  
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below.  Note the low intensity values for th
black sections of the object.  

e pixels that correspond to the 

 

Exa

In the following example, an edge locator starts on
resizing handle) and processes moving to the righ
In this case, four edges are detected and can be u

r hole and the thickness of the two si s. (No
rmine the  of the ce  and w

measurement.) 

mples 

 the left of the image (at the square 
t (towards the round rotation handle).  
tilized to measure the diameter of the 
te, an Arc Fitter could have been used 
ould have resulted in a more accurate 

cente
to dete

de
nter holediameter

 

See Also 

Vision Toolkit | Arc Fitter | Find Point | Line Fitter 
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Find Centerline Tool 

Vision tool that searches a specified region for edg
the centerline between two located bounding lines

e points and returns 
. 

Pre

None 

Properties 

requisites 

Property Name Data 
Type Range  Description

1. Identity
Name String n/a 
Type String n/a

sStandard Identity propertie

2. Placement/Size
Angle Single -360 to 360 
Height Single 0 - AOI (mm) 
Width Single 0 - AOI (mm) 
XPos Single 0 - AOI (mm) 
YPos Single 0 - AOI (mm) 
RelAngle Single -360 to 360 
RelXPos Single 0 - AOI (mm) 
RelYPos Single 0 - AOI (mm) 

Standard Placement / Size 
properties.  The X and Y 
values define the center of 
the tool and the center of the 
search region.  The Height 
and Width specify the size of 
the search region. 

3. Operation
Camera Integer 1 - 6 
Relative-ToolName List n/a 

Standard Operation 
properties

EdgeMode List

..._NEAREST_DARK / 
..._NEAREST_NOMINAL / 

..._NEAREST_LIGHT / 
..._MAX_GRADIENTS / 

..._MAX_CONCENTRATION 

If several possible lines exist 
within the search region, this 
parameter helps to 
distinguish which two are 
selected as the bounding 
lines.  In addition to selecting 
the lines closest to the dark 
sides, light sides, nominal 
(center line), or greatest 
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concentration of edges, 
can also select the lines wi
the highest contrast. 
 
The concentration mode is 
particularly useful if the

possible boundary line and a

to span multiple groups. If 
concentrati

line, this tool will select the 
largest cohesive group 
edges as the basis for fitting 
the line. 

you 
th 

re are 
two or more distinct non-
colinear groups of edges per 

 
boundary line is attempting 

on mode is 
specified, for each bounding 

of 

EdgeThreshold Integer 0 - 254 

Specifies the threshold 

the 

 

below which weak (low 
contrast) gradients edges 
are ignored.  The smaller 
number, the more sensitive 
the system is in locating 
edges.  Please see the
description of the Edge 
Locator for more informatio
on edge gradients.  The 
default value is 30. 

n 

3A. Advanced Operation

Bias
..._BIAS_TO_DARK 

 

provide extra weight 

arch 
region.  For example, for a 
saw toothed pattern, this 
property could be set to fit 
each  to the 
tips of the high or low points 
of the pattern. 

For boundary lines with an 
irregular or jagged edge, this
parameter can be set to 

Filter List
..._BIAS_NONE / 

..._BIAS_TO_LIGHT / 

(importance) to edges that 
are closest to the light or 
dark side of the se

 boundary line

DrawEdgePoints
..._N OINTS
..._ INTS
..._U OINT

ts to 
hat 

are selected after the 
EdgeMode is applied or only 

SED 
e 

 

understanding the effect of 
changing various property 
settings. This value is 

List
O_EDGE_P  / 

 / 
S 

those edges that are U
to fit boundary lines after thALL_EDGE_PO

SED_EDGE_P

If set, draws yellow do
indicate ALL edge points t

EdgeMode is applied and all 
outliers are eliminated.  This
is very helpful for 

120 



Vision Toolkit Description 

NO_EDGE_POINTS by 
default.  

MaxEdgePoints Integer 2 - n 

Maximum number of edge 
point searches to perform 

ol.   
 

 

across the width of this to
Higher numbers produce
greater accuracy at the 
expense of execution 
speed.  The minimum value 
of this parameter is 2.  This 
value is automatically limited 
to the number of pixels along 
the height of the tool.  The
default value is 30. 

MaxIterations Integer 0 - n 
h 

 

fault value is 

Maximum number of 
iterations for filtering per 
boundary line.  The filtering 
algorithm repeatedly 
removes outlier points, 
refitting a boundary line eac
time, until no more points
need to be removed or the 
maximum number of 
iterations have occurred.  A 
value of zero disables 
filtering.  The de
5. 

MinFilterDistance Single 0 - n.nn 

dary 

n of 
 line can be 

lt value is 1. 

Absolute minimum filter 
distance in pixels.  No edge 
points closer to a boun
line than this are discarded 
during the iterative process.  
A minimum distance is 
needed because the 
standard deviatio
distances to a fit
less than a pixel with a good 
image of a clean edge.  The 
defau

SigmaFilter Single 0 - n.nn 

Filter width in units of 
standard deviations.  This 
value is multiplied by the 
standard deviation of the 
edge points’ distances to a 
boundary line to compute
distance threshold beyond
which edge points are 
removed during the iterative 
boundary line fitting 
pro

 the 
 

cess.  The default value 
is 1.5. 

4. Inspection Settings
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InspectType List

NONE / ..._RMS / 
..._ANGLE / 

..._NUM_EDGES_FOUN
..._NUM_EDGES_USED

..._LINE_THICKNESS 

D / 
 / 

InspectLabel List
NONE / PASS_AND_FAI

PASS / FAIL / VALUE_RE
VALUE_INTEGER 

L / 
AL / 

InspectMax Single   
InspectMin Single   
InspectActual Single  
InspectPassed List Pass / Fail

gs Standard Inspection Settin
properties  The 
LINE_THICKNESS is the 
average distance between 
the two bounding lines 
measured at the center of
th

 
e tool. 

5. Results Settings
OffsetAngle Single degrees 
OffsetX Single mm 
OffsetY Single mm 
ResultOnNotFound Boolean TRUE / FALSE
ShowResults List NONE / FRAME / LINE / POINT 

Standard Results Settings 
properties

6. Results
ResultErrorCode Integer   
ResultAngle Single -360 to 360
ResultXPos Single mm
ResultYPos Single mm

Standard Results properties

ResultLine-
Thickness Single   

en Average distance betwe
the two bounding lines 
measured at the center of 
the tool. [GPL: 
VisResult.Info(3)]

ResultNum-
EdgesFound Integer   

nd Number of edge points fou
during the boundary line 
fitting. [GPL: 
VisResult.Info(1)]

ResultNum-
EdgesUsed Integer   

e points 
remaining after the filtering 
Number of edg

process for the boundary 
lines. [GPL: 
VisResult.Info(2)]

ResultRMS Single    
Root mean square of the 
boundary line fits. [GPL:
VisResult.Info(0)]

Rema

This tool searches the region defin ue outlined rectangle for edge 
omputes the for two bounding lines, and returns the centerline between 
ding lines.  T  convenience routine that internally executes two Line Fitter

rks 

ed by its gray and bl
points, c
the boun

 best fit 
his is a  

accurately locate the bounding lines using least squares fitting and sub-pixel tools to 
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edge extraction tech  T  search area for each Line Fitter is identical to the 
ed for the terline ntation of the two Line Fitters 

0 degrees.  After the Line  completed execution, the center line 
oundary lines is returned by this tool. 

ry useful for a curately lo r line
nce found, ter line can  compu

res or for gener erence frame  can accur
res in an object ol also returns the average th
dary lines meas  the tool. 

ning thi u should pla  center (no
(as indicated by the green double headed arrow) at approx
orientation that you expect to find the center line. 

iled explana f the y
is tool's var erties on  process

section of the Line Fitter tool. 

At the conclusion of this tool, the center position and orien
line are returned.  In addition, statistical data on the numbe
fitting operations and the root mean square of the line fits 
data indicates the quality of the final fits and can be tested
yield a pass/fail indication for the tool's operation. 

Sp uttons (loc

Adjust Threshold

Pressing this button displays a pop-up window tha
the Edge Threshold property to be manually adju
viewing the effect of the new setting in the Camera
that satisfy the threshold criterion are displayed in white. 

Examples 

In the following example, a single Find Centerline tool is u
the orientation of the primary axis of an object.  

niques. he
region specifi
differs by 18

Find Cen  tool.  The orie
Fitters have

between the fit b

This tool is ve
object.  O

c
the cen

cating a cente
 be used to

 between two outer edges of an 
te distances between important 
ately locate an object or 
ickness between the two 

minal) line of the search region 
imately the position and 

 line fitting operation and the 
, please refer to the Remarks 

tation of the computed center 

featu ating ref s that
featu
boun

.  This to
ured at the center of

When positio s tool, yo ce the

For a deta
effect of th

tion o
ious prop

 operation of the boundar
the fitting

r of edges used in the line 
are returned.  This statistical 
 via the "Inspect Settings" to 

t permits the value of 
sted while dynamically 
 Display.  The edges 

ecial Feature B ated above the property editor) 

tilized to accurately determine 

 

See Also 
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Vision Toolkit | Line Fitter | ocatorEdge L

124 



Vision Toolkit Description 

  

Find

Y position of the point 
is returned with sub-pixel accuracy along (and pixel accuracy 

 Point Tool 

Vision tool that locates the edge point that is closest to the line that 
defines the start of the tool's search region.  The X

perpendicular to) the search direction. 

Prerequi

Properti

sites 

None 

es 

Property Name Data 
Type Range  Description

1. Identity
Name String n/a 
Type String n/a

Standard Identity properties

2. Placement/Size
Angle Single -360 to 360 
Height Single 0 - AOI (mm) 
Width Single 0 - AOI (mm) 
XPo

Standard Placement / Size properties.

s Single 0 - AOI (mm) 
YPos Single 0 - AOI (mm) 
RelAngle Single -360 to 360 
RelXPos Single 0 - AOI (mm) 
RelYPos Single 0 - AOI (mm) 

  
r of 

 and the center of the search 
region.  The Width defines the distance 

dge 
of 

The X and Y values define the cente
the tool

that is searched looking for the first e
point.  The Height defines the length 
the reference search line. 

3. Operation
Camera Integer 1 - 6 
Relative-ToolName List n/a 

Standard Operation properties

Threshold Integer 0 - 254 

Specifies the threshold below which 
weak (low contrast) gradients edges are 
ignored.  The smaller the number, the 
more sensitive the system is in locating 
edge points. Please see the description 
of the Edge Locator for more information 
on edge gradients.  The default value is 
30. 

3A. Advanced Operation
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Too
ges 

rch 
region. 

lDisplayMode List NoDisplay / 
DisplaySearch 

DisplaySearch illustrates all of the ed
that were located within the sea

4. Inspection Settings

InspectType List NONE (reserved for 
future use) 

InspectLabel List
PASS_AND_FAIL / 

PASS / FAIL / 

NONE / 

VALUE_REAL / 
VALUE_INTEGER 

InspectMax Single   
Insp Single   ectMin
InspectActual Single  
Insp Pass / Fail

es.Standard Inspection Settings properti

ectPassed List
5. Results Settings
OffsetAngle Single degrees 
OffsetX Single mm 
OffsetY Single mm 
ResultOnNotFound Boolean TRUE / FALSE

Sho LINE / POINT 

perties

wResults List NONE / FRAME / 

Standard Results Settings pro

6. Results
ResultErrorCode Integer   
ResultAngle Single -360 to 360
ResultXPos Single mm
ResultYPos Single mm

Standard Results properties

Remarks 

ary of 

This tool is useful for locating the closest position between a part's boundary and a 
 

 

This tool searches a region of interest for the edge point that is closest to the line that 
defines the start of the rectangular search region.  The distance between the edge point 
and the line is measured along the perpendicular to the starting line that passes through 
the point.  The direction of search is indicated by two arrows that mark the bound
the search region. 

reference line.  This tool is very convenient if the boundary is not a smooth curve or has
points of interest such as corners or cusps. 

Candidate edge points are located using the same method as the sub-pixel mode of the
Edge Locator.  So, the XY position of the located edge point is computed with sub-pixel 
accuracy along the direction of search and to within a pixel perpendicular to the direction 
of the search.  The position of the returned point can be used in combination with other
tools to establish the position or thickness of an object. 

 

Special Feature Buttons (located above the property editor) 
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Adjust Threshold

Pressing this button displays a pop-up window that permits the value of 
the Threshold property to be manually adjusted while dynamically 

ng in the Camera Display.  The display 
indicates the edges that satisfy the threshold criterion in white. 

Exampl

In the fo e point of the black object that is closest 
to the reference line that defines the start of the rectangular search region.  The search is 
perf
a corne

viewing the effect of the new setti

es 

llowing example, this tool locates the edg

ormed in the direction indicated by the tool's arrows.  In this case, the closest edge is 
r point. 

 

See Also 

Vision Toolkit | Edge Locator
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Finder      Tool 

Most powerful vision tool that identifies 
randomly placed parts in a camera image 
and returns their position, orientation and 
scaling to within sub-pixel accuracy.  

Prerequisite

None 

Properties 

This too a trained object model ("template") to recognize objects.  To simplify 
the use of this tool, it has two Property Lists.  The "Template Settings" Property List 
controls template and its properties.  The "Runtime 
Settings" Property List defines how the template is applied to an image to locate 
obje e two lists. 

The ll
modified
is requir

s 

l employs 

 the automatic generation of the 

cts.  Special Feature buttons above the Property Lists switch between th

 fo owing describes the "Template Settings" Property List.  When a property is 
 that invalidates the template, the system automatically indicates that Re-training 
ed.  

Property Name Data 
Type Range  Description

1. Identity
Type String n/a Standard Identity properties
2. Placement/Size
Height Single 0 - AOI (mm) 
Width Single 0 - AOI (mm) 
XPos Single 0 - AOI (mm) 
YPos

Standard Placement / Size properties.  The 
X and Y values define the center of the 

d rectangular template and the Height an
Width define its dimensions. 

Single 0 - AOI (mm) 
3. Operation
Camera Integer 1 - 6 Standard Operation property

MinMaxAngle Integer 0 - 180  

This parameter defines the maximum 
amount that the template is permitted to 
rotate when it is locating objects.  Normally, 
this property is set to 180 degrees to detect 

a part parts in any orientation.  However, if 
can only rotate a limited amount relative to 
its taught orientation, reducing this value to 
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the smaller range of orientations will speed 
up processing. 

e type of 

ict 
 speeds 

m 
making unnecessary changes in orientation 
to grasp a part.  This property should be 
set as follows for common types of 
symmetries: 

By default, this property is set to 180 
degrees (any orientation). 

 
In addition, if the part has som
orientation symmetry (e.g. a circle or a 
square), this value should be set to restr
the range of orientations.  This
processing and prevents a robot fro

 
   Circle:  0 deg 
   Square: 45 deg 
   Rectangle: 90 deg 
   Equilateral triangle: 60 deg 
   Hexagon: 30 deg 
 

ScoreAutoSetMin List NO / YES / 
THIS_TIME_ONLY 

ScoreHiRes

When a template is compared against a 
ition 
h.  A Min Single 0 - 1 

region in a camera image, the "recogn
score" indicates how well the two matc
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ScoreLoResMin Single 0 - 1 

match and 
erfect match.  

 ScoreLoResMin 
s specify the minimum scores for 

a match to be considered good.  The 
sMin is utilized at the lowest 

image resolution to determine if a possible 
ndidate to be 

further analyzed at higher resolution 
levels.  The ScoreHiResMin specifies if a 
match at the full camera resolution is 
acceptable as a final, good match. 

 the 
ScoreHiResMin and ScoreLoResMin 
values are automatically set to computed 
conservative values when the template is 
trained.  If ScoreAutoSetMin is set to 

esMin 

 template 
 set to 

 the values 
of ScoreHiResMin and ScoreLoResMin 
can be manually adjusted after training is 
completed. 
 
In general, the ScoreLoResMin is set 
equal to or lower than ScoreHiResMin.  In 
fact, ScoreLoResMin can be set very low 
or even to 0.  Since the Finder sorts all of 
the candidate matches at the lowest 
resolution and pursues the best candidates 
first, setting ScoreLoResMin low just 
results in more candidates being pursued 
to the full resolution level.  If a specific 
number of parts is being located, having 
additional candidates is not a problem 

red 
if 

 set too 
low can result in excessive execution time.
 
On the other hand, the setting for 
ScoreHiResMin is very important in terms 
of the quality of the Finders results.  Only 
matches that exceed this value are 
returned by this tool.  Setting this property 
higher results in higher quality matches 
being returned at the risk of rejecting 
acceptable matches. 

value of 0 represents a total mis
a value of 1 represents a p
The ScoreHiResMin and
propertie

ScoreLoRe

match is a good enough ca

 
If ScoreAutoSetMin is set to YES,

THIS_TIME_ONLY, the ScoreHiR
and ScoreLoResMin values are only 
automatically set the next time the
is trained.  If ScoreAutoSetMin is
NO, these two properties are not 
automatically set.  In all cases,

since the finder will stop when the desi
number of parts are located.  However, 
an unknown number of parts is being 
searched for, having this property

Speed Integer 1 to 99  The Speed property controls how quickly 
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Spe

the tool executes at runtime versus how 
meticulously it attempts to find matches.  If 
this value is set to 1, the Finder executes 
more slowly but with the highest reliability.  
If it is set to 99, it executes at the fastest 
speed but may fail under non-ideal 
conditions.  
 

t is set to YES, the Speed 
 a conservative value 
balance of speed and 

AutoSet is set to 
THIS_TIME_ONLY, the Speed value is 
only automatically set the next time the 
template is trained.  If SpeedAutoSet is 
set to NO, the Speed is not automatically 
set.  In all cases, the Speed can be 
manually adjusted but will typically 
invalidate the template. 

edAutoSet List NO / YES / 
THIS_TIME_ONLY 

If SpeedAutoSe
is automatically set to
that achieves a good 
reliability.  If Speed

3A. Advanced Operation

Accuracy Integer 1 - 100  

This property controls the amount of effort 
and time that is spent on performing the 
final refinement of the location and 
orientation of a ma e.  Smaller 
values result in less accuracy but faster 
execution times.  Values above 10 provide 
higher ense 
of exec
increased, additional key match points will 
be automatically added to the template. By 

 property is set to 10. 

tched templat

sub-pixel accuracy at the exp
ution time.  As this value is 

default, this
Depth Integ 1er  - n As a significant speed optimization, at 
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DepthAutoSet Lis NO / YES
HIS_TIME_  

runtime r 
matche

ha tion.  
 le

of 2 sm
parame rch 
level to
 
During training, PreciseVision automatically 

b
feature rion and sets this 
property value.  After training, the Depth 
can be lowered to limit the number of 
reduced resolution levels considered.  This 
is bene essive 
and selects too many levels.  The number 
of levels does not affect the accuracy of the 
final results of the Finder since the last 
match is always performed at the full image 
resolution.  Higher levels will result in much 

s some 

epth 
is automatically set to the highest value 
that is appropriate for the template.  If 

 is 

s set 
to a 

t  / 
T ONLY

 the Finder initially searches fo
s to the template model in images 
ve been reduced in resolu
vel of reduced resolution is a factor 
aller in width and height.  This 
ter is the maximum pyramid sea
 use. 

that 
Each

comput
to use 

es the maximum number of levels 
ased upon the loss of distinctive 

s and other crite

ficial if the system is too aggr

fast execution times but may mis
possible matches.  
 
If DepthAutoSet is set to YES, the D

DepthAutoSet is set to 
THIS_TIME_ONLY, the Depth value
only automatically set the next time the 
template is trained.  If DepthAutoSet i
to NO, the Depth can be manually set 
lower value. 

GainLimit Single   To enhance robustness, each time the 
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OffsetLimit Integer  0 -  n 

template is compared to a region of a 
camera image by the Finder Tool, the 
comparison is automatically normalized to 
eliminate differences due to the overall 
brightness of the image.  In particular, each 
pixel value is effectively adjusted as 
follows: 
 
   New_value = Gain*image_pixel + Offset

cess is controlled by 
s: 

 
GainLimit restricts the range of the Gain 
value.  If non-zero, the "Gain" will be 
restricted to fall between 1/GainLimit and 
GainLimit.   By default, this property is set 
to 4. 
 
OffsetLimit restricts the amount by which 
the overall brightness is adjusted up or 
down, i.e. this property specifies the 
maximum absolute value of the "Offset".  
By default, this pro  64. 

 
This normalization pro
the following propertie

perty is set to
MaxScale S 0.8 to 1.2 ingle

MinScale Single 0.8 to 1.2 

These properties can be set to locate parts 
that have a variable scaling (size).  This 
can occur if the part can be at different 
distanc ll in 
acceptable focus.  Allowing scaling 
variations can be very useful, but it does 

quire additional execution time.  By 
efault, these values are set to 1.0, which 

indicates no scaling is permitted. 

es from the camera while sti

re
d

The following list is ed when  Runti
ssed.  The roperties co ntime e

atching operation

 display the "Switch to me Settings" Special Features 
xecution of the template Button is pre

m
se p

. 
ntrol the ru

Property Name Data 
Type Range  Description

1. Identity
Name String n/a 
Type String n/a

Standard Identity properties

2. Placement/Size
Angle Single -360 to 360 
Height Single 0 - AOI (mm) 
Width Single 0 - AOI (mm) 
XPos Single 0 - AOI (mm) 
YPos Single 0 - AOI (mm) 
RelAngle Single -360 to 360 

Standard Placement / Size 
properties.  The X and Y values 
define the center of the rectangular
search region and the Height and 
Width define its dimensions. 
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RelXPos Single 0 - AOI (mm) 
RelYPos Single 0 - AOI (mm) 

 

3. Operation
Camera Integer 1 - 6 
Relative-ToolName List n/a 

Standard Operation properties

PrecentClipped Integer 0 - 50 

 Normally, this 

ot 
 where the 

r of the template is closer 

undary of the search 

 

in proportion to 
the value of this property.   Also, 

ScoreLoResMin should be 
reduced.   By default, this property 
is set to 0. 

This property allows parts to be 
recognized even if the matching 
template area is partially outside of 
the search region. 
property is set to 0 and the Finder 
only searches for X/Y template 
center positions that have the 
template fully within the search 
area.  In this case, this tool will n
return a match position
cente
than 1/2 the template's width or 
height to a bo
region.  If the PercentClipped is 
set to 50%, all template center 
positions within the search area will 
be considered.  As this property 
value is increased, the recognition
match score that is compared to 
ScoreHiResMin and 
ScoreLoResMin will be reduced 
somewhat, but not 

this property only applies to 
template matches that protrude 
beyond the search space and does 
not deal with occlusion due to 
overlapping parts.  To allow for 
overlapping parts, the 
ScoreHiResMin and 

ReTrain Boolean True / False  

gnition 
r the Finder has become 

corrupted or invalid for any reason, 
this property can be set to True.  
When set, the original image that 
was used to train the Finder is 

 

If you suspect that the reco
strategy fo

automatically reloaded into the 
camera image buffer and the
Finder is re-trained. This property 
can be manually or remotely set to 
True.  

3A. Advanced Operation

MaxFinds Integer -1 or 1 to n This property is only valid if the 
Finder is called multiple times by a 
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repeat tool such as a Fixed
which is set to execute in a 
pattern.  This property limits the

 Frame, 

 
number of matches found each 
time that the same Finder is 

ol.  It is 
esults, 

er 
of matches found for the entire 
image. 

 if MaxFinds is set to 
Fixed Frame executes the 

adrants of an image, 
ches will be found in 

each quadrant.  On the other hand, 
if MaxR  2, after a 
total of  is found in any 
quadrants, the Finder will return no 
further uent 
quadra
 
A value of -1 indicates that a 
unlimited number of matches 
should 

executed by a repeat to
similar in operation to MaxR
but MaxResults limits the numb

 
For example,
2 and a 
Finder in 4 qu
at most 2 mat

esults is set to
2 matches

matches in any subseq
nts. 

be found. 

MaxRecognition
Time S   

Limits the total time the tool will 
execute is can 
be help ing 
for a sp cts 
(such a the expected 
objects may or may not be 
presen  property 
will stop efore it 
exhaustively tests all possibilities. 
 
Howev o 
low, it c  
results 
comple  and 
verifica
 
Normally, this parameter is set to 
its defa  sec). 

 ingle

, in milliseconds.  Th
ful if the Finder is look
ecific number of obje
s 1) but 

t.  In this case, this
 the Finder b

er, if this value is set to
an generate incorrect
due to the Finder not 
ting its full analysis
tion process. 

ult value of 10000 (10
4. Inspection Settings

InspectType List
NE / RESULT_ANGLE 

CORE / 
SULT_ID 

NO
/ RESULT_S

RE

InspectLabel List
NONE / PASS_AND_FAIL 

SS / FAIL / 
REAL / 

NTEGER 

/ PA
VALUE_

VALUE_I
InspectMax S   ingle
InspectMin S

Standard Inspection Settings 
propert

ingle   

ies
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InspectActual Single  
InspectPassed List Pass / Fail

 

5. Results Settings
MaxResults In or 1 to n teger -1 
OffsetAngle Single degrees 
OffsetX Single mm 
OffsetY Single mm 
ResultOnNotFound Bo  FALSEolean TRUE /
ResultSelect In n teger 1 - 

ShowResults

Standard Results Settings 
properties.  MaxResults d

ber of matches to

l will execute mo
wn number of match
 and this property is 

efines 
the num  find each 
time that this tool is executed.   
This too re quickly 
if a kno es are 
located set 
accordingly.  This is due to the fact 
that execution terminates as soon 
as the expected number of 
successful matches is found.  Until 
all expected matches are found, 
this too
exhaustively test all possible 
matche erty 
is set to matching.  

l will continue to 

s.  By default, this prop
 -1, exhaustive 

List NONE / FRAME / LINE / 
POINT 

ShowResult-
TemplateGraphics Bo ALSE 

If TRUE, each matched part in the 
Camera Display is overlaid with 
dots tha ion of the 
key fea
Templa or the 
object f is 
permits atched 
part to  with 
the key features of the Template.  
The yellow dots indicate the 
primary pixels that should match 
prominent features of the full 
resolution image.  

olean TRUE / F

t indicate the posit
tures of the Finder 
te that are utilized f
inding process.  Th
 the alignment of a m
be visually compared

ShowResul
ore Boolean TRUE / FALSE 

If TRUE, each matched part in the 
rlaid with its 
 score" that 
 template 

rt.  A value 
ismatch 

presents a 
perfect match.  Accepted scores 
will all be greater than or equal to 
the ScoreHiResMin property value 
for the associated template. 
Especially for scenes with multiple 
instances of the same type of part, 
this feature is very useful for tuning 
the ScoreHiResMin value to 
correctly locate only valid parts.  

t-

Camera Display is ove
numerical "recognition
indicates how well the
matched the located pa
of 0 represents a total m
and a value of 1 re

TemplateSc

6. Results
ResultCount Integer 0 - n 
ResultErrorCode Integer   
ResultAngle Single -360 to 360

Standard Results properties
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ResultXPos Single mm
ResultYPos Single mm

 

Res

If a single Finder is executed 
multiple times within a Vision 
Process, this property identifies the 
instance of the Finder that 

sult.   

n a 
ol has an index 

that steps a Finder around in a 
pattern.  In this case, this property 
indicates the step in which each 
result was generated. 
[GPL:VisResult.Info(4)]

ultObjectID Integer 1 - n  

produced each re
 
This is particularly useful wh
Fixed Frame To

e

  

ResultR
Time

ecognition- Single  msec

Total time required for the last 
execution of this tool in 
milliseconds. [GPL: 
VisResult.Info(3)]  

ResultScaleX Single   

ResultScaleY   

These values ind d Y 
scale factors that were 
when matching the template to the 
camera image.  If scaling was not 
enabled, t  equal 
to 1. [GPL .Info(1), 

Single

icate the X an
computed 

hese values will be
: VisResult

VisResult.Info(2)]  

ResultScore Single 0 - 1 

This is the at 
indicates how well the template 
matched t d part.  A value 
of 0 repre
and a valu
perfect ma
will all be o 
the Score  
for the ass : 

 "recognition score" th

he locate
sents a total mismatch 
e of 1 represents a 
tch.  Accepted scores 

greater than or equal t
HiResMin property value
ociated template. [GPL

VisResult.Info(0)]  

Remarks 

The Finder is the most powerful tool in the toolkit and provides the m
for identifying and locating parts in grayscale images.  It can locate ra
with both simple and complex shapes and will return their part type, p
and scale.  There are other tools in the toolkit that are appropriate fo
situations such as binary images or non-rotated parts.  Also, for som
constrained cases, it is relatively easy to combine Line Fitters and o
parts.  However, the Finder can handle the widest range of parts and
very simple one-shot teaching method, and returns accurate sub-pix

To address applications like locating a secondary object within a prim
Finder can be placed relative to the results of any other tool includin
The one restriction is that the Finder search window is always orthog ith the 

me of refer  (although the match bjects can be in a

ost general method 
ndomly placed parts 
osition, orientation 

r specialized 
e simplified or 
ther tools to locate 
 situations, has a 

el results. 

ary object, the 
g another Finder.  
onal w

camera fra ence ed o ny orientation).  
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Typical uses for this tool include: finding fiducial marks on a printed c
parts randomly placed and oriented on a conveyor belt and refining t
orientation of sample trays. 

mplates an aining Mode

ircuit board, locating 
he position and 

Finder Te d Tr  

The Finder operates in one of two modes:  "Training" or "Finding".  T
teaches the system the visual features of a part and stores the information in a 

el.  Finding mode searches the camera image for regions of the 
e match for the Template. 

When a Finder tool is first created, it is automatically placed into Tra
"Template Settings" Property List is presen list displays th
position of the Template and other pro ic to the 

.g. paramete  part symm ariation
above this property list are Special Fea  in teachi
template. 

To create a Template, a single image of the part must be trained.  The traini
consists of bounding the part plus some of the adjacent background 

raining mode 

"Template" object mod
image that are a suitabl

ining mode and the 
e size and the 
type of part being 
s, etc.  Presented 

ng and adjusting the 

ng process 

ted.  This 
perties that are specif
etries, expected scale v
ture buttons that aid

taught, e rs for

with a red "Template 
rectangle".  This red rectangle defines the size and contents of the T
PreciseVision subsequently searches an image and reports the posit
of a matched part, it is actually stating the position of the center of th

und a ount by whi was rotated

During the training process, a yellow "Training rectangle"

emplate.  When 
ion and orientation 
e Template when the 
. match was fo nd the am ch the Template 

 must also b
the Template.  This yellow rectangle is used to teach the system how
Template from other objects or background clutter that might be enco

clutter are expected to be present, the sys
ll copy of the desired target part plus any different objects and clutter 

are enclosed by the yellow rectangle.  In gen arger the yellow rectangle, the 

e positioned around 
 to distinguish the 
untered at runtime. 
tem will work best if If different types of parts or 

one and only one fu
eral, the l

better the Finder will operate since th  more positions and is allows the Finder to try
orientations for the template as it opti ters.mizes its search parame   Please note that since 
PreciseVision is a 2D vision system, tes) o
produce different 2D images are cons

The following picture illustrates how ld be positioned to teach 
the Finder how to locate one orien  a se

 different poses (stable sta
idered different parts. 

 the training rectangles shou
tation of a part while ignoring

f the same part that 

cond stable state. 
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If two or more types of parts are to be identified and located in the sa
Finders and their Templates should be trained and included in the V

 Template a ctangles have been properly posit
can be taught by pressing the "Training Required" special feature b
the Template Properties list.  To simplify the training and setup proce  
a new Finder, a wizard is automatically displayed that walks you thro  
steps.  Using this wizard, performing the training and setting up the k
is extremely simple.  

e Templa re subsequently modified that inva
the system will automatically indicate that the Template must be train
simplify retraining, the system always stores the image that was utiliz

evious image can be easily recalled using one of the Special Feature 

er Search hm

me image, multiple 
ision Process.  

ioned, the After the nd Training re Finder 
utton located above 
ss, when you create
ugh the training
ey Finder properties 

lidate the Template, 
ed again.  To 
ed during the prior 

If any of th te properties a

training.  This pr
buttons.  

The Find Algorit

After a Template ha ol can xecuted in Find 
nate "Runtime P s" list can be displ using the Specia

pe resents the  of a green

s been trained, the to  be e mode and the 
l Feature buttons.  
 "Search rectangle".

alter ropertie ayed 
The Runtime Pro rties list p  size and position   

arch for matches to 
at control the 
tted, etc.  In the 
aught Template 

This recta
the Temp

ngle defin mera image area that the Finder will se
late.  The property list also contains parameters th

. the numb  parts mi
ay Windo  "t

es the ca
Runtime 

search, e.g
Camera Displ

er of
w, the gre

 to find, the amount of clipping per
en Search rectangle and the blue

rectangle" will be displayed. 

t of the Fin l is a patented at combines a h 
 with the ro ss of normalize  to match the

n the searc .  This intelligent se  technique avoid
requirements of applying correlation to a multi-dimensional search th es 
concurrent changes in position, orientation and scale.  Also, this tech

 the proble untered with corre ptimization me
mportant benefits of a norma

match. 

e most search methods, this tool employs reduced resolution images for the initial 
rch steps in order to quickly identify candidate positions.  This method is often called 

w 

 
  
 

ore when tested at the full camera resolution.  When the 
system finds the requested number of successful results or all of the candidate locations 

The hear
technique

der Too
bustne

 algorithm th
d correlation

n intelligent searc
 Template with 
s the computational 
at accommodat
nique does not 
thods such as 
lized correlation 

regions i h region arch

introduce
skipping pixels, while 

ms enco
still retaining the i

lation o

Lik
sea
a pyramid search since each successive search level has half as many pixels in each ro
and column.  During the training process, this tool automatically computes the 
recommended number of levels that can be utilized while still retaining sufficient 
distinctive features to differentiate the target object from the background and other 
objects. 

At each position where the template (or a reduced resolution template) is compared to 
the image (or a reduced resolution image), a normalized comparison operation produces 
a "recognition match score".  This score ranges from 0, which indicates no match, to 1, 
which indicates a perfect match.  At the reduced resolutions, all of the locations whose
score exceeds a minimum value are retained and ordered according to their score value.
The tool then pursues these candidate locations and validates whether the locations also
satisfies a minimum match sc

have been exhausted, execution is terminated.  
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As a final step, if the Inspection Setting has been defined, each of the successful results 
will be tested against the Inspection criteria and will be tagged as to whether it "Passes" 
or "Fails". 

Optimizing The Finder And Templates

The following are a number of guidelines for optimizing the performance of the
and 

 Finder 

 other 
parts of objects.  

• In general, the Template rectangle should be larger than the target object.  It is 

Finder Templates.  

Template (Red) Rectangle Guidelines 

• The Template should fully enclose the target object and should contain no
objects or 

best to have a boundary of at least 16 camera pixels all around the target object 
(more pixels are better than fewer pixels).  For a 640x480 camera, 16 pixels is 
1/30th of the full height of the camera image.  This permits the system to capture 
the edges between the object and the background.  This is especially important if 
the object does not have many internal features. 

 

• If the background varies significantly (e.g., there is dirt and paint blotches on a 
conveyor belt), then the part should be placed on a uniform, neutral background 
to teach the Template. 

• The target object should be oriented in the camera image in what you want to 
define as ‘Zero’ degrees.  That is, when the Finder later locates a part is in the 
trained orientation, it will return an orientation angle of 0 degrees. 

Training (Yellow) Rectangle Guidelines 

• The Training rectangle must be larger than the Template and must fully enclose 
the Template. 

• The Training rectangle should include one and only one full image of the target 
object.  Since the Finder uses the contents of the Training rectangle to determine 
distinguishing features of the Template, a second complete copy of the Template 
will confuse the system and will generate an error.  It is acceptable to have 
additional partial images of the target object in the Training rectangle so long as 
each is less than 50% of the target object (see picture above in the Template 
discussion for an example).  
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• This rectangle should include any other objects or clutter that are expected to be 
encountered during runtime to aid the system in learning to distinguish between 
the target object and its surroundings.  

• This rectangle should be as large as possible without violating the rules above.  
A larger regio its the system to test more positions and orientations for the 

te dur  trainin nd assists in optimiz e search 
strategy. 

Finder Prop

c, e.g. a circle, a square, a rectangle, set the 
inMaxAngle property to limit the rotation of the results.   

If the target object cannot be rotated into cing the 

n perm
ing theTempla g phase a ing the runtim

erties 

• If your part is symmetri
M

•  any arbitrary orientation, redu
MinMaxAngle search range to less than the default value of +/-180 degrees will 
significantly reduce the execution time of this tool. 

yond the search window, set the • If any portion  part migh nd be
PrecentClipped property appropriately. 

System and Camera S

 trainin exec
relationship.  Failure to do s sult 

of the t exte

etup 

uting this tool, ca
o may re

• Prior to g or librate the camera's pixel to millimeter 
in parts not being located.  This is due t
square pixels, i.e. 

o 
the fact that some cameras do not have their X and Y scaling 

erent.  If this difference in scaling is not accounted for properly, as 
ed, their shape will be distorted and their size will be incorrect.  

• Larger target objects (and therefore large
all fo

search space is comparable to finding a 
e more image features; larger templates usually can be found with 
racy particularly in orientation

features c  searc ller 
the search. 

timal Tar jects 

• Target objects that contain corners that f ree angle result in more 
recognitions and higher accuracy. 

factors are diff
parts are rotat

r templates) generally perform better 
: finding a very small template in a large 
needle in a haystack; larger templates 

than sm templates r various reasons

usually hav
r accuhighe

big 
; and larger templates containing some 
search pyramids thereby accelerating an be hed using ta

Op get Ob

orm a 90-deg
reliable 
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• Sharp features in focus p acc

pl an di
irection, m cations ve gre

perpendicular to the majority of the edge
and "B" contain many vertical edges so b n 
the horizontal direction.  But template "A
compared to "B", so along the vertical dir

uracy than pla

rovide more urate results than smooth or blurred 

rection but only a few in the orthogonal 
ater accuracy in the direction 

s.   In the figures below, templates "A" 
oth can be located with high accuracy i

" has very few horizontal edges 
ection, "B" will be found with higher 

features. 
• If the tem ate has m y edges in one 

d atched lo will ha

acc  tem te "A". 

 

• A wide dynamic range of brightness in th
results than an image with a narrow rang

n is lost when pixels are clippe
e.  

• Fine details in the image enhance the ov
calculations, but large features enhance   Large features 
enable use of taller search pyramids. 

Template Mask 

the 

Special Feature Buttons (located above the property editor) 

 is 

utton.  This greatly simplifies retraining 
ct of altering various Template 

e template provides more accurate 
e.  However, avoid saturation.  Image 
d at the two ends of the brightness 

erall accuracy of the position 
the speed of search.

informatio
rang

• If the part contains features that are known to be variable from one image to 
next, the unwanted features can be ignored by masking them out of the 
template.  The masking operation is similar to using a simple painting tool to 
indicate regions to be ignored in the template.  

• To define a Template mask, force the system into Training mode, right click in 
the camera display window or in the Vision Tool Definition window and select 
Finder > Edit Template.  

Execute

Executes the Finder search algorithm once in the current camera image 
buffer.  

Load Original Image 

Each time a Template is trained, the image used for the training
automatically stored by the system.  This button reloads the previous 
training image into the camera b
the template if you wish to see the affe
properties.  
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Reset Template Defaults / Undo Changes 

y 

Show T

Pops up a window that displays the Template that has been trained.  The 
pixels in the Template that represent key features to be located are 
highlighted in yellow.  If the Template includes a mask for ignoring 

Switch 

Trainin

Examples 

In the fo
Since th nd one 
complet  (each less than 50% of the full object) are 
included in order to enlarge the Training rectangle.  Also, for a reasonable template 
bounda r than 
the part
position

Either resets the Template Property values to their default values, which 
were established when the Template was trained, or undoes any recentl
changes to the property values.  

emplate 

unwanted areas, the mask is displayed in red.  

to Template Settings / Switch to Runtime Settings 

Switches between the Template Settings and the Runtime Settings 
Property lists.  

g Required 

Indicates that the Template for the Finder is not valid.  Pressing this 
button will train the Template.  

llowing example, a Finder Template is trained on one of six identical parts.  
e parts are all the same, the yellow Training rectangle is only placed arou
e part although other partial parts

ry and for an intuitive orientation angle, the horizontal part is trained rathe
s at a skewed angle.  After the Training and the Template rectangles are 
ed, the Train icon can be pressed. 

 

For this simple part, training completes in approximately one second after which the tool 
ce.  At the 

conclusion of the search, all six parts will be identified and each of the part's position and 
orientation will be indicated by yellow coordinate axes as illustrated in the following 
picture.  

is automatically placed into Find mode and the search operation is executed on
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See Also 

Vision Toolkit | Connectivity 
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Fixed Frame Tool 

Computational tool that places a reference frame at a fixed image 
coordinate or at a constant offset relative to another vision object.  Can 
optionally index the frame in an X and/or Y grid pattern to repeatedly 
execute any linked tools.  

Prerequi

None 

Properties 

sites 

Property Name Data 
Type Range  Description

1. Identity
Name String n/a 
Type String n/a

Standard Identity properties

2. Placement/Size
Angle Single -360 to 360 
XPos Single 0 - AOI (mm) 
YPos Single 0 - AOI (mm) 
RelAngle Single -360 to 360 
RelXPos Single 0 - AOI (mm) 
RelYPos Single 0 - AOI (mm) 

Standard Placement / Size 
properties.  The X and Y values 

e origin of the referenc
d the Angle specifies it

define th e 
frame an s 
rotation. 

3. Operation
Camera Integer 1 - 6 
Relative-ToolName List n/a 

Standard Operation properties

3A. Advanced Operation
FramePatternXIndex Integer 1 - n  
FramePatternYIndex Integer 1 - n  
FramePatternXPitch Single mm 

FramePatternYPitch Single mm 

If the X a
greater th
Fixed Fra
pattern th  
steps by 
values.  T
tools to b
repeated
pattern.  

nd/or Y index values are 
an 1, the position of the 
me is indexed in a grid 
e number of X and/or Y
the appropriate Pitch 
his permits any linked 
e automatically and 
ly executed in a grid 

TargetDisplaySize Single  0 - n  Optionally draws an overlaid 
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TargetDisplayType List NONE / SQUARE / 
CIRCLE 

graphics 
position a  
Frame. T
highlighti cific region in the 
image.  T
diameter
shape in 

shape relative to the 
nd orientation of the Fixed
his is useful for 
ng a spe
he "size" defines the 
 or edge length of the 
calibrated units.  

5. Results Settings

ShowResults List NONE / FRAME / LINE / 
POIN

The fram
represen
line or a T 

e can be graphically 
ted as a coordinate frame, 
point. 

6. Results
ResultAngle Single -360 to 360
ResultXPos Single mm
ResultYPos Single mm

Standard Results properties

Remarks 

A Fixed Frame can be used in several different ways.  It can be def
ct with a fixed position and an r offset.  This i

 of e Results Settings of most tools and ha
allowing the offset to be graphically specified by dragging the Fixed
window. 

Alternately, a Fixed Frame can be placed in an image at a specified
orientation and can then serve as a datum from which other measu

Lastly, if the Pattern properties are utilized, a Fixed Frame can be a
about an X and/or Y grid pattern.  This has the benefit of repeatedly
linked to (i.e. defined Relative-to) the Fixed Frame in a grid pattern.

Examples 

Below is an example of a Finder that returns a frame that is at the c
Fixed Frame is placed relative to the finder and used to effectively r

ference.  Additional vision tools can n  placed relati
advantag s is that if the Finder template is

be placed in exactly the same position and orientation relative to the
Frame can then be adjusted to account for any difference in the Fin
orientation.  By using this relative reference frame, we can easily en
subsequent tools will maintain their positional relationship with resp
the part. 

ined relative to 
s an alternative to 
s the advantage of 

 Frame in the vision 

 position and 
rements are made. 

another vision obje
directly setting an

gula
fset in th

utomatically indexed 
 executing any tools 
  

enter of the part.  A 
e-define the part's 
ve to the Fixed 
 re-trained it may not 
 part.  The Fixed 

der position and 
sure that all 

ect to key features of 

frame of re
Frame.  The 

ow be
e of doing thi
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See Also 

Vision Toolkit | Line-Line Frame Tool | Point-Line Frame Tool | Point-Point Line Tool 
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Image Process Tool 

Vision tool that performs image filtering, edge extraction, thresholding 
and morphological operations on a specified area in the camera image. 

Prerequisites 

None 

Properties 

Property Name Data 
Type Range  Description

1. Identity
Name String n/a 
Type String n/a

Standard Identity properties

2. Placement/Size
Angle Single 0 (non-rotating) 
Height Single 0 - AOI (mm) 
Width Single 0 - AOI (mm) 
XPos Single 0 - AOI (mm) 
YPo  s Single 0 - AOI (mm)
RelAngle Single 0 
RelXPos Single 0 - AOI (mm) 
RelY

Standard Placement / Size 
properties.  The X and Y values 

o be 
processed.  The Height and Width 
define the dimensions of the 
region.  

define the center of the region t

Pos Single 0 - AOI (mm) 
3. Operation
Camera Integer 1 - 6 
Rela
Too

tive-
lName List n/a 

Standard Operation properties

Inve
eter is 
alues 

 will be 
 the 

rtBinary Boolean  TRUE / FALSE  

ProcessModes, if this param
True, after the binary pixels v
are extracted, their values
inverted before the remainder of
processing is performed. 

(BINARY) For BINARY_* 

Iteration Integer 1 - n Specifies the number of times that 
the ProcessMode should be 
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applied to the area of interest.   This 
is often used to repeatedly execute 
the morphological operations. 

ProcessMode LIST  CONV_* / BINARY_*  

ng 
 the 

 These 
are destructive operations that alter 
the contents of the camera buffer so 
that all subsequent tools operate on 

tion 
of each of the supported operations.

Specifies the image processi
operation to be performed on
selected area-of-interest. 

the modified data. 
 
See the Remarks for an illustra

Threshold Integer 0 - 254 

(BINARY_*) This is the value used 
to convert gray scale values into 
black and white pixels. 
 
(CONV_*)  This value is not utilized.
 
(EDGE_*) Specifies the threshold 
below which weak (low contrast) 
gradient edges are ignored.  The 
lower this property is set, the more 
sensitive the system is in locating 
edges.  Please see the description 
of the Edge Locator for more 
information on edge gradients.  The 
default value is 30. 

3A. Advanced Operation

ConvolutionSize List SIZE_3X3 / SIZE_5X5  

Specifies whether the convolution 
kernel is a 3x3 or a 5x5 matrix.  The 
size of the kernel determines how 
many neighboring pixels are 
consider in the computation of each 
new pixel value.  

5. Results Settings
OffsetAngle Single degrees 
OffsetX Single mm 
OffsetY Single mm 

ShowResults List NONE / FRAME / 
LINE / POINT 

Standard Results Settings 
properties

6. Results
ResultErrorCode Integer   
ResultAngle Single 0 (non-rotating)
ResultXPos Single mm
ResultYPos Single mm

Standard Results properties 
 
X and Y position for the centroid of 
the processed area-of-interest. 

Remarks 
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This tool performs an image filtering, edge extraction, thresholding or morphological 
operation on a specified area in the camera image.  For example, an operator can be 
applied to smooth a region to eliminate noise due to poor lighting.  Conversely, the image 
can be sharpened to highlight features. 

yze the data in the camera image and leave the data 
unmodified, these operators all alter the raw data in the image buffer.  All subsequent 
vision tools will operate on the modified image data and not the raw information captured 
by the camera. 

l properties must 

While most vision tools anal

If you wish to revert back to the original raw captured image data, specia
be set in the Acquisition Tool at the time that the picture is first taken. 

The following table illustrates each of the image processing operations. 

 

CONV_FILTER_ 

bias for edges that 
slope down from the 
left. 

EDGE_DL 
 
Extracts edges with a 

Raw, unprocessed 
camera image. 

CONV_FILTER_ 
E_DR 

acts edges with 
a bias for edges that 

e down from
.  

CONV_FILTER_ 
ED
 
Extracts edges with 
a bias for horizontal 

EDG
 
Extr

slop
right

 the 

GE_H 

edges. 

CONV_FILTER_ 
GAUSSIAN 

 operator.  

CONV_FILTER_ 
E_V 

cts ed
s for ve
s. 

EDG
 
Extra ges with 
a bia
edge

rtical 

 
Reduces image 
noise by blurring the 
region.  This is a 
smoothing

CONV_FILTER_ 
LAPLACIAN_ 
GAUSSIAN 
 
Extracts edges after 
smoothing with a 
Gaussian to reduce 
noise.  

CONV_FILTER_ 
LAPLACIAN 
 
Extracts edges 

ator. 
using a Lapl
oper

acian 

 smoo

CONV_FILTER_ 
LOWPASS 
 
Reduces image 
noise by eliminating 
high frequency 
changes. This is a 

thing operator. 

CONV_FILTER_ 
LOWPASS_H 
 
Reduces image 
noise by eliminating 
high frequency 
changes but only in 
the horizontal 
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direction. This is a 
1D smoothing 
operator. 

CONV_FILTER_ 
LOWPASS_V 
 

ces im

high frequency 
changes but only in 
the vertical direction. 
This is a 1D 
smoothing operator. 

 

CONV_FILTER_ 
SHARP 
 
Accentuates or 
enhances edges in 
the image. 

Redu
noise by eliminating 

age 

 bla

EDGE_THRE
 

SH 

Computes each 
pixel's edge strength 
and sets all strong 
edges to white and 
all weak e

ck. 
dges to 

BINARY_THRESH 
 
Converts all pixels to 
white or black. 

BINARY_DILATE 
 
Binary thresholds 

s 
of pixels. 

 
of pi

BINARY_ERODE 

sh
egion an
ks white gr

xels. 

 
Binary thre
the r

olds 
d 

shrin oups 
the region and 
grows white group

Special F (loc p

just Threshold

_* mode, the edge pixels are extracted and displayed in 
white. 

See Als

Vision 

eature Buttons ated above the pro erty editor) 

Ad

Pressing this button displays a pop-up window that permits the value of 
the Threshold property to be easily adjusted while dynamically viewing 
the effect of the new setting in the Camera Display.  In a BINARY_* 
mode, the displayed image shows all pixels converted to black or white.  
In an EDGE

o 

Toolkit | Acquisition Tool
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Inspect Frame Tool 
Inspection tool that pa
referenced tool and op

sses through the XPos, YPos and Angle Results of a 
tionally rotates and shifts the Results based upon an 

inspection.  The inspec lts of 
two othe
mathem

  

Prerequisites 

FrameSource must be defined

tion can consist of the arithmetic combination of the Resu
r tools.  So, this tool also provides a means for performing simple 
atical operations on the results of two tools. 

 for this tool to execute. 

Properties 

Property Name Data 
Type Range  Description

1. Identity
Nam String n/a e
Typ n/a

Standard Identity 
e String properties

3. Operation

Cam 1 - 6 Standard Operation era Integer property

App List OFFSET_ON_PASS / 
OFFSET_ON_FAIL / 
OFFSET_ALWAYS 

The nominal Results of 
this tool are equal to the 
Results of the specified 
FrameSource.  This 

pecifies when 
X, OffsetY, 

ffsetAngle are 
added to the nominal 
Results.   For example, 
this tool can rotate the 
orientation of the output 
of the FrameSource by 
180 degrees based upon 
the pass/fail outcome of 
a specified inspection 
operation. 

NONE / 
the O
and O

property s
ffset

lyFrameOffset

Fram List n/a 

Name of the required

eSource

 
tool whose 
ResultsXPos, YPos and 
Angle are taken as the 
nominal Results of this 
tool. 

Insp List n/a If ectTool1 the InspectType
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InspectTool2 List n/a 

specifies an arithmetic 
computation that 
operates on the Results 
of two tools, these two 
optional properties 
specify the tools that are 
the sources for the 
Results. 

3A. Advanced Operation

SortResults List

NONE / 
SORTFROMLEFT / 

SORTFROMRIGHT / 
SORTFROMTOP / 

SORTFROMBOTTOM 

If the FrameSource 
generates multiple 
Results, this property 
automatically sorts the 
Results as specified. 
This is useful for items 
on a conveyor belt that 
may need to be picked in 
order from the front to 
back. 

ZeroAngle Boolean TRUE / FALSE 

If True, will force the 
ResultAngle to ZERO. 
This is useful for 
randomly oriented parts 
that require the angle to 
be removed for picking. 
This operation does 
NOT change the sorting 
operation. 

4. Inspection Settings

InspectType List

NONE / 
INSP1_MINUS_INSP2 / 
INSP1_PLUS_INSP2 / 
INSPECTIONS_PASS / 
INSPECTIONS_FAIL / 

INSPECT_XY_DISTANCE / 
INSPECT_X1_MINUS_X2 / 
INSPECT_Y1_MINUS_Y2 / 
INSPECT_X1_PLUS_X2 / 
INSPECT_Y1_PLUS_Y2 / 
INSPECT_X1_MULT_X2 / 
INSPECT_Y2_MULT_Y2 / 
INSPECT_X1_DIV_X2 / 
INSPECT_Y1_DIV_Y2 / 

INSPECT_ANG1_MINUS_ANG2 / 
INSPECT_ANG1_PLUS_ANG2 / 
INSPECT_ANG1_DIV_ANG2 / 
INSPECT_ANG1_MULT_ANG2 

InspectMax Single   
InspectMin Single   
InspectActual Single  
InspectPassed List Pass / Fail

Standard Inspection 
Settings properties.  The 
InspectType can specify 
a simple arithmetic 
operation that is to be 
performed on the 
Results obtained from 
InspectTool1 and 
InspectTool2.  The 
InspectActual returns 
the result of the 
arithmetic operation and 
the InspectPassed is 
set according to whether 
the result falls within the 
specified Min and Max 
values. 
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InspectEval String   

Displays the arithmetic 
expression that is 
evaluated to compute 
the InspectActual 
results.  This expression 
is a function of the 
InspectType. 

Insp

Optional label that is 
displayed in the camera 

dow.  This provides a 
convenient way to 
display part ID or other 
information. 

ectString String n/a win

5. Results Settings
MaxResults Integer -1 or 1 to n 
OffsetAngle Single degrees 
Offs Single mm etX
OffsetY Single mm 
ResultOnNotFound Boolean TRUE / FALSE
ResultSelect 1 - n Integer

S NONE / FRAME / LINE / POINT 

Standard Results 
Settings properties.  The 
Offsets are conditionally 
added to the nominal 
ResultsXPos, YPos and 
Angle depending upon 
the setting of 
ApplyFrameOffset and 
the pass / fail status of 
the insphowResults List ection operation.

6. Results
ResultCount - n Integer 0 
ResultAngle -360 to 360Single
ResultXPos Single mm

ResultYPos Single mm

Standard Results 
properties.  The 
ResultsXPos, Ypos and 
Angle are equal to the 
Results of the 
FrameSource, 

, 
optionally adjusted by 
the OffsetX, OffsetY
OffsetAngle. 

R

tool passes th e ResultXP s, and ResultAngle from a 
enced FrameS ool and opt d rotates the Results based upon a 

test.  This function can be used to correct the position and/or the orientation of 
t based upon an additional inspection operation.  If the referenced tool produces 

tiple Results, the test and correction will be applied to each 

This tool can also be used to perform measurements between t
tools.  For example, the InspectType property can specify that 
XY positions of InspectTool1 and mpu
specified min/max values.   The te

f this tool.  This pass/fai ng
 input to other tools. 

For example, when a Connectiv nt
always ambiguous since this algorithm will return the same orie
if an object is rotated by 180 degrees.  If the Connectivity Tool

emarks 

This rough th os, ResultYPo
refer ource t ionally shifts an
pass/fail 
an objec
mul generated Result. 

he Results of two vision 
the distance between the 
ted and compared to 
rmines the pass/fail 
 of the Results or can be 

ation of its Result is 
ntation and position even 
 is specified as 

 InspectTool2 is to be co
 outcome of this inspection de
l value can trigger the offsetti

ity Tool is executed, the orie

status o
used as
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the FrameSource of an Inspect Frame Tool, a measurement o
object can be performed.  Based upon the measurement, the frame of refere
generated by the Connectivity Tool can be conditionally rotate

Examples 

Below is an example of a Inspect Frame Tool that alters the or
Connectivity Tool output based on the inspection of an Edge L
Locator Tool measures the width of the part (along the green l
picture on the right) by determining the distance between the fir
Depending upon whether the wide or narrow portion of the part 
Frame Tool conditionally applies an angular offset to rotate the
orientation angle. 

f a specific feature of the 
nce that is 

d to correct its orientation. 

ientation of a 
ocator Tool.  The Edge 

ine shown below in the 
st and last located edge.  
is detected, the Inspect 
 returned frame's 

     

See Also 

Vision Toolkit | Inspect List
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Inspect List Tool 
Inspection tool that passes through the XPos, YPos and Angle 
referenced tool and tests up to 12 different Results from multipl
the object is good or bad.  This tool provides a convenient way 
testing of a located object and generating an equivalent location
Pass/Fail indicator. 

Prerequisites 

e mus ed

Results of a 
e tools to determine if 
to perform complex   
 with a single 

FrameSourc t be defin  for this tool to execute. 

Properties 

Property Name Data 
Type Range  Description

1. Identity
Name String n/a 

n/a
Standard Identity properties

Type String
3. Operation
Camera Integer 1 - 6 Standard Operation property

FrameSource List n/a 

Name of the required tool whose Results 
nd Angle are passeXPos, YPos a d through 

as the position of the 
Inspect List to

 and orientation Results 
ol. 

InspectTool01-12 List
Note: Accessed 

using "Setup 
Inspection

button. 

List of vision t
to determine i
vision tools (i. iple 

sults. Such
multiple times
property value

 List" Re

ools whose Results are tested 
f the part passes or fails. Many 
e. connectivity) have mult
 tools can be referenced 
 to test different Results 
s. 

3A. Advanced Operation

ShowInspectTools Boolean TRUE / FALSE 
If True will display the tools defined in the 
Inspect List du ly 
the resulting o

ring execution, otherwise on
utput frame is displayed. 

4. Inspection Settings
InspectPassed List Pass / Fail Standard Inspection Settings properties.

InspectString String n/a 

ptional label  
ow relativ

orientation of this tool.  This provides a 
convenient wa
information. 

O
wind

 that is displayed in the vision
e to the position and 

y to display part ID or other 

5. Results Settings
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MaxResults Integer -1 or 1 to n 
ResultOnNotFound Boolean TRUE / FALSE
ResultSelect Integer 1 - n 

ShowResults List NONE / FRAME / 
LINE / POINT 

Standard Results Settings properties.  For 
esultOnNotFoundthis tool, the R  should 

normally be enabled on the Preferences > 
n page.  This property forces 
erate results even if their 

il.  This ensures that the 
as a consistent set of 
lts from all referenced tools.  I
 not enabled, it is possible fo
ls to past back

Tool Operatio
l tools to gen
spections fa

Inspect List h
complete resu f 
this property is r 
referenced too  a varying 
number of results depending which 
inspections pass and fail, with the result that 

pect List will be confused and will 
return an accurate good/bad indicator.  

al
in

the Ins
not 

6. Results
ResultCount Integer 0 - n 
ResultErrorCode erInteg   
ResultAngle Single -360 to 360
ResultXPos Single mm

e mm

esults propertiesStandard R .  The XPos, 
g
S

As a special case for this tool, GPL: 
VisResult.Info(0-11) are equal to the Pass(-
1) or Fail(0) results of InspectTool01-12. 
 

L: VisResult.Info(12-23) are equal to the 
actual values used for the pass/fail tests for 

tTool01-12. 

YPos and An
of the 

le Results are equal to those 
ourceFrame

 
. 

ResultYPos Singl GP

Inspec

R

lic  required s to determ
cuted directly in a 

cess.  However, if e Inspect List provides a 
onvenient method for executing up to 12 tests on the Results from multiple tools 

g a s s/Fail result that indicates if all of the tests are satisfied.  This 
imp prove the efficien  of a GPL program that accesses vision 

If the GPL  only needs  all tests pa
 return a si e instead of req  the GPL prog
ltiple tools. 

er conve e ResultXPos, ResultYPos and R
 to the Re cified FrameSource.  So, if F  

locates the position of an object, the output of the Inspect List f 
ct together gle Pass/Fail property that indicate
ns were s . 

ts tested by this tool can come from a single vision
rmits the Re m multiple measurement or inspecti

Alternately, for tools such as Connectivity that return many indep
tBlobArea, ResultMajorAxisLength, ResultMinorAxisLength, 

sultMaxRadiusAngle, etc.), multiple properties from the same tool can be tested to 
verify that the part is acceptable. 

Special

emarks 

Many vision app
le.  In these 

ations only
s, the vision i

 one or two test ine if a part is 
acceptab
Vision Pro

case nspection tools can be exe
many tests must be performed, th

very c
and generatin
tool can also s

ingle Pas
lify and im cy
 program to know that ssed, the Inspect List 

ram to read the results 
results.  
tool can ngle valu uiring
from mu

nience, th
sults of the spe

esultAngle of this tool are 
rameSource is a tool that
will provide the location o
s if up to 12 qualifying 

As a furth
set equal

the obje
inspectio

 with a sin
uccessful

The 12 Resul
This pe

 tool or multiple tools.  
on tools to be combined.  

endent properties (e.g. 
sults fro

Resul
Re

 Feature Buttons (located above the property editor) 
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Setup Inspection List

Since this tool has the ability to reference the Results properties from up 

accessed by pressing the "Setup Inspect List" button above the tool's 

to 12 other tools and each referenced tool can have properties that are 
specific to its tool type, a special pop-up dialog is provided to specify the 
12 possible tests.  The following is an example of this dialog page that is 

property list. 

 

Each tool to be accessed is selected using the pull-down combo box 
"Inspect Tool".  Once a tool is specified, the Results property to test is 
selected using the "Inspect Type".  All tools support the same base set of 
inspection types: ResultInspectPassed / ResultInspectFailed / 
ResultXPos / ResultYPos / ResultAngle.  Some tools also have 
special Results that can be tested.  Please see the "Info()" array of the 
selected vision tool for details as to its tool specific Results properties.   

In addition to returning a Pass/Fail inspection result, many tools can 
return various "warnings".  In most cases, warnings can be ignored and 
the tool's inspection result can be interpreted as "passed".  For example, 
the Line Fitter Tool returns a warning if some edge samples are missing 
even if the line fit is very accurate.  In other cases, you might wish to 
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treat warnings as "fail" conditions.  For example, if you are using a Pixel 
Window Tool for inspecting a part and the window is clipped, it might be 
important for you to consider this as a failure.  To control the treatment of 

 in.  The retrieved property values are displayed in the Actual fields 
and the values are color coded to indicate if they fall within the Min/Max 

m of this dialog panel, there are buttons to assist in setting up 
 the "Run List" button is pressed, all of the 

Examples 

Below is an example of a Inspect List tool that is used to locate and qualify multiple 
ts in the camera's field-of-view.  The FrameSource is a Finder tool.  There is a Edge 

Fitter tool that is placed relative to each located object returned by the Finder. The Edge 
d will 

warnings, for each Inspect Tool, there is a "Tool Warnings" property that 
can be set to FAIL or IGNORE. 

Once the Inspect Type is selected, the Min/Max inspection limits can be 
filled

bounds. 

At the botto
and testing the tool.  When
referenced tools are executed and their properties are evaluated. 

par

Fitter counts the transitions on each part.  If the count is wrong, the part will fail an
not be picked. 

In this example, a part near the center failed since it is missing one of its slots. 

  

Even though multiple tools were utilized to locate and inspect each part, only a single tool 
result is passed to the connected robot controller for each part.  This simplification is 
especially useful for more complex inspection requirements and when the number of 
located parts is large.  
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See Also 

Vision Toolkit | Inspect Frame 
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Inspect Region Tool 
Inspection tool that inspects the perimeter and the interior of an opaque object to 

r.  This 
 and 

es or cracks 
  

Prerequisites 

Source must be defined

determine if there are any flaws in the object's outline or holes in the interio
tool was designed to inspect wafers, where slight changes in the overall size
shape of the wafer are permitted, but chips in the perimeter or interior hol
are unacceptable. 

Frame  for this tool to execute.  Multiple source tools must be 
efine the perimeter of the object to be inspected. 

Properties 

created that d

Property Name Data 
Type Range  Description

1. Identity
Name String n/a 
Type String n/a

Standard Identity 
properties

3. Operation

Camera Integer 1 - 6 Standard Operation 
property

FrameSource List n/a 

Name of the required to
whose 

ol 
ResultsXPos, 

YPos and Angle are 
taken as the nominal 
Results of this tool. 

PerimeterTool01-12

 

ected.  These 
tools are normally Line 
Fitters, Arc Fitters or 
computed line tools. 
These tools must be listed 

List n/a 

Series of up to 12 vision 
tools whose results define
the outline of the region to 
be insp

in sequence as the 
perimeter is traversed in a 
counter-clockwise 
direction.  The located 
lines and arcs plus the 
points of intersection that 
are automatically 
computed between 
adjacent tools define a 

e mask that is applied to th
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image to detect flaws.  
The resulting mask must 
be a closed convex 
shape. 

SetMinBlobArea Integer 0 - n 

Specifies the minimum 

s that 

is 
th to 

flaws.  Any flaw that 

 

number of connected 
binary or edge pixel
a flaw must contain in 
order for it to be 
considered a defect.  Th
test is applied bo
perimeter and interior 

consists of a smaller 
number of pixels will be
ignored. 

SetNumOfErosions Integer 0 - n 

 
 be 

 

ine of 
the region to be tested in 
the image is somewhat 
rough, this permits small 

ignored. 

After the mask is 
dynamically generated 
from the results of the 
PerimeterTools, the size
of the mask can
reduced by a few pixels
via an iterative erosion 
operation.  If the outl

errors in the outline to be 

SetT

Threshold that is used 
when the ImageMode is 
Binary to convert gray 

to black 
s.  For 

EdgeLevel mode, this 
specifies the threshold 

w 
ges 
er 

this property is set, the 
more sensitive the system 

es.  

e Edge 

hreshold String   

below which weak (lo
contrast) gradient ed
are ignored.  The low

scale values in
and white pixel

is in locating edg
Please see the 
description of th
Locator for more 
information on edge 
gradients.  The default 
value is 30. 

3A. Advanced Operation

Ima EdgeLevel / Binary 

 of 
zed 

as a binary or an edge 
image. 

geMode List
Specifies if the region
interest is to be analy
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ProcessMode Boolean EROD D_IMAGE / 
EDGE_IMAGE / 

THRESHOLDED_IMAGE / 
ANDED_IMAGE / 

ANDED_IMAGE_WITH_BLOB 

its 
pped at 

n of the 
specified processing step 
so that the results of the 
step can be viewed in the 
Camera Window.  If this 
property is not set to 
Normal, the results of this 

 be valid since 
 not complete 

its full analysis. 

NORMAL / 
LINE_ARC_BOUNDARY / 

FLOODED_REGION / 

This is a setup / 
debugging aid.  It perm
the tool to be sto
the completio

E

tool will not
the tool will

ShowPerimeterTool Boolean TRUE / FALSE 

If TRUE, the Results of 
each of the 
PerimeterTools will be 
displayed.  These results 
can sometimes be useful 
to see, but at other times, 
can clutter the Camera 
Window. 

4. Inspection Settings
InspectActual Single   

InspectPassed List Pass / Fail

Standard Inspection 
Settings properties.  The 
InspectActual returns the 
number of defects that 
are detected.  If no 
defects are found, the 
InspectPassed is set to 
Pass. 

InspectString String n/a 

Optional label that is 
displayed in the Camera 
Window.  This provides a 
convenient way to display 
part ID or other 
information. 

5. Results Settings
MaxResults Integer -1 or 1 to n 
OffsetAngle Single degrees 
OffsetX Single mm 
OffsetY Single mm 
ResultSelect Integer 1 - n 

ShowResults List NONE / FRAME /  
LINE / POINT 

Standard Results Settings 
properties.  

6. Results
ResultCount Integer 0 - n 
ResultErrorCode Integer   
ResultAngle Single -360 to 360
ResultXPos Single mm

Standard Results 
properties. 
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ResultYPos Single mm  

Remarks 

designed to locate chips in the perimeter of a 
smooth convex outline and interior holes and cracks.  This was developed to inspect for 
defects in wafers, whose size and outline might vary slightly from one wafer to the next.  

nnot be 
enerated for each 

.  These tools 
t expected 

This tool can operate on any convex shape whose outline can be defined by 12 lines and 
mple of acceptable shapes are as follows: 

This is a specialized inspection tool that is 

Since acceptable wafers can vary in their exact size and shape, a fixed mask ca
applied to inspect the perimeter.  Instead, a mask is dynamically g
image using the results of Line Fitter, Arc Fitter and computed line tools
can locate the actual perimeter to be inspected and can take into accoun
variations in the outline of the wafer to be inspected. 

arc.  An exa

 

ncave features, the following While this tool could be d to ha ith co
apes are currently no rted. 

 extende ndle outlines w
sh t suppo

 

t the imag
 arc are automatically 
 must be specified in the 

This tool dynamically generates a m ins e using the results 
12 lines and arc  inter and
d to bound the  There  arc

ask to compare aga
section of the lines 
fore, the lines and

of up to 
compute

s.  The
mask. 

PerimeterTools list in the order in wh s yo eter ich they appear a u trace around the perim
in a counter-clockwise direction.  After the mask has been c
desired by a series of erosion operations.  If the object to b
edges, this will eliminate a few pixels along the perimeter fr

reated, it can be shrunken if 
e tested has slightly rough 
om consideration. 
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The region to be tested is then converted to either a binary 
mask is AND'ed with the converted region.  Any flaws along
interior of the region will be left as non-zero pixels.  A conn
applied to identify any collection of non-zero pixels that are larg stitute an 
important defect. 

The number of detected defects are counted and if any def
a failure indication. 

uste
ions   The ntro

that are considered defects and how much the mask is shru

Examples 

Below is an example of a Region Inspect tool that detects missing regions along the 
perimeter of a part.  On the left is a good part that passes. 
due to a missing region along an "arc" and an interior defect.  Any detected defects are 
automatically highlighted by a bounding red rectangle. 

or an edge image and the 
 the perimeter or in the 

ectivity algorithm is next 
e enough to con

ects exist, this tool returns with 

d using the SetMin
se parameters co

BlobArea and 
l the minimize size of flaws 
nk before it is applied. 

The sensitivity of the tool can be adj
SetNumOfEros properties.

 On the right is a part that fails 

     

See Also 

Vision Toolkit | Line Fitter | Arc Fitter
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Light Recorder Tool 

ed vision tool uires a sequ  of camera
period of time, determines the brig ss of each
e brightness  in an array for subsequent 

Specializ
specified 

that acq ence
htne

 images for a 
 image, and 
analysis. returns th readings

Prerequisites 

e camera pro for example the ExposureT
VideoOffset, etc.) defined in the previously executed Acqui turing the 
images required by this tool. 

Properties 

ime, VideoGain, 
sition Tool for cap

Utilizes th perties (

Property Name Data 
Type Range  Description

1. Identity
Name String n/a 
Type String n/a

Standard Identity properties

2. Placement/Size
Height Single 0 - AOI (mm) 
Width Single 0 - AOI (mm) 
XPos Sin 0 - AOI (mm) gle

YPo

Sta  Size 

s Single 0 - AOI (mm) 

ndard Placement /
properties. The X and Y values define 

 center of the tool.  The Height and 
th specify the size of the image 
ion being tested. 

the
Wid
reg
 
If the referenced camera supports 
hardware AOI to permit faster frames 
per second rates and PreciseVision 

, this 
 

crease 
ote, some 

camera's maximum frame rate occurs 

 

implements AOI for the camera
tool will automatically utilize the
camera's AOI capability to in
the maximum frame rate.  N

when the AOI is larger than a few 
pixels in each direction, so some 
experimentation with the AOI size 
might be require if the fastest frame
rate is desired.  

3. Operation
Camera Integer 1 - 6 Standard Operation property
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yMode List MEAN / MAX / MIN  
Specifies the type of result to be 
computed and returned for each 
frame.  

Gra

DesiredSampleRate Single 0 - n (msec) 

(in msec) between each acquired 
image.  The actual time will vary 
depending upon the performance of 
the camera and the PC on which 
PreciseVision is executed.   If this 
property is set to 0, images will be 

Specifies the desired amount of time 

acquired as quickly as possible. 
Defines the period of time during 
which images are acquire
seconds.  The actual resul

RecordTime Single 0 - n (seconds) 

d, in 
ts returned 

are limited by how many values can 
be transmitted to the attached motion 
controller.  Currently, at most 3000 
sample results can be returned. 

5. Results Settings

ShowResul s propertyts List NONE / FRAME / 
LINE / POINT Standard Results Setting

6. Results
ResultErrorCode Integer   
ResultAngle Single -360 to 360
ResultXPos Single mm
ResultYPos Single mm

Standard Results properties

ResultActualTime Single sec Actual time in seconds for the 
operation to complete. 

Remarks 

This vision tool captures a sequence of images at a specified target rate (in msec), 
computes the mean, maximum or minimum brightness of each image, and returns the 
results in an array of values.  This tool was originally designed to analyze the blinking 
pattern of an LED.  However, it could also be used as a time based proximity sensor or 
light level detector. 

While this function could be implemented with a combination of other vision tools, this 
tool is able to achieve higher image acquisition rates due to reduced overhead between 
image captures.  The image capture rate can be especially high if this tool is applied to a 
camera that includes a hardware area of interest (AOI) capability that is supported by 
PreciseVision. 

To permit a detailed analysis of the results of this tool, two integer values are returned for 
each image: 

• The mean, maximum or minimum gray-scale value of all pixels within the tool's 
region of interest (0-255). 

• The number of msec that elapsed from the start of the image capture until the 
start of the next image capture.  This time will differ from the target time due to 
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variability in the camera acquisition and delays due to the PC operating system.  
If pictures cannot be acquired at the specified rate, they will be captured as 
quickly as possible.  The time for the first acquisition will be somewhat longer 
than subsequent times due to acquisition setup operations. 

property editor) 

e 
f the 

vides a quick graphical presentation of the 
data collected by this tool. 

Special Feature Buttons (located above the 

Execute and Graph 

Pressing this button executes the tool a single time and displays th
collected mean, maximum or minimum gray-scale value for each o
captured images.  This pro

 

Sample GPL Program 

ng is a sample ram that sion process ("main") that 
cludes a Light Recorde e outpu m for a sample image are 

wn following the progra

 MAIN 
 

 vis As New Vision 
 visRes As New VisResult 

ress = "192.168.0.112" 

    vis.Process("main")
ErrorCode =  

        visRes = vis.Result("light_recorder",1) 
        Dim ii As Integer 
        For ii = 0 To visRes.InfoCount-1 Step 2 
            Console.WriteLine("Gray:" & CStr(visRes.Info(ii)) & _ 
                              " mSec:" & CStr(visRes.Info(ii+1))) 
        Next 
    End If 
End Sub 
 
Output:

The followi GPL prog  executes a vi
in
sho

r tool.  Th
m. 

t of this progra

 
Public Sub

    Dim
    Dim
 
    vis.IPAdd
 

 
    If vis.  0 Then
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Gray:20 mSec:193 
Gray:17 mSec:187 
Gray:28 mSec:187 
Gray:34 mSec:191 
Gray:38 mSec:187 
Gray:46 mSec:186 
Gray:57 mSec:189 
Gray:65 mSec:186 
Gray:73 mSec:187 
Gray:79 mSec:187 
Gray:49 mSec:189 
Gray:29 mSec:189 
Gray:26 mSec:187 
Gray:32 mSec:187 
Gray:84 mSec:192 

Sec:186 

See Also 

Vision Toolkit

Gray:241 m

 | Acquisition Tool | Pixel Window Tool
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Line Fitter Tool 

that searches a s gion f ts and re
ges. 

Vision tool 
the line that best fits the ed

pecified re or edge poin turns 

Prerequisites 

None 

Properties 

Property Name Data 
Type Range  Description 

1. Identity 
Name String n/a 
Type String n/a

Standard Identity properties

2. Placement/Size 
Angle Single -360 to 360  
Height Single 0 - AOI (mm) 
Width Single 0 - AOI (mm) 
XPos Single 0 - AOI (mm) 
YPos Single 0 - AOI (mm) 
RelAngle Single -360 t o 360 
RelXPos Single 0 - AOI ( mm) 
RelYPos Single 0 - AOI (

St

 mm) 

andard Placement / Size 
properties.  The X and Y 

lues defiva ne the center of the 
tool and the center of the 
search region.  The Height and 
Width specify the size of the 
search region. 

3. Operation 
Camera Integer 1 - 6 
Relative-ToolName List n/a 

Standard Operation properties

EdgeMode List 

..._NEAREST_DARK /  
_NEAREST_N INAL /  
..._NEAREST_LIGHT /  
..._MAX_GRADIENTS / 

AX_CONC TION  

If multiple lines exist within the 
se
helps to distinguish which line 
should be returned.  In addition 
to sele
th
no
gr
ed  the 

... OM

..._M ENTRA

arch region, this parameter 

cting the line closest to 
e dark side, light side, 
minal (center line), or 
eatest concentration of 
ges, you can also select
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lin st.  
 
Th ode is 
pa here are 
tw
co
th
at
gr
is 
th  group of 
ed
fit

e with the highest contra

e concentration m
rticularly useful if t
o or more distinct non-
linear groups of edges and 
e returned fit line is 
tempting to span multiple 
oups. If concentration mode 
specified, this tool will select 
e largest cohesive
ges as the basis for the line 

ting. 

EdgeThreshold Integer 0 - 254 

Sp
wh
gr  
Th
m
lo  
de

ecifies the threshold below 
ich weak (low contrast) 

adients edges are ignored. 
e smaller the number, the 

ore sensitive the system is in 
cating edges.  Please see the
scription of the Edge Locator 

fo
gr e is 
30

r more information on edge 
adients.  The default valu
.  

3A. Advanced Operation 

AllowedAngular-
Range Single 0.01 - 89 (deg)  

(M
m
orientation of the line that will 
be in 
de nus 
ro l 
an
 
In
ar s, this 
pa ilized in 
co
CO
lo line with a 
se

AX_CONCENTRATION 
ode only)  This limits the 

 returned.  It is specified 
grees and is a plus or mi
tation relative to the nomina
gle of the tool.   

 special cases when there 
e multiple uneven edge
rameter can be ut
mbination with the MAX_ 
NCENTRATION mode to 

cate the dominant 
lected orientation. 

BiasF
..._BIAS_NONE /  

Fo gular or 
ja rameter 
can be set to provide extra 
weight (importance) to edges 
that are closest to the light or 

ion.  
hed 

ld be 
s of 
her 
.  

r lines with an irre
gged edge, this pa

ilter List ..._BIAS_TO_LIGHT /  
..._BIAS_TO_DARK 

dark side of the search reg
For example, for a saw toot
pattern, this property cou
set to fit the line to the tip
the high or low points rat
than along the center line

Draw hat 
are selected after the 

EdgePoints List 
..._NO_EDGE_POINTS / 
..._ALL_EDGE_POINTS / 
..._USED_EDGE_POINTS  

If set, draws yellow dots to 
indicate ALL edge points t

171 



PreciseVision 

EdgeMode is applied or only 
those edges that are USED to 
fit lines after the EdgeMode is 
applied and all outliers are 
eliminated.  This is very helpful 

the effect of 
rty 

settings. This value is 
NO_EDGE_POINTS by 
default.  

for understanding 
changing various prope

MaxEdgePoints Integer 2 - n  

Maximum number of edge 
point searches to perform.   
Higher numbers produce 
greater accuracy at the 
expense of execution speed.  
The minimum value of this 

 value is 
 

r of pixels across the 
width of the tool.  The default 
value is 30.  

parameter is 2.  This
automatically limited to the
numbe

MaxIterations Integer 0 - n  

Maximum number of iterations 
for filtering.  The filtering 
algorithm repeatedly removes 
outlier points, refitting the line 
each time, until no more points 
need to be removed or the 
maximum number of iterations 
have occurred.  A value of zero 
disables filtering.  The default 
value is 5.  

MinFilterDistance Single 0 - n.nn  

Absolute minimum filter 
ge 

to the fitted line 
than this are discarded during 
the iterative process.  A 
minimum distance is needed 
because the standard deviation 
of distances to the fitted line 

s than a pixel with a 
f a clean edge.  

 is 1.  

distance in pixels.  No ed
points closer 

can be les
good image o
The default value

MinP dges Integer 1 - 100  

NTRATION 
mode with BiasFilter only) 
Minimum width (as a 
percentage of the tool's Width) 
that a candidate edge must 
span in order to be an 
acceptable result. 
 
For special cases, this can be 
a very powerful feature to filter 
out short undesirable lines. 

ercentE

(MAX_CONCE
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0 - n.nn  

Filter width in units of standard 
deviations.  This value is 
multiplied by the standard 
deviation of the edge points’ 
distances to the fitted line to 
compute the distance threshold 
beyond which edge points are 

 du
fitting proces t 
value is 1.5.  

SigmaFilter Single 

removed ring the iterative 
s.  The defaul

4. Inspection Settings 

Inspe t ..._NUM_EDGES_FOUND / 
..._NUM_EDGES_USED 

ctType Lis
NONE / ..._RMS / 

..._ANGLE / 

InspectLabel List 
NONE / PASS_AND_FAIL / 

PASS / FAIL / VALUE_REAL / 
VALUE_INTEGER 

InspectMax Single   
I Single   nspectMin 
I ctual SnspectA ingle  
I ed List s / Fail

Standard Inspection Settings 
properties

nspectPass Pas
5. Results Settings 
O le S rees ffsetAng ingle deg
O Sin m ffsetX gle m
OffsetY Single mm 
R Boo  TRUE / FALSEesultOnNotFound lean
S List NONE / FRAME / LINE / PhowResults OINT 

Standard Results Settings 
properties

6. Results 
R de Int   esultErrorCo eger 
ResultAngle Single 360-360 to 
Resul  Single tXPos mm
R Sin

Standard Results properties

esultYPos gle mm
ResultNum-
E Integer . 

Result.Info(1)]dgesFound   Number of edge points found
[GPL: Vis   

R
E In   

Number of edge points 
remaining after the filtering 
process. [GPL: 

esultNum-
dgesUsed teger 

VisResult.Info(2)]  

ResultRMS Single   Root mean square of the line 
fit. [GPL: VisResult.Info(0)]  

Re

ar region reen and blue outlined rectangle for 
edge points and fits a line to the edge points using a least squares technique.  By 

marks 

The Line Fitter se ches the  defined by its g
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computing th
edges in its

e edge positions d by employing multiple such 
 computation, this t e sub-pixel results. 

l is very useful for accurately locating straight edges of objects.  Once found, 
nes can be  compu between important features or for 
g reference  that can ac tely locate an object or features in an object. 

o make this re discriminating, the Line Fitter only utilizes edges whose 
dark and light sides have roughly the same orientation as the dark (blue) and light (green) 

es of the search area.  So, when positioning this tool, you should place the center 
(nominal) line of the search region at approximately the position and orientation that you 

1. All of the edges in the rectangular region are extracted by performing 
.  

ia 
ht, etc.) is retained and the other edge points are 

discarded. 

tting process iteratively to increase the 
robustness of the results.  During each line fitting pass, edge points that are too distant 
from the line (outliers) are discarded.  This filters out edges that are not a part of the line 
and whose inclusion would incorrectly offset the result.  MaxIterations specifies the 

ting all of 
the edges.  So, the speed and the accuracy of the Line Fitter can be traded-off by 
adjusting MaxEdgePoints.   This property determines how densely the tool scans to 
detect edges.  This parameter must be set to at least 2 in order to detect the minimum 
number of edges to define a line.  At most, one edge search is performed for each pixel 
along the width of the Fitter.  Execution time increases roughly in proportion to the value 
of MaxEdgePoints.  On the other hand, the accuracy of the tools increases 
approximately as the square root of MaxEdgePoints.  That is, if you increase 
MaxEdgePoints by a factor of 4, the tool execution time will quadruple but the accuracy 
will only double. 

In order to address some unusual cases, the Line Fitter provides special modes of 
operation.  For lines with an irregular or jagged edge, the BiasFilter property can provide 
extra weight (importance) during the line fitting operation to edges that are closest to the 
light or dark side of the search region.  This has the effect of causing edge points that are 

rthest from the biased edges to be discarded. 

edges and 
s to 

distinguish the desired line, the "MAX_CONCENTRATION" mode can be utilized to 
locate the most prominent line.  During Step 2, this method analyzes all of the edge 
points and computes a best guess line within the specified range of orientation that has 
the highest concentration of strong edges.  Then, for each edge search, the point that is 

to a sub-pixel accuracy a
ool is able to generate very accurat

n

This too
these fit li  used to te distances 
generatin  frames cura

In order t  tool mo

sid

expect to find the line with the blue side on the anticipated dark side of the object.  

The operation of this tool is generally performed in the following three steps.   

MaxEdgePoints number of linear edge searches using the Edge Threshold
2. For each edge search, the single edge point that best fits the EdgeMode criter

(nearest dark, nearest lig

3. A straight line is fit to the selected edge points. 

Typically, the Line Fitter will perform the fi

maximum number of fits to perform.  After each line fit, edges that are beyond 
SigmaFilter standard deviations are rejected, unless the edge is within 
MinFilterDistance pixels of the fit line.  The iterative process stops if (i) MaxIterations 
are performed, (ii) no further edges are discarded, or (iii) only two edge points remain. 

Of the various operations, the tool spends most of its time in the first step, extrac

fu

As another special case, if the search area has two or more distinct groups of 
it is not possible to utilize the EdgeMode nearest dark, light or nominal method
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closest to this best guess line is retained and all other edges points are discarded.  Step 
3 progresses as usual to compute the best fit line to the selected edge points. 

At the conclusion of the Line Fitter, the center position and orientation of the best fit line 
stical data on the number of edges finally used and the root 
 returned.  This statistical data indicates the quality of the 

final fit and can be tested via the "Inspect Settings" to yield a pass/fail indication for the 

Special Feature Buttons (located above the property editor) 

Adjust Threshold 

Pressing this button displays a pop-up window that permits the value of 
the Edge Threshold property to be manually adjusted while dynamically 
viewing the effect of the new setting in the Camera Display.  The edges 
that satisfy the threshold criterion are displayed in white. 

Examples 

the following example, two Line Fitters are utilized to accurately determine the 
ns and orientations of the straight sides of an ob

tersection tool then takes the output of the two Fitters and generates a reference frame 
s at the intersection of the two fit lines.  Since the two Line Fitters compute 

results based u iple pixel values, their outp

are returned.  In addition, stati
mean square of the line fit are

operation.  

In 
positio
In

ject.  A Computed Line-Line 

whose origin i
their pon mult ut values are very accurate. 

 

re the outer orThe follow
series of fing

ing example demonstrates the special case whe  inner edge of a 
ers is to be located.  If the standard Line Fitter is applied with 

FITLINE_BIAS_NONE, the fit line is located somewhere along the center of the fingers.  
 locate th r uter edge of the fingers, the BiasFilter should be set to 

S_TO_D  or FITLIN _LIGHT.  
To properly e inner o  o
FITLINE_BIA ARK E_BIAS_TO
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The following example demonstrates the special case where there are a series of closely
spaced discontinuous parallel edges and you wish to

 
 locate the strongest edge.  If you 

are not able to accurately position the finder and use EdgeMode to distinguish the 
ired line by specifying the nearest light, dark or nominal, 

X_CONCENTRATION may be of use.  This method locates the line with the 
e 

des
FITLINE_MA
greatest concentration of strong edges and uses this to select the edge points that ar
considered during the iterative line fitting.  

 

See Also 

Vision Toolkit | Arc Fitter | Edge Locator | Find Centerline Tool | Point-Point Line Tool 
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Line-Line Frame Tool 

Computational tool that determines the intersection of two lines defined by 
vision objects and returns a reference frame.  Alternately, this tool 
compute and return the midpoint of two 

can 
reference frames defined by two 

vision objects.  

Prerequisites 

Requires two vision objects that each supply either a line or a frame. 

Properties 

Property Name Data 
Type Range  Description 

1. Identity 
Name String n/a 
Type String

rties
 n/a

Standard Identity prope

3. Operation 
Camera Integer 1 - 6 Standard Operation property

SourceLine1Name  

Name of the vision object 
that defines the line that 

the 
 

List n/a determines the X-axis of 
computed reference frame.

SourceLine2Name List n/a 

ect 

t is intersected with the 

Name of the vision obj
that defines the second line 
tha
first line. 

4. Inspection Settings 
InspectType List NONE / RESULT_ANGLE 

InspectLabel List 
NONE / PAS AND_FAIL 

PASS / F LUE_REAL
VALUE_INTEGER 

S_
AIL / VA

/ 
 / 

InspectMax Single   
InspectMin Single   
InspectActual Single  
InspectPassed List Pass / Fail

 Standard Inspection Settings
properties.  Can be used to 
validate the ResultAngle. 

5. Results Settings 
OffsetAngle Single degrees Standard Results Settings 
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OffsetX Single mm 
OffsetY Single mm 
ResultOnNotFound Boolea TRUE / FALSEn 
ShowResults List NONE / FRAME / LINE / POINT 

properties

ResultMode List 

LINE_TO_ RS / 
MID_POINT_ANGLE_AVER / 
MID_POINT_ANGLE_SRC1 / 
MID_POINT_ANGLE_SRC2
MID_ E_ZERO

LINE_TO_LINE... - Tool 
returns a reference frame 

MID_POINT_ANGLE... - Tool 
returns a reference frame 

point 
een the origin of 

SourceLine1Name and 
SourceLine2Name.  The 
returned orientation can be 
the average of the 

sources, the orientation of 
either source, or zero.  

LINE_INTE

 / 
  

whose origin is the mid
betwPOINT_ANGL

Specifies the result to be 
computed by this tool. 
 

that represents the 
intersection of two lines. 
 

orientations of the two 

6. Results 
ResultAngle S -360 to 360ingle 
ResultXPos Single mm
ResultYPos Single mm

Standard Results properties

Remarks 

This computational tool combines the results of two vision tools to compute a new 

ion 
objects that define two intersecting, non-parallel lines.  The X-axis of the new reference 

 

orientations of the two source vision objects; the orientation of one of the 
two source vision objects; or zero.  

Exampl

reference frame.   

If the ResultMode is set to LINE_TO_LINE_INTERSECT, the inputs must be two vis

frame will be collinear with the first input line.  The origin of the new frame will be at the 
point where the two lines intersect. 

This method is often used to uniquely define the position and orientation of a simple 
object or a section of an object.  The resulting reference frame can then be used to 
position additional vision tools.  As another example, this method can be utilized to 
compute the position of a corner of an object as determined by its two adjacent straight 
sides. 

If the ResultMode is set to one of the MID_POINT_ANGLE_* methods, the origin of the
returned reference frame will represent the midpoint between the origin of the two source 
vision objects.  The orientation of the returned reference frame can be selected as:  the 
average of the 

es 
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The following example illustrates how two Line Fitters can be applied to accurately 
identify the position and orientation of two adjacent sides of an object.  The results of the 
two Fitters are then fed into a Line-Line Frame Tool with the ResultMode set to the 

ference frame that accurately 
sed corner. 

LINE_TO_LINE_INTERSECT method to yield a re
represents the position and orientation of the enclo

 

See Also 

Vision Toolkit | Fixed Frame Tool | Point-Line Frame Tool | Point-Point Line Tool 
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Pixel Window Tool 

ular or circular region. This tool is 
d to quickly determine if a feature is present or to verify that 

erage gray-level reading of a region is correct. 

Vision tool that counts pixels of a specific type or computes pixel 
statistics within a rotated rectang
typically use
the av

Prerequisites 

None 

Properties 

Property Name Data 
Type R e  ang Description 

1. Identity 
Name String n/a 
Type 

s
String n/a

Standard Identity propertie

2. Placement/Size 
Angle Single -360 to 360 
Height Single 0 - AOI (mm) 
Width Single 0 - AOI (mm) 
XPos Single 0 - AOI (mm) 
YPos Single 0 - AOI (mm) 
RelAngle Single -360 to 360 
RelXPos Single 0 - AOI (mm) 
RelYPos Single 0 - AOI (mm) 

Standard Placement / Size 
properties.  The X and Y values 
define the center of the region to 

e 
be processed.  The Height and 
Width define the dimensions of th
region.  

3. Operation 
Camera Integer 1 - 6 
Relative-ToolName List n/a 

Standard Operation properties

PixelMode List  
B / 

EDGE_LEVEL  

level 
). 

INARY_STATS 
GRAY_STATS / 

When this tool executes, it 
operates in one of three different 
modes: 
 
"BINARY_STATS" counts 
white/black pixels after 
thresholding. 
"GRAY_STATS" returns gray-
statistics (i.e. mean gray-levels
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"EDGE_LEVEL" counts edge 
s 

 

pixels after a gradient operator i
applied. 
 
Where a property is only relevant 
for a specific mode, the property is
labeled as BINARY, GRAY or 
EDGE. 

CountWhitePixels  TRUE / FALSE  

d. 

Boolean
(BINARY) If TRUE indicates that 
the white pixels are to be 
counted.  Otherwise, black pixels 
are counte

Threshold Integer 0 - 254 

 

d.  The 
lower this property is set, the more 

ocating 
scription 

e Locator

(BINARY) This is the value used 
to convert gray scale values into
black and white pixels. 
 
(GRAY)  This value is ignored. 
 
(EDGE) Specifies the threshold 
below which weak (low contrast) 
gradient edges are ignore

sensitive the system is in l
edges.  Please see the de
of the Edg  for more 
information on edge gradients.  
The default value is 30. 

ToolShapeType 
RECT LAR / 

RO
SQUARE window has its aspect ratio forced 

to 1:1. 

List 
ANGU

UND / 

Shape of the window in which the 
pixels are analyzed.  A square 

4. Inspection Settings 

Insp
MAXPIXELVAL / 

PIXELSUM / 

ectType List 

NONE / MEAN / 
NUM_PIXELS / 

STANDARD_DEV / 
MINPIXELVAL / 

PIXELSUMSQUARE 

InspectLabel List 

NONE / 
PASS_AND_FAIL / 

PASS / FAIL / 
VALUE_REAL / 

VALUE_INTEGER 
InspectMax Single   
InspectMin Single   
InspectActual Single  
InspectPassed List Pass / Fail

Standard Inspection Settings 
properties

5. Results Settings 
OffsetAngle Single degrees Standard Results Settings 
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OffsetX Single mm 
OffsetY Single mm 

ShowResults List NONE / FRAME / 
LINE / POINT 

properties

6. Results 
ResultErrorCode Integer   
ResultAngle Single 0 (non-rotating)
ResultXPos Single mm
ResultYPos Single mm

Standard Results properties 
 
(BINARY,EDGE) X and Y position 
represent the centroid of the 
counted binary or edge pixels. 

ResultPixelCount Integer   

(BINARY,EDGE) Total number of 
counted binary or edge pixels in 
the rectangular region. [GPL: 
VisResult.Info(0)]

ResultMean Single   
(GRAY) Mean gray-scale value of 
all pixels in the region. [GPL: 
VisResult.Info(1)]

ResultMaxPixelValue Integer   
(GRAY) Maximum gray-scale 
value of all pixels in the region. 
[GPL: VisResult.Info(4)]

ResultMinPixelValue Integer   
(GRAY) Minimum gray-scale value 
of all pixels in the region. [GPL: 
VisResult.Info(3)]

ResultPixelSum Integer   
(GRAY) Sum of gray-scale values 
of all pixels in the region. [GPL: 
VisResult.Info(5)]

ResultPixelSumSqr Integer   

(GRAY) Sum of the squares of the 
gray-scale values for all pixels in 
the region. [GPL: 
VisResult.Info(6)]

ResultStandardDev Single   

(GRAY) Standard Deviation of the 
gray-scale values for all pixels in 
the region. [GPL: 
VisResult.Info(2)]

Remarks 

This tool very quickly processes a rectangular or circular region of a gray-scale image 
and either counts black or white pixels after thresholding, counts edge pixels after 
applying a gradient operator or collects image statistics, such as mean, maximum, 
minimum and standard deviation of the pixel gray-scale values. 

This tool provides a very efficient means for quickly extracting gross statistical information 
about a rectangular or circular region.  This tool is often used to quickly verify the 
presence of a feature or obstacle or to collect gray-scale statistics.  For example, this tool 
can be employed to inspect a part to ensure that expected holes are present or that tabs 
have been removed.  The BINARY mode can be applied to detecting defects in a uniform 
area such as inspecting for scratches or pits in a lens.  The GRAY mode can be used as 
a simple light meter to adjust the threshold for other operations or can determine the 
gray-scale uniformity of the region. 
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When this tool is operated in the BINARY mode, the specified region is converted to 
white and black pixels based upon the Threshold property.  Then, either the white or the 
black pixels are counted based upon the CountWhitePixels property.  The number of 
counted pixels and the centroid of all of the positions of the counted pixels are returned in 

If this tool is operated in the EDGE mode, the specified region is converted to edge pixels 
 

he centroid 
of all of their positions are returned in the results. 

If this tool is operated in GRAY mode, statistics are collected on all of the pixel gray-scale 
n value, 

re Buttons (located above the property editor) 

Pressing this button displays a pop-up window that permits the value of 
the Thres operty to be easily adjusted while dynamically viewing 
the effect of the new setting in the Camera Di
the displa ge shows all pixels converted to black or white, where 

e white pixels are the ones that are counted.  In EDGE mode, the edge 
counted are di

See Also 

Vision Toolkit

the results. 

using a gradient operator and the setting of the Threshold property to select only stron
edges.  Then, the edge pixels are counted.  The number of edge pixels and t

g

values within the specified region.  The returned results include the mea
maximum value, minimum value, sum of the squares, and standard deviation. 

Special Featu

Adjust Threshold 

hold pr
splay.  In BINARY mode, 

yed ima
th
pixels that are extracted and will be splayed in white. 

 | Pixel Color Window
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Pixel Color Window Tool 

l that tests if the color of tches a trained color.  The 
nsidere able if, fo n of interest, the match of the 
nsity of each of the RGB s and their trained values is 

e an acceptable threshold.   In addition, this tool computes the mean 
/HSI values f gion. 

Vision too  a region ma
color is co
mean inte

d accept r the regio
color layer

abov
HSV or the re

Prerequisites 

 a color camera. 

Pro

Requires

perties 

Property Name Data 
Type Range  Description 

1. Identity 
Name String n/a 
Type

roperties
 String n/a

Standard Identity p

2. Placement/Size 
Angle Single 0 (non rotating) 
Height Single 0 - AOI (mm) 
Width Single 0 - AOI (mm) 
XPos Single 0 - AOI (mm) 
YPos Single 0 - AOI (mm) 
RelAngle Single 0 
RelXPos Single 0 - AOI (mm) 
RelYPos

Standard Placement / Size 

 Single 0 - AOI (mm) 

properties.  The X and Y 
values define the center of 
the region to be processed.  
The Height and Width define 
the dimensions of the region.

3. Operation 
Camera Integer 1 - 6 
Relative-ToolName List n/a 

Standard Operation 
properties

ToleranceBlue Integer 0%  0-10
Toler

Define the minimum match 
 be anceGreen Integer 0-100%  percentages that must
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ToleranceRed Integer 0-100%  

ASS.  
The color match is performed 
in the specified region 
between the mean intensity 
values for each RGB color 
layer and the corresponding 
trained mean values.  
 
For example, if the 
ToleranceBlue is set to 
95%, the computed match 
percentage between the 
mean of the pixel values in 
the specified region of the 
blue color layer and the 
InspectNominalBlue trained 
values must be 95% or 
greater for this tool to return 
PASS..  
 
Higher tolerance values 
require a better color match 
and lower tolerance values 
will accept a greater 
deviation in the color match. 

satisfied for this color 
comparison to return P

ToolShapeType List  RECTANGULAR / ROUND / 
SQUARE  

Shape of the window in 
which the pixels are 
analyzed.  A square window 
has its aspect ratio forced to 
1:1. 

3A. Advanced Operation 

HueOffset Single 0-360 

The computed hue value for 
the region 
(ResultHSVI_Hue) will range 
from 0 to 360 degrees.  
Green will nominally be at 
120 degrees, blue at 240 
degrees and red can be 
either 360 or 0 degrees.  To 
simplify testing for red, the 
HueOffset is added to the 
returned hue value to rotate 
the color represented by 0 
degrees.  This can avoid a 
0/360 discontinuity. 

4. Inspection Settings 

InspectType List  
NONE / 

RESULT_NORMALIZED / 
RESULT_FIXED  

InspectLabel List 
NONE / PASS_AND_FAIL / 

PASS / FAIL / VALUE_REAL 
/ VALUE_INTEGER 

Standard Inspection Settings 
properties.  In the 
RESULT_FIXED mode, the 
color comparison is 
performed with the raw 
nominal and actual mean 
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InspectMax Single   
InspectActualBlue Integer
InspectActualGreen Integer
InspectActualRed 

0-255

Integer

InspectPassed List Pass / Fail

intensity values. This can be 
used when the lighting is 
very controlled and the 

uct color does not vary.  
 the 
ESULT_NORMALIZED 

mode, the nominal and 
actual mean values are 
adjusted each time the tool is 
executed to compensate for 
uniform variations in the color 

prod
In
R

intensity values. This enables 
the color matching to be 
robust even when there is 
some variation in the lighting.

InspectLabelDisplay List RGB_DISPLAY / 
HSVI_DISPLAY 

If InspectLabel is set to 
VALUE_REAL or 
VALUE_INTEGER, PV will 
automatically display the 
computed mean color as 
either RGB or HSVI values 
next to the specified color 
region in the camera image.  

InspectNominalBlue Integer
InspectNominalGreen Integer 

These properties define the 
nominal mean values for 
three color layers.  These 

InspectNominalRed Integer 
0-255 color layers in the regio

interest to determine i
color matche

the 

values are compared to the 
actual mean values for the 

n of 
f the 

s the expected 
value.  These values are 
typically taught by pressing 
the Train Color button (see 
below). 

5. Results Settings 
OffsetAngle Single degrees 
OffsetX Single mm 
OffsetY Single mm 

ShowResults List NONE / FRAME / LINE / 
POINT 

Standard Results Settings 
properties

6. Results 
ResultErrorCode Integer   
ResultAngle Single 0
ResultXPos Single mm
ResultYPos Single mm

Standard Results properties

ResultHSVI_Hue Single 0-360 

r) of the 
pixels in the specified 
region.  Ranges from 0 to 
360 degrees as you go 

Mean Hue (colo
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around the color wheel 
(red=0, green=120, 
blue=240). [GPL: 
VisResult.Info(6)]

ResultHSVI_Saturation Single 0-100

Mean Saturation (intensity of 
the Hue) of the pixels in the 
specified region.  0% 
indicates a gray scale value.  
100% indicates a saturated 
color. [GPL: 
VisResult.Info(7)]

ResultHSVI_Value Single 0-255
RGB colors in the specified 
region.  This is the maxim
of the three RGB values.  
[GPL: VisResult.Info(8)]

Maximum lightness of the 

um 

Single 0-255 

ss 
of the color in the specified 
region.  This is the average 
of the mean RGB readings. 
[GPL: VisResult.Info(9)]

Mean lightness or darkne

ResultHSVI_Intensity 

ResultMeanBlue 
Mean blue color value of 

Single 0-255 pixels in specified region. 
[GPL: VisResult.Info(2)]

ResultMeanGreen Single 0-255
Mean green color value of 
pixels in specified region. 
[GPL: VisResult.Info(1)]

ResultMeanRed Single 0-255
Mean red color value of 
pixels in specified region. 
[GPL: VisResult.Info(0)]

ResultPercentBlueMatch Integer 0-100 
Match percentage for the 
blue color layer [GPL: 
VisResult.Info(5)]

ResultPrecentGreenMatch Integer 0-100
Match percentage for the 
green color layer [GPL: 
VisResult.Info(4)]

ResultPrecentRedMatch Integer 0-100
Match percentage for the red 
color layer [GPL: 
VisResult.Info(3)]

Remarks 

This tool compares the general color of a region of interest with a taught color and returns 

).  These actual mean values are compared against 

n. 

a Pass/Fail value that indicates if the colors matched as well as or better than specified 
minimum match criteria.  The region can be defined as a rectangular, square or circular 
shape.  The color of the region is determined by computing the mean intensity value for 
each of the three color layers (RGB
three taught mean RGB values.  If all three pairs of numbers match as well as or better 
than three specified % criterion, the color of the region is considered to be a match and 
this tool returns a Pass indicatio
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To improve the robustness of itions may vary, the 
InspectionType can be set to this mode, the taught 
nominal value l computed mean intensity values are adjusted for the over-
all brightness of the region 

This tool always accesses all thre
indep n yer the Ac

To permit further analysis of the c
retur s t
saturation, intensity) components.
cylindrical color coordinate system r 
plane f
about the circle and smoothly tran
vertical a s

To assis e i-
transparent ci  tin gion of interest.  This 
is illu tra pictur

this tool when the lighting cond
 RESULT_NORMALIZED.  In 

s and the actua
of interest. 

e RGB color layers of the captured color image 
quisition Tool loaded into the current frame buffer. e dent of which la

omputed mean color by other tools, this tool also 
 its HSV (hue, saturation, value) and HSI (hue, 
  These representations map the RGB results into 
s that ar

n he color characterized by

e a bit more intuitive to interpret.  Each circula
to a "color wheel".  The hue is the angle of the color 
sitions between red, green and blue.  The central 

 o  the cylinder corresponds 

xis of the cylinder repre ents the gray colors ranging from black to white. 

t in teaching this tool, th
rcular area that is

 center of the tool is always displayed with a sem
ted with the mean color for the re

s ted in the following e where the center is tinted in blue. 

 

In addition, the camera display window can always be switched into color display mode 
by pressing on the "Toggle Color Display Mode" button in the main Toolbar. 

Special Feature Buttons (located above the property editor) 

Train Color 

Pressing this button assists in teaching the color for the region of 
interest.  After confirmation, the values for the InspectNominalRed, 
InspectNominalGreen, InspectNominalBlue properties are set to the 
current mean values of the selected region of the currently displayed 
image. 

Examples 

none 

See Also 

Vision Toolkit | Pixel Window
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Point-Line Frame Tool 

Computational tool that takes a point and a line from two vision objects 
and returns a reference frame. 

Prerequisites 

Requires two vision objects, one of which supplies a line or a frame and the other of 
which supplies a point. 

Properties 

Property Name Data 
Type Range  Description 

1. Identity 
Name String n/a 
Type String n/a

Standard Identity properties

3. Operation 
Camera Integer 1 - 6 Standard Operation property

SourceLineName List n/a Name of the vision object that defines 
the line. 

SourcePointName List n/a Name of the vision object that defines 
the point. 

4. Inspection Settings 

InspectType List NONE / 
RESULT_ANGLE 

InspectLabel List 

NONE / 
PASS_AND_FAIL / 

PASS / FAIL / 
VALUE_REAL / 

VALUE_INTEGER 
InspectMax Single   
InspectMin Single   
InspectActual Single  
InspectPassed List Pass / Fail

Standard Inspection Settings 
properties.  Can be used to validate 
the ResultAngle. 

5. Resu  Slts ettings 
OffsetAngle Single degrees Standard Results Settings properties

189 



PreciseVision 

OffsetX Single mm 
OffsetY 

 

Single mm 
ResultOnNotFound Boolean TRUE / FALSE

ShowResults List NONE / FRAME / LINE 
/ POINT 

6. Results 
ResultAngle Single -360 to 360
ResultXPos Single mm
ResultYPos Single mm

Standard Results properties

Remark

This computational tool combines the results of two vision tools to compute a new 
reference frame.  The inputs to this method from the vision objects are a line and a point 
that is not on the line.  The X-axis of the new reference frame will be collinear with the 
input line.  The Y-axis of the new frame will pass through the specified point. 

This method is often used to uniquely define the position and orientation of a simple 
object or a section of an object.  The resulting reference frame can then be used to 
position additional vision tools.  

Alternately, this method can be utilized to compute the distance between a point and a 
line since the origin of the generated reference frame defines the position on the line that 
is closest to the input point. 

Examples 

The following example illustrates how a Line Fitter and an Edge Locator can be applied to 
accurately identify the position and orientation of one side of an object and a point on a 
perpendicular side.  The results of the Fitter and Locator are then fed into a Point-Line 
Frame Tool to yield a reference frame that accurately represents the position and 
orientation of this section of the object.  The origin of this reference frame also specifies 
the point on the line that is closest to the point determined by the Edge Locator. 

s 

 

See Als

Vision T

o 

oolkit | Fixed Frame Tool | Line-Line Frame Tool | Point-Point Line Tool 
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Point-Point Line Tool 

Computational tool that computes a line given two points from vision 
objects. 

Prerequisites 

Requires two vision objects that each supply either a point, a line or a frame. 

Properties 

Property Name Data 
Type Range  Description 

1. Identity 
Name String n/a 
Type String n/a

Standard Identity properties

3. Operation 
Camera Integer 1 - 6 Standard Operation property

SourcePoint1Name List n/a Name of the vision object that defines 
one of the two points on the line. 

SourcePoint2Name List n/a Name of the vision object that defines 
one of the two points on the line. 

4. Inspection Settings 

InspectType List NONE / 
RESULT_ANGLE 

InspectLabel List 

NONE / 
PASS_AND_FAIL / 

PASS / FAIL / 
VALUE_REAL / 

VALUE_INTEGER 
InspectMax Single   
InspectMin Single   
InspectActual Single  
InspectPassed List Pass / Fail

Standard Inspection Settings 
properties.  Can be used to validate 
the ResultAngle. 

5. Results Settings 
OffsetAngle Single degrees 
OffsetX Single mm 

Standard Results Settings properties
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OffsetY Single mm 
ResultOnNotFound Boolean TRUE / FALSE

ShowResults List NONE / FRAME / LINE 
/ POINT 

 

6. Results 
ResultAngle Single -360 to 360
ResultXPos Single mm
ResultYPos Single mm

Standard Results properties

Remarks 

This computational tool combines the results of two vision tools to compute a line.  The 
inputs to this method from the vision objects are two points.  The resulting line will 
intercept each of the two input lines. 

Once computed, the resulting line can be combined with other vision results to establish 
reference frames or as a datum for measurements. 

Examples 

Locators can then be fed into the Point-Point Line Tool to compute a line that represents 
the location of one side of the object.  This line can then be combined with other tools to 
measure the dimensions of the object or to establish reference frames.  Note that, in 

The following example illustrates how two Edge Locators can be applied to find two 
reference points on the edge of an object to sub-pixel accuracy.  The results of the two 

general, a more accurate line fit can often be obtained using the Line Fitter Tool.  
However, there are incidences where an edge is non-uniform and selecting two good 
points to construct a line is advantageous. 

 

See Also 

Vision Toolkit | Fixed Frame Tool | Line-Line Frame Tool | Point-Line Frame Tool | Line Fitter Tool
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Sensor Window Tool 

Vision to  within a specified 
region of the image. This tool takes multiple camera images in 
succession using a single camera and determines if there are any 
significant changes. 

ol that detects part movement or no movement

Prerequisites 

Non

Properties 

e 

Property Name Data 
Type Range  Description 

1. Identity 
Name String n/a 
Type 

s
String n/a

Standard Identity propertie

2. Placement/Size 
Height Single 0 - AOI (mm) 
Width Single  0 - AOI (mm) 
XPos Single 0 - AOI (mm) 
YPos Single 0 - AOI (mm) 

Standard Placement / Size 
properties.  The X and Y values 

Height and Width specify the size 
of the image region being tested. 

define the center of the tool.  The 

3. Operation 
Camera Integer 1 - 6 Standard Operation property

DelayAfterComplete Single 0 - n 

Specifies an amount of time to 
wait after the operation is 
completed (post-processing dwell 
time). 
Specifies the threshold below 
which weak (low contrast) 

EdgeThreshold Integer 0 - 254 more sensitive the system is in 
locating edges.  Please see the 
description in the Edge Locator 

gradients edges are ignored.  
The lower this property is set, the 

Tool for more information on 
edge gradients.  The default 
value is 30. 

MaximumTimeout Single 0-n (seconds) Specifies a maximum time (in 
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seconds) that the tool will 
execute. If this time is exceeded, 
the tool stops processing and 
returns an error. 

PixelChangeAmount Integer 0-n 

If more than this specified 
number of edge pixels change 
between successive images, this 
tool declares that motion has 
been detected. 

SenseMode List WAIT_MOTION_STOP / 
WAIT_MOTION_START 

Specifies the operating mode of 
this tool. The default is to "wait 
for no motion". 

3A. Advanced Operation 
ExposureTime Integer   
VideoGain Integer   
VideoOffset Integer   

Same properties as in the 
Acquisition Tool.  See that tool for 
details. 

5. Results Settings 

ShowResults List NONE / FRAME / 
LINE / POINT 

Standard Results Settings 
property

6. Results 
ResultErrorCode Integer   
ResultAngle Single -360 to 360
ResultXPos Single mm
ResultYPos Single mm

Standard Results properties

ResultActualTime Single sec
Actual time in seconds for 
operation to complete. [GPL: 
VisResult.Info(1)]

ResultPixelCount Integer   
Actual number of pixels detected 
during the operation. [GPL: 
VisResult.Info(0)]

Remarks 

This motion sensing tool acquires a series of pictures sequentially and compares 
successive images to detect how many edges are changing.  Based upon the number of 
changed edges, this tool decides upon whether any movement has been detected. 

This tool determines movement by performing the following operations.   First, it acquires 
a new image.  Then the new image is subtracted from the previous image.  A cross 
gradient edge extraction algorithm is performed across the resulting image and the edges 
are thresholded to produce a binary image.  The binary image is eroded to eliminate 
insignificant changes.  The resulting binary edges are counted and compared to the 
PixelChangeAmount to determine is sufficient pixels have changed to declare that 
movement has been detected.  Based upon the setting of the SenseMode property, this 
tool either takes another picture and repeats the process or it terminates.  

This tool requires successive images so a minimum of two pictures are always taken.   
During this operation, no graphics are displayed on the screen.  A dialog is placed above 
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the vision window to indicate that the operation is in progress and permits the operator to 
abort the tool. 

This tool can be applied in applications where parts may be falling or moving (e.g. rolling 
parts). Instead of applying a worst case fixed delay time, the Sensor Window Tool can be 
used to ensure the parts are not moving before locating or executing the remaining 
processes. 

Special Feature Buttons (located above the property list): 

Show Motion Image 

Displays the output of comparing a single pair of images. Any pixels that 
are detected as changed (moving) are drawn in white.  If zero motion is 
taking place, the entire image will be black. 

Test Motion (Continuous) 

Places tool in a continuous execution mode that allows the user to see 
the results of the motion dynamically. A small dialog box will appear in 
the center of the vision window that displays the number of pixel counts 
sensed as being in motion. Click the 'abort' button on the dialog to stop 
the test operation. 

See Also 

Vision Toolkit | Acquisition Tool | Edge Locator Tool
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Text Label Tool 
Text labeling tool that displays string constants plus inspection and results data from 
a referenced tool.  Text is shown in the Camera Display Window relative to the   

Properties 

position of the referenced tool. 

Prerequisites 

None 

Property Name Data 
Type Range  Description 

1. Identity 
Name String n/a 
Typ

s
e String n/a

Standard Identity propertie

2. Placement/Size 
Angle Single -360 to 360 
XPos Single 0 - AOI (mm) 
YPos Single 0 - AOI (mm) 
RelAngle Single -360 to 360 
RelXPos Single 0 - AOI (mm) 
RelYPos Single 0 - AOI (mm) 

Standard Placement / Size 
properties.  The X and Y values 

 the text 
 Angle defines the 

orientation of the text string. 

define the starting point for
output and the

3. Operation 
Camera Integer 1 - 6 Standard Operation property

SourceToolName List  n/a results are displayed by th
Name of the vision object whose 

is tool. 

EnableResultName Boolean  True / False specified by ResultToolInfo will 
automatically be included in the 

If True, the name of the results data 

output text string. 

ResultToolInfo List 
ResultYPos / 

This is a list of Inspection and 
t can be 

  The items in the list are 
 of the tool 

selected by SourceToolName. For 
most tools, at least the properties 

NONE / InspectPassed Results properties tha
displayed./ InspectFailed / 

ResultXPos / a function of the type

ResultAngle / ... listed in the Range field are 
available. 

TextColor Window 
Color n/a Permits the font color to be 

selected from the system color 
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Selector palette. 

TextForceZeroAngle Boolean  True / False   

If True, will force the output text 
string to have a zero Angle even if 
the text is relative to a source tool 
whose result is rotated. 

TextOutputType 
Defines if numerical values should 

List FORMAT_INTEGER / 
FORMAT_REAL be output as integer or real 

numbers. 

TextSize 
Specifies the font size of the output 

Integer  1 - 50 string as a Windows Font Size (not 
in pixels). 

TextTitle 

Optional string that is placed at the 
tput text. This 

 the 

 pipe 
ter is 
s will 

automatically be placed on the next 
line, including the results. 

start of the ou

String  n/a multiple lines use the delimiter
character '|'. When this charac
encountered, subsequent item

provides a way to customize
label for the results data. For 

5. Results Settings 

ShowResults List / POINT 
 Settings NONE / FRAME / LINE Standard Results

properties
6. Results 
ResultAngle Single -360 to 360
ResultXPos Single mm
ResultYPos 

lts propertiesStandard Resu

Single mm

Remarks 

 fixed positions in the Camera Display Window or 
relative to the results of other tools.  If the text tool is relative to a source tool, the text can 

rties of the 

Below is an exa xt L  e bjects that 
has been located by a Finder Tool is labeled with the Finder' nition score. 

This tool displays text labels either in

automatically include the values of selected Inspection and Results prope
source tool. 

NOTE:  This tool cannot be specified as one of the source tools in an Inspect List Tool. 

Examples 

mple of the Te abel Tool.  In this xample, each of the o
s recog
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See Als

Vision 

o 

Toolkit
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Tool Filte
Filte
of result he results based upon specified criteria.  

Prerequisites 

r Tool 
r tool that takes the output from another vision object that generates multiple sets 

s, and returns a subset of t   

Requires another vision object that generates multiple sets of results.  

Properties 

Property Name Data 
Type Range  Description 

1. Identity 
Name String n/a 
Type String n/a

Standard Identity properties

3. Operation 
Camera Integer 1 - 6 Standard Operation property

SourceToo
uts 
of 

results serve as the input to this tool.  
lName List n/a 

Name of the vision object that outp
multiple sets of results.  These sets 

3A. Advanced Operation  

SortResults List 

NONE / 
SORTFROMLEFT / 

SORTFROMRIGHT / 
SORTFROMTOP / 

SORTFROMBOTTOM  

Automatically sorts the results based on 
the selection. This is useful for items on 
a conveyor belt that may need to be 
picked in order from the front to back of 
the conveyor. 

ZeroAngle Boolean True / False  

If True, will force the ResultAngle to 
ZERO. This is useful for randomly 
oriented parts that require the angle to 
be removed for picking. This operation 
does NOT change the sorting 
operation.  

4. Inspection Settings 

InspectType List 

NONE / RESULT_ID / 
RESULT_X_POS / 
RESULT_Y_POS / 
RESULT_ANGLE / 

RESULT_INSPECT_-
STATUS  

InspectMax Single   
InspectMin Single   
InspectActual Single  

Standard Inspection Settings 
properties.  All of the sets of results 
generated by the SourceToolName 
object are tested against this inspection 
criteria and those that pass become the 
output of the Tool Filter. 
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InspectPassed List Pass / Fail  

InspectString String n/a 

Optional label that is displayed in the 
vision window on all input results that 
satisfy the inspection criteria.  This 
provides a convenient way to display 
part ID or other information. 

5. Results Settings 
MaxResults Integer -1 or 1 to n 
OffsetAngle Single degrees 
OffsetX Single mm 
OffsetY Single mm 
ResultSelect Integer 1 - n 

ShowResults List NONE / FRAME / LINE / 
POINT 

Standard Results Settings properties

6. Results 
ResultCount Integer 0 - n
ResultA lng e Single -360 to 360
ResultXPos Single mm
ResultYPos Single mm

Standard Results properties

Remarks 

This o
resu  
allows a
queues
the sam llow all of the results of the input tool to be segmented and 
processed. 

For example, if the input tool is a Finder, special processing can be applied to all objects 
loca
with the 

Examples 

rizontal position with the top of the "T" pointed to the right.  

 to s of 
lts, and applies criteria specified by the "Inspection Settings" to filter the results.  This 

 process to isolate results that require further special processing or to create 
 of results based upon specified criteria.  Multiple Tool Filters can be applied to 
e vision object to a

l inputs the results from another vision object that generated multiple set

ted by the Finder that are in a specific region of the screen by defining a Tool Filter 
InspectType set to "RESULT_X_POS" or "RESULT_Y_POS".  

Below is an example of a single Finder that has located 6 identical parts.  You will note 
that the bottom left part was used as the tool template, so that all future part orientations 
will be with respect to this ho
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If we now wish to segment these 6 parts by their orientation, we can apply a Tool Filter 
that references the output of the Finder by specifying the Finder's name as the Filter's 
SourceToolName.  By setting the Tool Filter's InspectType to "RESULT_ANGLE", we 
can select only those parts with a specific orientation.  If we set the InspectMin and 
InspectMax to -90 degrees and 90 degrees respectively, only those objects that are 
approxi
add a la .  The picture below shows the 
results o
that only
wanted 
input to 

mately pointed to the right will be selected as the output of the Filter.  We can also 
bel to these parts by filling in the InspectString
f this filter where InspectString has been set to "Pointed Right".  You will note 
 four of the six parts located by the Finder will be output by the Tool Filter.  If we 
to further process these four parts, the Tool Filter output could be utilized as the 
yet another tool.  

 

See Also 

Vision Toolkit | Finder Tool 
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Camera Calibration Introduction 
The PreciseVision camera calibration procedures generate the data necessary to convert camera pixel 
positions into real world units of measure, typically millimeters. For robot guidance, this calibration also 
translates camera positions into the robot's world coordinate system.  This permits a robot to grasp a part 
that has been located by the vision system.  Consequently, a camera must be calibrated with respect to a 
robot before a vision-guided application can be executed.  Even for simple vision testing where 
PreciseVision is not communicating with a robot, calibration is still highly desirable (but not required), 
since the calibration process corrects for non-square pixels and cameras that are not perfectly 
perpendicular to the imaged plane, which causes perspective distortion.  This correction is important as 
parts rotate to ensure that dimensions are always computed the same independent of the part's 
orientation. 

So, when a camera is first put into use, it should be calibrated.  In addition, calibration data should be 
updated if a t camera 
lens is used or t h 
camera that is p henever any of the optical characteristics of a camera are 
modified. 

In the next section, general instructions and information that apply to all calibration methods are 
presented.  This is followed by information concerning the various calibration methods. 

section should be read prior to executing any of the calibration methods.  

Standard Calibration Target Sheet

 camera with different optical characteristics is utilized, a camera is moved, a differen
he length to the focal plane is altered. In general, it is always best to calibrate eac
laced into service and w

General Calibration Instructions 
This section includes descriptions of general procedures that apply to all calibration methods.  This 

 

All calibration s and 
millimeters. andard 
Calibration T g squares that have a known size and pitch. Three 
different pa  sheet can 
be used wit

 m establish the conversion between camera pixel position
 In most cases, PreciseVision determines this relationship based on viewing a St

et Sheet that contains 

ethods are required to 

ar patterns of 
ttern sizes are provided to accommodate different camera fields of view.  The target
hout a robot or any automatic motion. This sheet looks like the following: 
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This target sheet is provided as a .pdf file and can be found via the Windows Start menu: 

Start > Programs > Precise Automation > PV xxx > Documentation > 
PreciseVisionCalibrationTarget.pdf 

or by browsing t reated upon installation of PreciseVision. 

\Progra
#.#\reso

The calibrat nd quality.  When 
you are instructed to do so, this sheet should be placed in the focal plane of the camera. The focal plane 
of the came ures to be 
located or in

Camera Se

o the “\resource\” folder c

m Files\Precise Automation\PreciseVision 
urce\PreciseVisionCalibrationTarget.pdf 

ion target sheet should be printed out at the highest possible resolution a

ra should be as close as possible to the actual Z height of the primary part feat
spected. 

tup 

Prior to executing a calibration process, the camera must be rigidly mounted, selected in software and 
carefully setup. The camera can be selected from the View > Select Camera top-level menu.  The 
aperture and focus can then be manually set by viewing the camera image in "live video" mode.  If the 
camera is not in this mode, it can be initiated by pressing an icon in the main toolbar.  Finally, the camera 
gain and offset that control the brightness and brightness range should be set by selecting Tool > 

Camera Calibration Wizard

Camera Video Properties .  
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When you select Tool > Calibrate Vision > Camera Calibration Wizard, a wizard is initiated and the 
following pop-up is displayed. 

 

This wizard takes you step-by-step through the process of calibrating a camera either for standalone 
vision or for a vision-guided robotic application with the camera mounted in a variety of configurations.  
The instructions are fairly self-explanatory. 

While each page of the wizard is different, the following toolbar buttons are available on every page to 
assist you with the calibration process. 

CalibrationWizard Toolbar 

Icon Tool Tip Title Description 

Live Video  Continuously updates the displayed camera image to 
show a "live" image.   

 Single Picture Captures a single picture (snap shot) from the selected 
camera.  

 Load Robot Calibration  

Displays a pop-up file folder window that permits an 
existing vision calibration file to be selected and loaded. 
This allows an old calibration file to be loaded and 
tested.  

 Save Robot Calibration  Displays a pop-up file folder window that permits the 
current calibration data to be saved to a disk file.  

Continuous Threshold  displayed camera image as a thresholded 
binary image instead of the standard gray scale.  
Updates the 

 

 Open Threshold Tool  Displays the pop-up that permits changing the 
threshold for the binary image.  

 Reset Calibration  Provides a way to reset the camera calibration to its 
default (unity scaling).  
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Calibration Layout  

e Camera CalibratioWhen th n Wizard is selected, the layout of the main PreciseVision window 
automatically changes to the following "Calibration Layout". 

 

This arra era Display Window on the left and a panel on the right that is 
provided as a convenience for mov mera-
to-robot calibration is performed.  T ot 
controll nection is ve.  

To switch back to the default arran ts > 
Load Defa youts >

Calibration Data Files 

ngement has a large Cam
ing a robot in manual control.  The robot panel is utilized if a ca
he Calibration Wizard includes a panel for connecting to a rob
 established, the manual control panel becomes acti

gement for the main Prec

er.  When this con

iseVision window, select View > Layou
 Load Edit Layout.  ult or View > La

 

Calibra n is stored in  in 
the “ExampleProjects” folder in the nstallation 
directory for PreciseVision version tory:  

m Files\Pr

fter a calibration data disk file has been created, it has to be specified in each Vision Project in which it 
 to be used.  When a Vision Project is opened, to associate a calibration file with a camera, open the 

Camera Calibration Configuration pop-up by selecting Tool > Camera Calibration Configuration.  The 
pop-up panel should appear as follows: 

tion informatio  disk files with a “.dat” extension. By default, these files are stored
 PreciseVision directory. For example, for the default i
 1.2, the calibration files will be stored in the following direc

ecise Automation\PreciseVision 3.0\ExampleProjects  C:\Progra

A
is
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Click the Load button to select a calibration file to be associated with a camera.  A dialog window will b
displayed that will allow you to browse to the directory location that cont

e 
ains the calibration (.dat) file. If 

on 

All of the calibration methods including standalone vision (Camera Only) and robot guidance begin by 
easure, typically millimeters.  In 

n the camera is not perfectly 
perpendicular to the plane of t era's coordinate system is 
set to the bottom left-hand cor

r 
ation 

p is not 

This procedure relies upon the Standa d does not require a robot or any 
automated motion.   

 Calibration Instructions

you wish to delete an association between a camera and a calibration file, click on the Reset button. 

Once a camera calibration file is specified in the Camera Calibration Configuration menu, the calibrati
will automatically be applied whenever a picture is acquired from the referenced camera.  Also, whenever 
the Vision Project is opened, the specified calibration files will be automatically opened and reloaded. 

Basic Camera Calibration 

calibrating the camera's pixel coordinate system into real world units of m
addition, this procedure adjusts for perspective distortion, which occurs whe

he objects to be located.  The origin of the cam
ner of the camera image.   

After this basic calibration is completed, the vision system can be used for metrology operations or fo
other applications not needing a robot.  However, since this step does not include a transform
between the camera frame of reference and the world coordinate system of a robot, this ste
sufficient for vision-guided robot applications. 

rd Calibration Target Sheet an

Prior to executing the Calibration Wizard, the following steps must first be performed: 

• The "General " section of this manual should be read.  
dard Calibration Target Sheet must be printed and available.  

• 

The Calibration Wizard is f elf-ex llowing p ation for 
first time us

• The Stan
The camera must be rigidly mounted, selected, and accurately setup in terms of 
its focus, aperture setting, and gain and offset. 

airly s planatory.  The fo rovides some additional inform
ers.  
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»   To start this method, select Tool > Calibrate Vision > Camera Calibration Wizard. 
 
»   Advance past the title page by pressing the N ibration process ext key.  You can stop the cal
at anytime by pressing the Cancel key. 
 
»   Select the type of camera c you wish to perform.  Camera Only will not perform the alibration 
camera to robot calibration and is only appropriate for testing a one vision.  nd standal

 

»   Advance to the next page and specify the siz g. e of the calibration target you will be usin
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This page permits you to select from one of the standar on 
Calibration Target sheet or to manually enter the target ameters if you have generated a 
custom sized target that is more appropriate for your ap n 
that is fully visible within the camera's field-of-view.   

The standard target has black squares printed on a whi
normally always be checked.  

d sizes that are provided on the PreciseVisi
dimension par
plication.   You should select the largest patter

te background, so the Dark Squares should 

»   Place the Calibration Target Sheet in the sam art e focal plane that you expect the primary p
features to be located.  Position the sheet such  visible that the pattern you have selected is fully
in the field-of-view. 
 
»   Advance to the next page of the Wizard to adjust the binary threshold of the image and to 
set the size a  t ontainnd position of he AOI that c s the target.  

 

a Window and adjust the size and position 
ed outline completely surrounds 

As instructed in the Wizard, you should view the Camer of the 
red square outline using the green handles so that the r the calibration 
squares. 
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Whe  image is th ed, it w ows: n the reshold ill appear as foll

 

»   Follow the Wizard's instructions to compute age. the camera calibration using the target im
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At the completion of the process, the Camera Window will appear as shown above, which indicates how 
vision tools were used to locate the calibration squares.  Each of the four sides of each square should 
have been automatically and accurately located with a Line Fitter tool. If a message indicates that an 
error has occurred, most likely, the Threshold value or the Dark Target check box were not set correctly.  

This completes the Basic Camera Calibration procedure. 

Robot Vision Camera Calibration 
After the Basic Camera Calibration is completed, if vision is being used with a robot, the transformation 
from the camera's frame of reference to the robot's world coordinate system must be computed.  This 
information permits PreciseVision to send object X/Y/Z/Theta values to a motion controller in a form that 
can easily be used to define a pick-up location.  PreciseVision includes several different methods for 
performing this calibration because cameras can be mounted in a number of different positions (e.g. fixed 
in a stationary position, mounted on a link of the robot, etc.).  

Since the instructions for executing the Calibration Wizard are fairly self-explanatory, this section includes 
just an overview of the methods that are common to all of the procedures. 

In general, these methods compute the calibration data by having the operator move a customer supplied 
calibration disk to several positions in the camera's field of view.  At each position, a gripper or pointer 
attached to the robot must be moved to the same position to establish a correspondence between vision 
positions and robot positions.  In order to execute this procedure, the robot's controller must be powered 
up and properly setup so that it can be safely operated. 

Prior to executing this calibration method, the following steps must first be performed: 

• The "General Calibration Instructions" section of this manual should be read.  
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• The Standard Calibration Target Sheet must be printed and available.  
• The camera must be rigidly mounted, selected, and accurately setup in terms of 

its focus, aperture setting, and gain and offset. 
• 

The calibration methods typically rely upon locating the center of the disk at 
several different positions.  Consequently, if the disk is too large, its size would 
limit the maximum distance between center points. The color of this disk should 

th the background. The disk should also 
 aligning the center of the pointer with the 

A circular, relatively flat calibration disk and a pointer or gripper mounted to the 
tool flange of the robot must be obtained. The calibration disk's diameter is 
recommended to be roughly 10-15% of the width of the camera's field of view. 

be selected to maximize its contrast wi
have a feature that aids the user in
center of the disk. 

• The Guidance Controller for the robot must be powered on and interfaced via 
Ethernet to the PC that is executing PreciseVision. 

• The robot must be homed and capable of being moved.  Some procedures do 
not require the robot to be moved automatically or under power, while other do. 

 
required to permit the robot to be manually or automatically repositioned
must be in place. For the Precise robots, this information is provided 
robot's Hardware Introduction and Reference Manual.

DANGER: Before proceeding with this procedure, please ensure that the 
robot has been properly mounted, all required safety interlocks have been 
installed and tested, and power has been connected. All safe guards 

 
in the 

 

The following ge  robot 
vision calibratio

neral instructions and pictures illustrate the concepts at are common to all of the
n procedures. 

»   W er and hen prompted by the Calibration Wizard, specify the IP address of the robot controll
press Connect to establish an Ethernet connection between the PC and the controller. 

 

211 



PreciseVision 

This connection is required in order for PreciseVision to automatically read the position of the robot and to 
permit ma ual control panel 
in the mai dard web 
based Vir

As you execute the Wizard, you will be presented with various options for teaching locations, selecting 
g the robot automatically to return to picture locations or to clear the 

ependent upon the specific camera calibration method being 

n disk in different positions within the 
camera's field of view, and recording the robot's corresponding positions.  

The following series of pictures illustrates how a disk is moved to various quadrants of the camera's field 
of view and Pre sition, the 
robot's location 

nual and automatic control of the robot.  After this connection is made, the man
n PreciseVision window will become active, although a hardware MCP or the stan
tual MCP can be used as well.  

the teaching method, and movin
picture area.  These options are d
performed. 

Independent of the specifics of the calibration procedure, fundamentally, all of these methods provide a 
means for taking multiple pictures, visually locating a calibratio

ciseVision locates disk and marks the spot with a circular indicator.  At each po
also needs to be recorded. 
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ill automatically compute the required transformation
is then stored in a camera calibration file along with

After this or similar data is collected, PreciseVision w  
between the camera and the robot.  This information  
the camera calibration data for subsequent use. 

This completes the o ot Vision Areverview of the Rob a Camera Calibration procedures. 
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Appendi

Frequently Asked Questions 
This section contain eque k

A. General Questions  

1.  What do you do if PV was working but wil

x A: FAQ 

ed questions related to PreciseVision.  

l no longer properly start up?

s a compilation of fr ntly as

 
er host computer?2.  How do I transfer my PV license to anoth  
eVision?3.  What PC TCP/IP ports are used by Precis

B. DALSA Cameras 

1.  What does the DALSA camera LED indicate? 
an image with a DALSA camera?2.  What do you do if you are not able to get  
ing after DALSA drivers are installed?3.  What do you do if other NIC's stop operat  

A camera image?4.  How do you eliminate diagonal stripes in the DALS

C. IDS uEye USB Cameras 

1.  What do you do if you are not able to get an image with an IDS or USB camera? 
 parameters are available?2.  What IDS uEye camera trigger and strobe

General Que

What do you do if PV was working but will no longer properly start up?

stions 

 

Sometimes the prefe  for PreciseVision can become corrupted or can reference a PV 
project that  corrupt curs, PV will fail to launch.  To work around this problem, do the 
following. 

1. Loc seVision is installed. Typically, this will be 
"C:\P ise Automation\PreciseVision V__\". 

2. Ren s file "Preferences.vpr" to "Preferences.bad". 
3. Restart 

If PreciseVision sta ail your bad Preferences file and your PreciseVision projects to 
support@preciseaut  short explanation so we can diagnosis the problem. 

  

rences information
ed.   When this ocis

ate the folder where Preci
rogram Files\Prec

ame your preference
PreciseVision. 

rts properly, please em
omation.com with a
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How do I transfer my PV license to another host computer? 

e on a single PC.  In general, if you need to exe
rchased. 

e is being obsoleted, you can transfer a purchased 

dure, PV will no longer be permitted to execute 

erform the following procedure. 

stalling PV on the ne

The PreciseVision software is only licensed to execut cute 
PV on additional PC's, additional licenses must be pu

However, if the PC on which PV is licensed to execut
PV license t  a new

Note, as soon as you execute the following proce
on your old PC. 

To transfer a purchased PV license to another PC, p

1. Follow the standard procedure for in w

o  PC.  

 PC. 
2. On the new PC, execute the proced

information.  This is needed to issue
 Execute PV 2.0 or later on the old

ure for licensing PV to obtain the PC's ID 
 you a new license for this PC. 

3.  P
PV, obtain a new version from the P
old

C.  If you are executing an older version of 
recise Support website and install it on the 

 PC. 
4. Select "Help > Product Activation". 
5. Click the "Uninstall" button. 
6. Follow the instruction to execute the uninstall procedure.  After you execute this 

proce  longdure, you will no er be able to execute PV on the old PC. 
les@preciseautomation.com and request 7. Email t formation to sa

that the license be transferred. 
o Your company name 
o The name of the individual that the license was issued to, if you know 
o The original license code dis
o The uninstall code displayed
o The new PC's ID displayed b

8. Once you obtain your new license key, e
new

he following in

played by the uninstall procedure 
 by the uninstall procedure 
y the licensing procedure 
xecute the standard activation process on the 

 PC. 

This com h s.

What PC TCP/IP ports are used by Precis

pletes t e license transfer proces  

eVision? 

om a Precise Controller. PreciseVision Remote PC PreciseVision listens on port 1410 for connections fr
control listens on port 1450 for connections from a command client. If you are using the Multi-Instance PV 

rts numbers are incremented by 1 for each additional instance, as shown below. option, the po

PV Instance GPL to PV Port Remote PC Control 
Port 

1 1410 1450 
2 1411 1451 
3 1412 1452 
4 1413 1453 
5 1414 1454 
6 1415 1455 
7 1416 1456 
8 1417 1457 
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DALSA Cameras 

What does the DALSA camera LED indicate? 

The back surface of the DALSA camera that contains the Ethernet and DC power plugs includes an LED 
that indicates the current status of the camera.  The interpretation of the LED's color and blinking state is 
described in the following table. 

LED State Camera Status 

TO Tff Camera is not receiving power 
Steady Red Camera is not initialized 

Slow Flashing Red Camera initialization problem.  Most likely indicates a 
camera hardware failure. 

Fast Flashing Red Camera is too hot 
Slow Flashing Blue Waiting for an IP address 
Fast Flashing Blue Ethernet cable disconnected (no link) 

Steady Blue IP address assigned, PreciseVision not connected to 
camera 

Steady Green PreciseVision connected to camera, standard 
operational state 

Slow Flashing Green Camera waiting for hardware trigger to take picture 

Fast Flashing Green Continuous acquisitions in progress, standard live 
video state 

  

What do you do if you are not able to get an image with a DALSA camera? 

If you are not able to get a image from a DALSA camera from within PreciseVision, there are several 
possible sources for this problem.  Most of the problems and remedies described below apply to systems 
that are being executed for the first time, but some are appropriate for systems that have already 
operated. 

A.  The DALSA camera may not be configured as the hardware to use within PreciseVision.  
PreciseVision can operate with a variety of Ethernet camera devices and can even operate in a 
demonstration mode without a camera.  However, at any given time, only one camera type is permitted.  
The following procedure verifies that PreciseVision is configured to capture images from DALSA cameras. 

1. Launch PreciseVision, typically by selecting TStart > Programs > Precise 
Automation > PV_ > PreciseVision.T 

2. Open the Preferences pop-up by selecting the following within PV:  TFile > 
PreferencesT. 

3. Select the "Camera Hardware" tab in the Preferences pop-up window. 
4. Ensure that the "Genie" option is selected.  You can also click on "Genie 

Mapping" to specify the logical camera number associated with each physical 
camera. 



Appendix A:  FAQ 

219 

 

B.  The required software drivers may not be installed.  The use of the DALSA cameras with PV 
requires the installation of three separate software packages on a Windows PC system. 

1. To verify that all three software packages have been installed, bring up the 
Windows Control Panel typically by selecting TStart > Settings > Control Panel.T 

2. Select T"Add or Remove Programs".T 
3. Verify that the following packages are installed:  (i) DALSA Coreco Sapera LT, (ii) 

DALSA Genie Framework, (iii) DALSA Sapera Network Imaging Package, and 
(iv) PreciseVision. 

4. If any of these packages are missing, refer to the PV installation instructions for 
installing the missing application packages. 

C.  No cameras found by the PC.  Typically after the software is installed and the PC is rebooted, any 
DALSA cameras will immediately be located by the PC and be accessible.  However, if you click on the 
small camera icon that is displayed in the Window's start bar  and see the "No Device Found" 
message in the Device's pop-up, it means that the PC could not locate a camera on its local Ethernet 
Network. 

 

1. Verify that the camera is receiving power and is properly connected to the 
network.  The LED on the camera should have initially been red and then 
changed to a blue color.  If the LED is not lit or is red, either the camera is not 
receiving power or is defective or is not connected to the network. 

2. If the camera LED is blue, the PC's firewall or virus protection is probably 
blocking the camera connection.  Disable your PC's firewall and turn off any virus 
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protection.  If the camera becomes visible by the PC, go to the DALSA website 
(Twww.imaging.comT) for information on how you still might be able to enable your 
virus protection or firewall. 

D.  The camera may not have an IP address compatible with your PC.  Normally, the camera will 
automatically obtain an IP address from a DHCP server within your network.  However, a DHCP server 
may not be available or the camera may have been set to a fixed (Persistent) IP address that is not 
consistent with your network.  If you click on the small camera icon that is displayed in the Window's start 
bar  and see "IP Error" in the Status area of the Device's pop-up, it indicates that the IP address of the 
camera is not set compatibly with your Ethernet network. 

 

1. Execute the "TDALSA Network Configuration ToolT".  Typically this is launched by 
selecting TStart > Programs > DALSA > Sapera Network Imaging Package > 
DALSA Network Configuration Tool.T 

 

2. Click on the Ethernet network interface card (NIC) that is connected to the 
camera. 

3. Select the "NIC Configuration" tab on the right.  This tab will permit you to 
change the IP address of your PC. Change the IP address and subnet mask to 
be compatible with the address of the camera as displayed in the Devices 
window shown above.  For example, in the previous picture, the camera IP 
address was 169.254.241.145.  IP addresses whose first number are between 
128-191 fall into Class B and require a subnet mask of 255.255.0.0.   Set a 
compatible IP address and subnet mask and click "Apply". 

4. After you have selected a compatible address, the camera information should be 
displayed in the left hand window below the NIC.  If you click on the camera 
information, its IP information will be displayed on the "Device Configuration" tab 
as shown below.  
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5. Enter the desired IP address and subnet mask for the camera and press "Apply". 
6. Repeat steps 2 and 3 to reset your PC to the previous IP information. 
7. Close the Devices window and double click on the camera icon in the start bar to 

redisplay this window.  The status should no longer indicate an IP Error. 

E.  The camera Ethernet drivers may be incorrectly configured.  If the camera and its Windows 
drivers are compatible and properly configured, the CamExpert Windows applications should always be 
able to display a live camera image. 

1. To test the camera and its Windows driver, launch the DALSA CamExpert, 
typically by selecting TStart > Programs > DALSA > Sapera LT > CamExpert. T  You 
should see the following application window.  
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2. Click on the camera listed in the top-left hand window and click the "TGrabT" button 
above the camera display window. 

3. If the camera and its Windows drivers are operating properly, you should see live 
camera video in the camera window and the "Frame/sec" above the video should 
be displaying the frame capture rate.  If this is all correct, close the CamExpert 
and restart PreciseVision T(NOTE:  The CamExpert and PV can not be 
executed simultaneously).T  PreciseVision should now be able to capture 
images. 

4. If the live video output of the camera was not displayed, try disabling 
unnecessary NIC's (especially wireless NIC's) by opening TMy Network Places > 
View Network Connections T.  Right click on unnecessary NIC's and select 
T"Disable"T.  

 

5. If this did not resolve the problem, try disabling all unnecessary software options 
associated with the NIC connected to the camera.  To do this open TMy Network 
Places > View Network ConnectionsT. 

6. Double click the NIC attached to the camera to display the "Local Area 
Connection" window. 

7. Click on the "Properties" button. 
8. In the Properties window, uncheck all software services except for "CorSnid 

Driver" and "Internet Protocol (TCP/IP)", and press "Ok".  
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9. If this does not resolve the problem, there may be a fundamental incompatibility 
between your NIC and the DALSA camera.  Please contact Precise Automation 
for further assistance. 

  

What do you do if other NIC's stop operating after DALSA drivers are installed? 

When you install the DALSA camera drivers, they automatically add camera specific software that is 
executed as part of the driver for every Ethernet card (NIC) in your PC.  For certain NIC's, this additional 
software can cause the Ethernet interface to malfunction even if you do not connect to a camera using 
this device.  This seems to often be the case with wireless Ethernet interfaces in particular. 

To disable the DALSA specific software for a NIC, do the following: 

1. Access the software options for the NIC by opening TMy Network Places > View 
Network ConnectionsT. 

2. Double click the NIC that is causing the problem to display the "Local Area 
Connection" window. 

3. Click on the "Properties" button. 
4. In the Properties window, uncheck the software labeled "CorSnid Driver" and 

press "Ok". 
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How do you eliminate diagonal stripes in the DALSA camera image? 

You may sometimes see a blinking pattern of diagonal stripes in the live video image generated by a 
DALSA camera.  For example, in the image below, the true image should be a grid of horizontal and 
vertical lines.  Interspersed in the grid is a pattern of diagonal lines that is not in the real image. 
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This pattern of lines is due to a problem with the DALSA communications buffer size.  To correct this 
error, do the following:. 

1. Exit from PreciseVision. 
2. Start the DALSA CamExpert application.  Normally, this can be launched from 

the Start bar by selecting:  TStart > Programs > DALSA > Sapera LT > 
CamExpertT. 

3. Press the "Grab" button to verify that the problem can still be seen. 
4. Press the "Grab" button again to stop the live image capture mode. 
5. In the "Camera Information Parameters" table, select the "GigE Vision" tab. 
6. Change the "Network Configuration Mode" from "Automatic" to "Manual". 
7. Decrease the size of the "Packet Size (in Bytes)".  This value might be set to 

1984.  Set it to 1500 instead. 
8. Press the "Grab" button to verify that the problem has been corrected. 
9. Exit the CamExpert application, saving your changes and restart PreciseVision. 

  

IDS uEye USB Cameras 

What do you do if you are not able to get an image with an IDS or USB camera? 

If you are not able to get a image from an IDS or other USB camera from within PreciseVision, there are 
several possible sources for this problem.  Most of the problems and remedies described below apply to 
systems that are being executed for the first time, but some are appropriate for systems that have already 
operated properly. 
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A.  IDS uEye/USB cameras may not be configured as the hardware to use with PreciseVision.  
PreciseVision can operate with a variety of USB and Ethernet cameras and can even operate in a 
demonstration mode without a camera.  However, at any given time, only one camera type is permitted.  
The following procedure verifies that PreciseVision is configured to capture images from IDS uEye or 
other USB cameras. 

1. Launch PreciseVision, typically by selecting TStart > Programs > Precise 
Automation > PV_ > PreciseVision.T 

2. Open the Preferences pop-up by selecting the following within PV:  TFile > 
PreferencesT. 

3. Select the "Camera Hardware" tab in the Preferences pop-up window. 
4. Ensure that the "Direct Show (USB)" option is selected.  
5. Restart PV to put this change into effect. 
6. Return to this panel and click on the "DS Mapping" button to select the USB 

cameras to utilize and define their operational parameters:  image resolution, 
color or grayscale mode, and whether the image is to be reversed. 

 

B.  The required software packages may not be installed.  To utilize the IDS uEye cameras with PV 
the following software must be installed on the PC: PreciseVision, DirectShow (DirectX) and the IDS 
camera driver.  DirectX is shipped as part of the Windows operating system and should therefore not be a 
problem.  However, if the other software packages are missing, you will not be able to capture camera 
images. 

1. To verify that all of the required software has been installed, bring up the 
Windows Control Panel typically by selecting TStart > Settings > Control Panel.T 

2. Select T"Add or Remove Programs".T 
3. Verify that the following packages are installed:  (i) IDS uEye, and (ii) 

PreciseVision. 
4. If either of these packages are missing, refer to the PV installation instructions for 

installing the missing application packages. 
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C.  Cameras may not have proper unique or registered ID's.  Each IDS camera must have a unique 
ID stored into its NVRAM and these ID's must be registered with DirectShow in order for PreciseVision 
communicate with the camera.  If an IDS camera is being used and it has the default ID of "1", it should 
be possible to communicate with the camera.  However, if multiple IDS cameras are being used or the 
default camera ID is not set to "1", one or more cameras may not be operating properly. 

Please refer to the PreciseVision IDS Camera Interface Installation section for instructions on setting the 
camera ID's and registering the ID's with DirectShow. 

D.  The camera resolution or display mode may be incorrect or incompatible.  USB cameras 
typically have several different resolutions that they will operate at and several different formats that can 
be used to fetch their image data.  The formats that are supported by PreciseVision and its DirectShow 
interface, which are the most common formats, are as follows: 

RGB8 (8-Bit Grayscale) 
RGB24 (24-bit color with 8-bit R,G,B components) 
YUY2 (16-bit color) 

All IDS cameras have resolutions and formats that are compatible with PreciseVision.  However, if you 
are not able to view the image, please refer to the IDS Camera Interface Installation section for a 
description of how to select the resolution and display format. 

If you are using a third party camera, there is a possibility that your camera driver does not support 
DirectShow or that it does not have an image format that is compatible with PreciseVision.  If this is the 
case, you will not be able to use the camera with this software.  However, please refer to the IDS Camera 
Interface Installation section for a description of how to select the resolution and display format to see if 
these setting can resolve your problem.  Please keep in mind that Precise cannot provide assistance 
with cameras that are not tested and fully supported by Precise. 

What IDS uEye camera trigger and strobe parameters are available? 

Most IDS uEye cameras have a hardware input signal for triggering the start of a camera acquisition and 
a hardware strobe output signal for triggering a strobe to freeze moving parts.  In their native operating 
mode, IDS cameras provide a number of parameters for controlling the operation of these two hardware 
signals.  Unfortunately, IDS does not currently provide the full set of parameters when a camera is 
operated via DirectShow, as is the case for PreciseVision. 

The following table describes the parameters that can currently be modified within PreciseVision and the 
fixed values for those parameters that cannot currently be altered. 

IDS Camera Parameter Setting Within PreciseVision 

Trigger Mode 

This specifies if the trigger occurs on the rising or falling edge 
of the external hardware input trigger signal.  This parameter 
can be specified within PreciseVision by setting the 
TriggerActive property of the Acquisition Tool that defines 
the picture to be taken. 

Trigger Delay 
This defines the delay between when an external hardware 
trigger signal is received and the start of the camera 
acquisition.  This is currently fixed at 0 microseconds. 

Flash Delay 
This is the delay between when an external hardware trigger 
or internal software trigger (from PreciseVision) arrives and the 
strobe output is asserted.  This is currently fixed at 0 
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microseconds. 

Flash Duration 
This is the time that the hardware output strobe signal is 
asserted high when the strobe is triggered.  This is currently 
fixed at 5000 microseconds. 
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Appendix B: Remote PC Control 

PreciseVision Remote PC Control 
Even though PreciseVision executes as a standalone application within a PC environment, its user 
interface and vision processing capability can be integrated with the user interface of another PC 
application.  PreciseVision provides the ability for any PC application to send commands to PreciseVision 
using TCP/IP.  These commands can specify the format of the PV window and its size and position on the 
screen.  This set of commands also includes methods for triggering the execution of vision processes and 
for reading and writing data within PreciseVision.  So, these commands allow any PC application 
environment to manipulate PreciseVision to look and feel like it is part of the environment without the 
need for complicated installation of COM objects or distribution issues. 

The communication interface uses simple string messages that are passed through an open TCP socket 
connection.  When PreciseVision begins execution, it automatically runs a remote TCP server in a 
background thread.  This thread listens on port (1450) and is dedicated to servicing commands from 
external applications.  This interface can be tested and debugged using any Telnet session connected via 
the communication port. 

Whenever the communication connection is lost, the PV user interface is automatically restored to its 
normally stand alone mode, i.e. the form title, status, menu and toolbars are all displayed. 

Command Definition 

Each transmitted command must conform to the following string format: 

command [key] arg1 arg2 arg3 … arg20 {LF} 

While in Telnet mode, the command response may be as simple as a {LF} or it may be a string that 
returns requested information.  Please see the command description table below for details. 

In general, the format of the response returned for each command is formatted as follows: 

errorcode arg1 ... argN {LF} 

If no error occurs, the returned "errorcode" will have a value of "0" to indicate success.  If an error occurs, 
a negative error code is returned and "arg1" contains the string representation of the error.  For some 
commands, "arg1 ... argN" contains information returned by PreciseVision.  

Supported Commands 

The following table describes the legal commands.  Please note that the CMD name is case sensitive. 

CMD KEY Argument List Description & Responses 
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getnumresults   T<tool>T 

Retrieves the number of results that exist for 
the specified tool.  The T<tool>T must be of the 
form Tprocessname.toolname.T 
 
The information returned by this command is 
as follows: 
 
T    <err> <num_results> T 
where 
    T<err>T:    Standard error code or 0 for 
success. 
    T<num_results>T:   The number of results 
available for this tool. 

getresults   T<tool> <index> T 

Retrieves the numeric results for a specified 
tool that was executed as part of a specified 
process. The T<tool>T must be of the form 
Tprocessname.toolname.T 
 
The information returned by this command is 
as follows: 
 
T    <err> <x> <y> <z> <yaw> <pitch> <roll> 
<objectID> <passed> <value> <info_array> T

TwhereT 
T    <err>:T         Standard error code or 0 for 
success. 
T    <x> <y> <z> <yaw> <pitch> <roll>:  T 
Cartesian coordinates for the located object.
T    <objectID>T:  Optional index that some 
tools return to identify the specific instance of 
an object that is located.  
T    <passed> T:    0 if tool's inspection was 
successful or -1 if the inspection failed.  
T    T<value>:     Value of the tool property that 
was tested by the vision inspection process. 
T    <info_array> T:  Please see the information 
on the specified tool for a description of any 
additional result values that are returned.  

getstringresults   T<tool> <index> T 

Retrieves the results for tools that return a 
string value instead of numerical results. For 
example, this command should be used for 
the Barcode Reader tool.  The T<tool>T must 
be of the form Tprocessname.toolname.T 
 
The information returned by this command is 
as follows: 
 
T    <err> <string>T 
TwhereT 
T    <err>:T         Standard error code or 0 for 
success. 
T    <string> T:    String value that is returned by 
the tool.  This is identical to the output that is 
sent to a Guidance Controller.  Please see 
the information on the specified tool for a 
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description of any string result values that 
are returned.  

load image T<file_name>T 

Loads an image from a specified file into the 
camera display buffer. 
 
    T<file_name>T:   The full path and name of a 
image file to be loaded. 

load importproject T<file_name>T 

Loads a PreciseVision project from a 
specified file and mergers its contents with 
the currently loaded project. If the new 
project contains any processes or tools 
whose names conflict with items that are 
already loaded, "_r" is appended to the name 
of the new item. Also, any camera calibration 
information that is contained in the new 
project is ignored. 
 
    T<file_name>T:   The full path and name of 
the PreciseVision project file to be loaded 
and merged.  

load layout T<file_name>T 

Loads a window layout given a specified 
path and file name. 
 
    T<file_name>T:  The full path and name of a 
compatible PV layout file.   This type of file is 
created when a layout is manually saved. 

load project T<file_name>T 

Loads a PreciseVision project file from the 
disk. 
 
    T<file_name>T:   The full path and name of 
the PreciseVision project file to be loaded. 
This allows a PC based application to 
change the project or override the default 
project loaded when PV starts. 

property set/get T<property> 
<value> T 

Reads or writes the value of a specified 
property of a specified tool.   The T<property>T 
must be of the form Ttoolname.propertyname.T

 
For write operations,T <value> Tdefines the 
new property value that is set.  
 
Not all properties are available for reading 
and/or writing. Please see the vision tool 
definitions for details on each tool type's 
properties.  
 
As a means for transmitting system 
information between PreciseVision and 
Precise Guidance Controllers, a special built-
in T"System"T tool always exists.  For the most 
part, this tool duplicates functionality 
available via explicit Remote PC Control 
calls.  However, some functionality is only 
available via the System tool.  If required, the 
System tool can be accessed by specifying it 
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as the Ttoolname T in this command.  For a 
explanation of the available Tpropertyname' Ts, 
please consult the TGuidance Programming 
Language Dictionary Pages T. 

run   T<process>T 

Initiates execution of the specified vision 
process. 

set displaymode T<mode>T 

Dictates the contents and visibility of the PV 
window.   The permitted values for T<mode>T 
are as follows.  
 
    0: Resets display mode to normal display. 
PV returns to stand alone mode with all 
normal windows, toolbars, menus etc. 
available for use. 
    1:  Displays only the camera window and 
the current Tool's window.  The PV form 
border, title, and status bars are all hidden. 
    2:  Displays only the camera window. The 
PV form border, title, status bars and all 
dockable controls are all hidden. 
    3:  Minimizes the PV window. 

set layout T<layout_type>T 

Selects one of the predefined panel layouts 
to display within the PV window based upon 
the value of T<layout_type>T: 
 
    0:   Edit mode 
    1:   Runtime mode 
    2:   Calibration mode 

set position T<xpos> <ypos> 
<width> <height>T 

Positions and sizes the PV window relative 
to the screen. 
 
    T<xpos>T:   X position relative to top left of 
screen 
    T<ypos>T:   Y position relative to top left of 
the screen 
    T<width>T:   width to set window 
    T<height>T:  height to set window 
 
All units are in pixels. 
 
Note: T<width> Tand T<height>T are optional. If 
not specified, only the X,Y position of the 
window will be altered. 

set topmost T<mode>T 

Specifies whether the PV window is on top or 
other windows.  The value of T<mode>T is 
interpreted as follows:  
 
    0:   Normal (resets topmost property) 
    1:   Keeps window on top. 
 
This allows PV to stay on top of another 
application while the user clicks or drags 
windows. 

set zoom T<scale_factor> T 

Selects the Zoom scale factor for the camera 
window.  The T<scale_factor>T ranges from 0 
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to 5 in steps of 0.1. A value of 0 will 
automatically set the zoom so that the entire 
frame buffer will be displayed within the 
camera display window. 
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Appendix C: Multi-Instance Execution 

PreciseVision Multi-Instance 
For most applications, a single copy of PreciseVision is connected to a single robot. If an application 
requires PreciseVision to communicate with multiple robots or if one or more robots need to overlap the 
processing of several cameras, the Multi-Instance version of PreciseVision should be utilized. This 
version of the software permits several instances of PreciseVision to be executed concurrently on the 
same PC.  

Each instance of PreciseVision executes completely independently of other instances. In particular, each 
instance:  

1. Connects to its own set of cameras with their own camera calibration data.  
Individual cameras cannot be shared by different PV instances. Different 
instances can simultaneously capture images from separate cameras subject to 
the bandwidth limitations of the PC. In the standard version of PreciseVision, if 
two or more cameras are connected to a PC, pictures must be sequentially 
captured and analyzed. In a PC executing multiple instances of PreciseVision, 
each instance can take a picture at any time without regard to any acquisitions 
being performed by another instance, subject to the bandwidth limitations of the 
PC's hardware interfaces.  

2. Can only connect to a single camera interface type (i.e. Ethernet GigE or USB), 
but different instances can be connected to different camera interface types.  

3. Connects to a single robot or a single motion controller or nothing. This allows 
multiple robots to share a single PC and permits a robot or motion controller to 
perform simultaneous frame grabs and vision analysis by referencing different 
instances of PV on the same PC. In the standard version of PreciseVision, only a 
single robot or motion controller can be connected to a single instance of PV 
running on the PC.  

4. Loads it own Vision Project and executes its own Vision Processes. This enables 
each robot to execute either the same Vision Process or independent Vision 
Processes.  

5. Operates with its own set of Preferences. This enables independent control of 
display options and other parameters.  

Software Installation and Activation  

The Multi-Instance capability is only supported in PreciseVision 3.0 and later versions. Both the standard 
and the Multi-Instance software are provided in the same software installation distribution. To load the 
software and camera drivers, follow the standard software installation instructions detailed in the 
TSupported Hardware and Software Installation ChapterT of this manual.  

The only difference in the installation procedure is the specific software license key that is utilized to 
activate the software. The “PreciseVision Multi-Instance” key must be installed in place of the standard 
“PreciseVision” key.  
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NOTE: When the PreciseVision Multi-Instance key is installed, it replaces any 
previously installed standard key. Unfortunately, this will de-activate any 2.x and 
older versions of PreciseVision that are still installed on the PC. 

 

Executing Multiple Instances  

Once PreciseVision 3.0 or later is loaded and the Multi-Instance key is installed, multiple instances can be 
executed. Each time the TStart > Programs > Precise Automation > PV 3.0 > PreciseVisionT menu item is 
selected; only the first instance of PreciseVision is initiated.  

To execute instances 2 to N, a command line switch must be specified when starting PreciseVision. In 
Windows, the simplest means for accomplishing this is to create a “Shortcut” to PreciseVision.  

1. To create the shortcut, locate the PreciseVisionGUI.exe file. This is normally 
stored in TC:\Program Files\Precise Automation\PreciseVision x.x\T. 

2. Right click on this file and select TCreate ShortcutT.  
3. Right click on the new shortcut and select TPropertiesT.  
4. On the Shortcut tab of the Properties page, edit the TTargetT to add a number from 

2 to N after the “.exe” to specify the instance of PreciseVision that is to be 
launched by the Shortcut. 

At the conclusion of this process, a typical Shortcut Property page that would launch the second instance 
of PreciseVision will look like the following: 
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Below is a screen shot that illustrates two instances of PreciseVision Multi-Instance simultaneously 
executing.  Pleases note that the second instance is recognizable by the "(2)" following "PreciseVision" 
name in the title bar. 

 

Once multiple instances of PV have been launched, a robot controller can communicate with a specific 
instance of PV by executing the GPL Tvision_objectT.IPAddress and Tvision_objectT.Instance methods to 
specify the specific PC and instance of PV to be accessed.  
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Appendix D: Error Messages and Warnings 

PreciseVision Error Messages and Warnings  
PreciseVision displays error messages and warnings in the Vision Results window and the Tool Property 
Lists.  Errors indicate more significant problems and may stop the execution of a Vision Process.  
Warnings are typically benign.  Most of the error messages and warnings are self explanatory.  The 
following table describes some of these messages. 

Code  Text  Type  Description  

  

ACQUIRE_DIRECT_ 
SHOW_BAD_ 
SELECTED_ 

RESOLUTION  

Error 

This is an internal check error that should not occur.  
It indicates that the index number for the resolution 
of a camera is out-of-range for the selected camera.  
If this error is generated, please report it to Precise 
together with the PV version, camera model number 
and camera driver version. 

  
ACQUIRE_DIRECT_ 

SHOW_COPY_ 
IMAGE_FAILED  

Error 

This error should rarely happen.  It indicates there was a 
problem copying the acquired image from the DirectShow 
buffer to the camera image buffer.  This could be caused 
by a faulty camera.  

  
ACQUIRE_DIRECT_ 

SHOW_DEVICE_ 
NOT_OPEN  

Error 

This error indicates that when a picture acquisition was 
performed, the camera was not opened as a DirectShow 
device.  This is an unusual situation and may indicate 
that the camera cable has been disconnected or the 
camera signal has been lost for some reason.  

  
ACQUIRE_DIRECT_ 

SHOW_ERROR 
Error 

This is a general error that is generated when any 
problem occurs with acquiring an image using a USB 
camera. 
 
In PV 4.0 and later, more specific errors are generated 
and this message should not be displayed.  If you 
encounter this error, please report it to Precise together 
with the PV version, camera model number and camera 
driver version. 
 
In systems before PV 4.0, the most common problem 
indicated by this error is that the camera's pixel clock is 
set too fast and is exceeding the capabilities of the PC's 
USB hardware. 
 
Other problems include: incorrect exposure time, gain, 
offset or binning settings; a problem with the camera's 
trigger; excessive time waiting for the acquire to 
complete; or an error copying the DIB image to an image 
buffer.  

  
ACQUIRE_DIRECT_ 

SHOW_ERROR_TYPE1 
Error 

This is a diagnostic error that should not occur.  If this 
error is generated, please report it to Precise together 
with the PV version, camera model number and camera 
driver version. 

  ACQUIRE_DIRECT_ Error This is a very unusual error that should not occur.  If this 
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SHOW_FRAME_ 
RESET_EVENT_ 

FAILED  

error is generated, please report it to Precise together 
with the PV version, camera model number and camera 
driver version. 

  

ACQUIRE_DIRECT_ 
SHOW_LIVE_ 

ACQUIRE_STOP_ 
TIMED_OUT 

Error Not currently used.  

  
ACQUIRE_DIRECT_ 

SHOW_OPEN_ 
DEVICE_FAILED  

Error 

This error is generated at a low-level between 
DirectShow and the camera, and then propagated 
up to PV.  It is typically caused by the camera 
settings calling for more performance than the 
camera and computer can reliably provide or a 
hardware problem such as noise in the camera 
cable. 
 
The performance is a function of:  the camera 
model; computer CPU chipset; computer interface 
port chipset (which can be different for different ports 
of the computer); camera driver and firmware; and 
the cables. 
 
To correct this problem, try lowering the properties 
that control performance, such as the pixel-clock 
rate and the frame rate; try an alternate USB port on 
the computer; verify you are using up-to-date 
camera drivers; and ensure the cables are shielded 
and in good order.  

  

ACQUIRE_DIRECT_ 
SHOW_PROPERTY_ 

ASSERTING_ 
ACQUIRE_FAILED 

Error 

This error is generated when a picture acquire 
command fails after the steps that set DirectShow 
properties have succeeded. 
 
The likely problems are: (1) one or more of the 
properties is causing the acquire to fail or be 
unreliable or (2) the new properties are calling for 
more performance than the camera and computer 
can reliably provide or a hardware problem such as 
noise in the camera cable. 
 
The performance is a function of:  the camera 
model; computer CPU chipset; computer interface 
port chipset (which can be different for different ports 
of the computer); camera driver and firmware; and 
the cables. 
 
To correct this problem, try reverting the properties 
to a known good set, try lowering the properties that 
control performance, such as the pixel-clock rate 
and the frame rate; try an alternate USB port on the 
computer; verify you are using up-to-date camera 
drivers; and ensure the cables are shielded and in 
good order.  

  
ACQUIRE_DIRECT_ 

SHOW_RESOLUTION_ 
NOT_USABLE 

Error 

This is an internal check error that should not occur.  
It indicates that the index number for an unable 
resolution of a camera has been permitted.  If this 
error is generated, please report it to Precise 
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together with the PV version, camera model number 
and camera driver version. 

  

ACQUIRE_DIRECT_ 
SHOW_SET_ 

DEVICE_PROPERTY_ 
FAILED  

Error 

This error is generated at a low-level between 
DirectShow and the camera, and then propagated 
up to PV.  It is typically caused by the camera 
settings calling for more performance than the 
camera and computer can reliably provide or a 
hardware problem such as noise in the camera 
cable. 
 
The performance is a function of:  the camera 
model; computer CPU chipset; computer interface 
port chipset (which can be different for different ports 
of the computer); camera driver and firmware; and 
the cables. 
 
To correct this problem, try lowering the properties 
that control performance, such as the pixel-clock 
rate and the frame rate; try an alternate USB port on 
the computer; verify you are using up-to-date 
camera drivers; and ensure the cables are shielded 
and in good order.  

  
ACQUIRE_DIRECT_ 
SHOW_SET_HW_ 
TRIGGER_FAILED  

  
ACQUIRE_DIRECT_ 
SHOW_SET_SW_ 
TRIGGER_FAILED  

Error 

When attempting to setup a hardware or software 
triggered picture acquisition process, the messages 
for setting up the picture acquisition failed.  
 
These errors indicate that a DirectShow API 
published by the camera vendor failed. Please send 
a bug report for these problems to Precise including 
the camera model number, the camera driver 
version and (for hardware triggers) the selected 
hardware trigger polarity. 

  
ACQUIRE_DIRECT_ 
SHOW_SET_MODE_ 

FAILED  
Error 

When attempting to setup a software or hardware 
triggered picture acquisition process, the "SetMode" 
DirectShow method failed.  
 
This error indicates that a core DirectShow API 
failed. Please send a bug report for this case to 
Precise including the camera model number and the 
camera driver version. 

  

ACQUIRE_DIRECT_ 
SHOW_STREAM_ 

DEVICE_ONESHOT_ 
ENABLE_FAILED  

  

ACQUIRE_DIRECT_ 
SHOW_STREAM_ 

DEVICE_ONESHOT_ 
DISABLE_FAILED  

  
ACQUIRE_DIRECT_ 
SHOW_STREAM_ 

DEVICE_RUN_FAILED  

  
ACQUIRE_DIRECT_ 
SHOW_STREAM_ 

DEVICE_STOP_FAILED 

Error 

These errors indicate a problem within DirectShow for the 
camera stream device. Try reinitializing the DirectShow 
driver, disconnect and reconnect the camera, run 
standard DirectShow acquisition programs (if any) to 
verify the normal operation of the stream device, and 
then re-verify the operation of DirectShow by running PV. 
If the error persists, please report a bug to Precise 
including the camera model number and the camera 
driver version. 
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ACQUIRE_DIRECT_ 

SHOW_TRIGGERED_ 
TIME_OUT 

Error 

This error typically indicates that the camera settings 
are calling for more performance than the camera 
and computer are able to reliably provide.  The 
performance is a function of:  the camera model; 
computer CPU chipset; computer interface port 
chipset (which can be different for different ports of 
the computer); camera driver and firmware; and the 
cables. 
 
To correct this problem, try lowering the properties 
that control performance, such as the pixel-clock 
rate and the frame rate; try an alternate USB port on 
the computer; verify you are using up-to-date 
camera drivers; and ensure the cables are shielded 
and in good order.  

  
FINDER_DIFFERENT_ 

CALIBRATIONS  
Warning  

If the camera calibration pixel-to-mm X or Y scale factors 
are changed after a Finder Tool template has been 
taught, the template must be retrained.  While the 
Finder produces results in calibrated units, some of its 
calculations rely upon these scale factors. 

-4024 
VISION_TOOL_ 
NO_RESULTS 

Warning 

Indicates that a vision tool generated results data, but 
that the tool failed its inspection operation.  Normally, 
this error is not seen because if a tool fails, it will not 
produce any results.  However, if the 
ResultOnNotFound property is TRUE, vision tools 
generate results for successful and failed operations.  
This warning marks results that were produced by a 
failed tool.  

-4025 
VISION_TOOL_ 

RESULTS_MISMATCH Error 

This error is typically generated by an Inspect List 
Tool if its output is invalid because one or more of the 
referenced tools did not generate the same number of 
results.  This can occur if the Inspect List operates 
on the output from a tool that generates multiple results, 
such as a Finder, and the Inspect List contains 
multiple inspection operations.  If one or more of the 
inspection tools fail, they will not generate results so the 
Inspect List will be operating on arrays of results 
that are different in length.  To resolve this problem, in 
the Preferences, turn on "Return results if not found".  
This will enable the ResultOnNotFound property 
and force tools to return results even if if the tool's 
inspection operation fails.  
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